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WELCOME
The year is at an end – and what a year it’s been! Computer Arts 
has changed editors, redesigned its interior and celebrated its 
hundredth issue in style. We’ve also given you some great free
gifts in 2004: the Graduate Showcase, a shiny new 2005 calendar 
for your wall, a full copy of Bryce 4 and Vue D’Esprit, a handy Adobe 
tips guide and a free Adobe DVD. 

Although we’ve been really spoiling you, the industry hasn’t fared 
so well fi nancially. So this month, our deputy editor Dom Hall has 
been looking forward to what’s in store for us all next year. Find out 
what he discovered, good and bad, on page 20.

On the CD, you’ll fi nd the latest demo version of 3ds max 7. This 
is a major release and a hefty download, too, so it’s convenient to 
have it on CD for you to try out our full tutorial on page 104. We’ve 
also given you a full version of screen-recorder Camtasia.

And, as always, our experts are on hand to reveal the latest tips 
and tricks in our extensive tutorials section, starting on page 53. 
There really is no better magazine than Computer Arts, which is 
why we’re the best-selling creative mag, across the globe.

GILLIAN CARSON SENIOR EDITOR
gillian.carson@futurenet.co.uk
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EDITORIAL

ILLUSTRATION IN THE MAG
JASPER GOODALL
Jasper’s brief was to show off the power of Photoshop’s eye-
catching spot colour effects. He rose to the challenge with 
this richly coloured, decadent yet funky illustration, created 
using both traditional india ink and digital techniques.
INFO: www.jaspergoodall.com
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ANTHONY ROBINSON
The iconic style of the 1972 
Munich Olympics revisited.
INFO: www.anthony
robinson.com

BEN MINERS
Ben applies 2D to 3D using 
special spray-can effects.
INFO: www.graphik
boutique.com

RUKKIT KUANHAWATE
Rukkit’s piece evokes the 
tension between creativity and 
the skills required to realise it.
INFO: www.boreddesign.com

TWELVE:TEN
A suitably energetic twelve:ten 
illo adds zest to our overview of 
design industry trends in 2004.
INFO: www.twelveten.com

SCOTT HANSEN
Scott pares objects down to 
geometric shapes for this 
month’s Group Test illo.
INFO: www.iso50.com

DEREK LEA
Derek makes the most
of Photoshop’s powerful
New Spot Channel.
INFO: www.dereklea.com

ROB CHIU
This gritty collage by Rob 
brings to life the trembling 
splendour of Super 8 footage.
INFO: www.theronin.co.uk

ANTHONY LESTER
This elegant 3D visualisation 
comes courtesy of 3ds max.
INFO: www.visual-eyes-
media.co.uk
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P76 ADOBE ACROBAT 7
Enjoy pre-press tools and improved 
performance from this PDF stalwart

P78 PRINTDEVIZOR 1.0
Test your metallic inks and gloss fi nishes 
with this accomplished 3D simulator

P80 VIDEO TOASTER 4
A complete TV studio with post-production 
thrown in – but will your system run it?

P81 COLOUR LASERJET 2550N
HP’s seductive kit offers great colour 
reproduction, but running costs are high

P82 FOLDUP! 3D 1.5
The ideal way to visualise packaging 
without having to dig out the scalpel

P83 PERFECTION 2580 PHOTO
35mm fi lm is a breeze to scan with 
Epson’s smartly designed hardware.
It’s keenly priced, too

P84 LACIE 40GB USB 2.0
Durable and hard-working, LaCie’s latest 
easy-to-use hard drive weighs just 200g

P87 BOOKS
Coffee-table guides to Photoshop 
calligraphy, DIY design, and more

P88 3D ANIMATION SOFTWARE
Model, animate, render! We pit fi ve 
industry leaders against each other.
On test are Maya, 3ds max, Cinema 4D,  
LightWave and Softimage. Read it here!

WHAT’S HOT 
AND WHAT’S NOT?

LEARN THESE GREAT 
TECHNIQUES

FIVE TOP PRODUCTS 
BATTLE IT OUT

SUBSCRIBE TURN TO PAGE 45
Subscribe today to take advantage of our 
special January Sale offer – and ensure you get
an exclusive collector’s copy delivered straight 
to your door. Visit www.computerarts.co.uk or 
call the subscription hotline on 0870 444 8455. 

040

104
REVIEWS TUTORIALS

GROUP TEST

068

    
WHAT’S HAPPENING 
IN YOUR INDUSTRY?

FEATURES

032

P40 SPRAY-CAN EFFECTS
Blend 2D and 3D more creatively
using Cinema 4D and Photoshop

P54 DUOTONE & POSTERIZE
Add grace and motion to your work by 
mastering these Photoshop features 

P60 SLIDER WEB GAME
Create a sliding tile puzzle game on 
the web with the help of SWiSHmax

P64 SUPER 8 TO VIDEO
Discover how to transfer fi lm to digital 
video for storage or post effects work

P32 CA INTERVIEW
“Without a client involved, creative
can get done really quickly,” says Jim 
Coudal, co-founder of Coudal Partners

P48 ICON
Campbell’s Soup Can: How Andy 
Warhol turned the humble tin into a 
work of art and a 20th-century icon

P68 GET STARTED WITH...
Professional training: Pinpoint your 
weak spots, fi nd the right course, 
check their credentials – and learn!

P114 CURRICULUM VITAE
Raoul Deleo: Manga, The Designers 
Republic and early black and white 
Disney cartoons inspire Dutch visual 
artist Deleo to do his very best
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3DS MAX 7 (PC)
Check out all the exciting
features in the latest
version, then turn to
page 104 for our 3D
house-building how-to

CAMTASIA 3 (PC)
Record on-screen
activity with this full app

PRINTDEVIZOR LITE (MAC+PC)
Visualise special print fi nishes with ease

FOLDUP! 3D (MAC+PC)
See how your package designs look in 3D. 
Comes with an impressive auto-folding feature

SWISHMAX (PC)
Versatile Flash app – see page 60

AVIDFREE DV (MAC+PC)
Use this trial DV editing pack to transfer and 
edit your home movies – turn to page 64

See page 102 for further details...

THIS ISSUE’S
SOFTWARE & 
RESOURCES

PUZZLING STUFF 
Use SWiSHmax
to fashion this
online game

PAGE 60 Ë

ON THE CD

006

DUOTONE & 
POSTERIZE 
Recreate the Swiss style of the 1972 Munich 
Olympics with our slick Photoshop techniques

ÁPAGE 54 

SPOT 
COLOURS

Create foils, fl uorescents, metallics 
and more with Photoshop’s 

New Spot Channel command

PAGE 25 Ë
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Send your work to Computer Arts and be seen by thousands! 
EXPOSURE

1LIANE WILCHER
LOCATION  London
JOB  Set designer and illustrator
CONTACT  020 7803 9889
SOFTWARE  Photoshop

Liane Wilcher has a Bachelor of 
Interior design from the University 
of Technology, Sydney, and a degree 
in Set and Costume Design from the 
National Institute of Dramatic Art.

Having worked in theatre for four 
years she decided to concentrate on 
designing for corporate events but 
now works on a freelance basis, 
designing and visualising sets for 
various production companies. 

Illustration has been a hobby for 
Wilcher since she got her fi rst 
computer about seven years ago 
and she has been experimenting 
with different styles and techniques 
ever since. During her spare time 
she enjoys illustrating a broad 
range of subjects from architecture 
through to caricatures.

“My illustrations are drawn 
freehand with a Wacom pen and 
tablet in Photoshop. I like to keep 
a raw, hand-drawn look,” she says.

For the London scenes shown 
here, Wilcher goes out and about 
taking digital photographs of 
famous scenes from different 
angles. She can then compose a 
3D distorted view to give her work 
added depth and perspective.

TEAM LinG - Live, Informative, Non-cost and Genuine!
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EXPOSURE

To fi nd out more about this section, please 
go to www.computerarts.co.uk/gallery/

1. Big Ben 
2. City Hall 
3. The Wheel
4. Tower of London
5. The Tube 
6. Tower Bridge 
7. Trafalgar Square

“For the London images 
shown here, I visited all the 
sites and took digital photos 
of the architecture. I then 
used the photos as a 
reference to construct a 
collage of each building.

From there I took a blank 
document – sketching in 
Photoshop using a Wacom 
pen and tablet until I was 

happy with the proportions 
and distortions.

I come from an interior 
design/theatre background, 
so I try to use my spacial 
awareness to create a 3D 
effect giving a sense of 
depth and distance to a 2D 
illustration. From there 
I start working on the detail 
and stylisation – slowly 

correcting the line work. 
Once I have achieved the 
correct outline I then select 
fi ll-in colours and blends to 
complete the piece.

All of these images are 
currently available as 
greetings cards and my 
recent image of St Paul’s has 
been used on the cover of 
London Illustrated News.” 

2

3

4 5

6 7
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VICKY WOODGATE
LOCATION  London
JOB  Illustrator
CONTACT  vickywoodgate@mac.com 
SOFTWARE  Illustrator 10

1. Marital Bliss “My artwork is vector 
based and drawn straight onto the 
screen using a graphics pad. This is a 
self-promotional piece showing the 
joys of togetherness. l try to give my 
characters personality and movement.”

2. Airport “I actually sketched these 
people while they waited for a 
rollercoaster ride at a theme park, but 
I then went on to use them as part of a 
brief that involved holiday travel.”

3. The Holiday Maker “For this piece 
I wanted to create a larger than life 
character, close up for an article on 
holiday makers in Spain. I have a keen 
interest in people in every walk of life 
and try to inject as much humour as 
I can into my work.”

1

2 3
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GET EXPOSED

EXPOSURE

ALBERTO EZZY 
LOCATION  Belgium
JOB  Freelance graphic designer
CONTACT  www.albertoezzy.be
SOFTWARE  Adobe Creative Suite, 3ds max 
and Finalrender

1. Beer “Duvel beer is one of my favourites. I had a 
glass and bottle on my desk and decided to create a 
3D scene of it to test my glass material and the 
caustics and HDRI features of Finalrender. I’m 
especially happy with the caustics (patterns created 
on the table by light passing through glass).” 

2. Glasses “I always use a real image of an 
environment as a “spherical environment map” in 
3ds max. The image is then refl ected in every object 
in the scene and gives a much more realistic effect.” 

3. Terrace “The textures for this illustration of my 
terrace are made with my Nikon D70 digital SLR. 
I really like the mood of this image, which is created 
by the “light projector maps” of trees and the 
refl ection in the glass.”

January 2005   | 9

Send your work to us, along
with an explanation of your 
techniques and software, 
the titles of each piece, your 
website details and email 
address. Images should be sent 
as PC or Mac TIFF or JPEG fi les, 
on CD or DVD. A hard copy is 
also a great help. We will 
endeavour to return all entries 
that provide an SAE. All 
contributions are submitted on 
the basis of a non-exclusive 
worldwide licence to publish, 
both in print and electronically. 
Post hi-res fi les for print to:  
Exposure, Computer Arts, 
30 Monmouth Street, 
Bath, BA1 2BW.

1

32

1
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STAR LETTER: AN ISSUE OF PORNOGRAPHY

You can buy Brad Guigar’s new book, The Everything Cartooning Book, at www.everythingcartooning.com

As the Star Letter winner, you can choose a day’s 
training at Space. Co-founded by Bridget Riley, 
Space is one of the largest visual arts resources in 
the Capital, and offers a variety of courses ranging 
from Photoshop and Final Cut Pro to how to sell 
your work, tax and self-employment, and 
marketing strategies for designers. 

Space also has a large range of high-end 
equipment including video-editing facilities, 
technical support staff and exhibition spaces. 
For more information, go to: 
www.spacestudios.org.uk

PRIZE: free training at Space, London

IT’S A DESIGNER’S LIFE...
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I’ve just received
the latest issue of 

Computer Arts. Yours is a 
no-nonsense publication 
that, for me, is very 
functional in teaching 
what can be achieved 
using (above all things) 
Photoshop. However, 
I’m concerned about 
your Christmas issue’s 
cover image. To be 
frank, I’m not happy 

with it at all! I think your use of 
such a pornographic image is cheap, demeaning 
and uncalled for. It lowers the standard of what is 
otherwise a very good publication down to the 
level of a “lad’s mag”. I understand that, on the 
magazine rack in WH Smith, Computer Arts 
may seem lost amid a sea of other such cheap 
cover images. However, I don’t think that this is 
enough of a justifi cation to follow suit.

No, I don’t like it at all! And if I had not been
a subscriber, I would have defi nitely given this 
edition a miss in protest. Let’s get the covers 
back up to the usual standard and beyond, and 
leave out the cheap shots.
Christopher Icha

+ Computer Arts:
Thanks for your feedback, Christopher. We 
knew that it would provoke a reaction, because 

it’s certainly different from the covers of the 
past. But you’ll be pleased to hear that we did 
have some debate in the offi ce as to whether or 
not to use it. After much to-ing and fro-ing, 
however, we concluded that the image was 
excellent in its own right – a beautiful and 
artistic representation of the female form, with
a fantasy, sc-fi  spin to it, that would appeal 
directly to a large percentage of our readership.

We don’t see the image as being pornographic. 
Yes, it’s sexy; yes, it’s appealing to men (the 
majority of our readers are men), but more than 
that it’s technically brilliant and perfectly 
portrays good use of metallic effects. We don’t 
plan to use “sexy” images on our covers from 
now on. We just couldn’t pass up this 
opportunity to use such a stunning piece of 
artwork. Hope you enjoyed the issue anyway.

CA FORUM
COMPETITION WINNER
Yet again this month, we laid down the 
gauntlet for our forum members with a 
challenging and creative competition. This 
time, the brief was to design a movie poster, 
with the prize a copy of the excellent tome 
Moving Pixels, published by Thames & 
Hudson. As usual, the standard of entries 
was high, but we all agreed that there was 
one clear winner – Thomas 
Geurink from Holland, who 
came up with this witty little
poster for a car chase 
compilation movie that 
reminded us of Seventies 
cop shows The
Professionals and The
Sweeney. Keep an eye on 
forum.computerarts.co.uk 
for more competitions. 

*  G5 ALTERNATIVE
I’ve just read your Apple G5 dual 2GHz 
review in issue 103, and interesting reading 
it is, too – especially the price! So just a 
thought for all us non-Apple users: how 
about a review of the new Sun Java 
Workstations W1100z and W2100z?

They come in single and dual Opteron 
formats and, from what I can gather, would
give the G5 a run for its money at a 
cheaper price. The high-end version of the 

TEAM LinG - Live, Informative, Non-cost and Genuine!

http://www.everythingcartooning.com
http://www.spacestudios.org.uk
http://forum.computerarts.co.uk
mailto:ca.mail@futurenet.co.uk
http://forum.computerarts.co.uk


January 2005   | 11

 

INSIDE EVERY ISSUE...

W2100z costs a pretty competitive £5,900, but you can 
also “Go Large” and spend a whopping eight grand or
so on more RAM (up to 16GB), disk space, extra 
monitors, etc. As for operating systems, unfortunately it 
doesn’t have the pretty interface of OSX, but it ships with 
Solaris, Linux or Windows.

I would love to see a review of this on your website. It 
would even up the balance nicely, don’t you think? Plus, 
I’d love to see how it fares against the G5.
Pete Edwards

+ Computer Arts:
Thanks for the letter, Pete – are you sure you don’t work 
for Sun? We always try to strike a good balance in the 
reviews section between Mac kit and other platforms. 
Indeed, we have a comprehensive workstation group test 
coming up over the next few issues, which may well 
include one of the Sun products you mention. Thanks for 
the tip, though.

*  ANIMATION ADVICE
A friend of mine recently had a neat idea for a series, 
a sitcom-type venture that would slowly build up with 
characters as each episode passes. He’s initially looking to 
pitch the project as a kind of animated affair, a cross 
between The Simpsons and 2DTV, but different! 

What would be the best way to approach this type of 
animation? My initial thoughts would be to use Flash, but 
I have no idea where to start. Also, distribution would be 
something else to consider, as either web or DVD 
production would be required. Any advice?
Wook, forum member

+ Computer Arts:
Probably the fi rst thing you should do is create a short 
“pilot” episode (successful TV series often start out in
this way). Flash would be fi ne for this. Other, more 
powerful apps dedicated to broadcast animation, such as 
Toon Boom, are available, but Flash is a good cheap 
option. Once you’ve polished off your pilot, get it 
published on a website and send it to big fi lm portal 
websites (like www.ifi lm.com or www.atomfi lms.com).

It’s not unheard of for big broadcast companies to 
notice these kinds of animations. The movie Undercover 
Brother started off as a web cartoon, for instance – and 
obviously the success of The Blair Witch Project owed 
much to the fi lmmakers’ self-promotion online.

BRYCE ON THE MAC
Unfortunately, there were problems with the installer for 
Bryce 4 on last month’s cover disc. For information on 
how to fi x the problem, visit www.computerarts.co.uk.

  NEXT ISSUE IN

All contents are subject to change

PHOTOSHOP • IILLUSTRA TOR • FLASH • 3D ANIMATION 

ON SALE THURS 20 JANUARY

ESSENTIAL SOFTWARE
•  Full software, plus the very

best designer toolkit around

LATEST REVIEWS
•  All the latest software

and hardware reviewed and
rated by our expert testers

HEAD TO HEAD
•  We pitch fi ve top-fl ight products 

against each other in a gruelling 
battle to fi nd out which is best, 
so you don’t have to

DESIGNERS IN PROFILE
•  The biggest and best creatives in

the industry tell you how they make 
a successful living from design

READERS’ SHOWCASE
•  New designers from all over 

the world show off their work 
in the ever-popular Exposure

TIPS & TRICKS
•  Hundreds of handy tips, tricks

and special techniques from
our in-house experts

‡    DESIGNER TOOLKIT (WORTH $1,548)
Enjoy these royalty-free illustrations, motion graphics and video tutorials 

‡    FULL SOFTWARE: COMIXWARE 1.2 (WORTH $40)
Essential software for anyone who wants to bring their artwork to life 

‡    DESIGNER TALK 
Ad director John Robertson talks about how he got started in animation  
and his work on the recent “paint-by-numbers” Gordon’s gin commercial  

PHOTOSHOP TOOLS 
MASTERCLASS

Photoshop pros take you through the 
secrets behind every-day tools 

– you’ll be amazed at what they can do!
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Crowds fl ocking to this 
year’s Mac Expo were 
palpably buzzing with 
excitement for all things 
Apple – enjoying the media 

spotlight now bathing their favourite platform. 
And they weren’t disappointed. Although 

not using the event to make any surprise 
product announcements Apple created an 
inevitable roadblock around its imposing 
stand by showing off the new iPod Photo, 
U2 iPod and currently in-demand iMac, 
although sadly, rumours of a satellite–linked 
keynote from Steve Jobs came to nothing. 

Also attracting a capacity crowd was a 
hotly contested product head-to-head 
between Adobe and Quark, designed to give 
both companies a chance to hammer home 
the excellence of their rival products.

With Quark evangelist Shellie Hall in one 
corner and Adobe’s IT development manager 
Chris Kitchener in the other, both sides 
traded blows over multiple undos, hanging 
punctuation and language extensions in front 
of a crowd mainly made up of Quark users. 

By the time the showdown opened up to 
the audience, Quark was on the back foot, 
attempting to answer increasingly heated 

questions from users over sticking points such 
as lack of support for Unicode, scepticism 
over upgrades and a lack of backwards-
compatibility – the last accompanied by 
vociferous accusations that the company was 
not “living in the real world”.

Neither company emerged a clear winner, 
although the intense passion and loyalty of 
Quark users was readily apparent, despite 
Adobe’s effi cient PR attack. 

Elsewhere, Epson, Konica-Minolta, HP 
and Sony pushed low to high-end Mac-
compatible printers, monitors and 
peripherals, and all were keen to underline a 
strong commitment to the creative sector 
and its large and loyal band of Mac users. 

Rick Spiller, product marketing manager 
at HP’s recently established Mac-Connect 
group, which actively develops links 
between the two companies and aims to 
increase sales of HP’s printing and imaging 
products among Mac-using graphics 
professionals, said his company was looking 
to tap into Apple’s powerful brand. 

“It has a small market share, but it’s 
infl uential, especially in the creative 
market, and that’s a good place for us to 
start,” he said.  INFO www.mac-expo.co.uk
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  ONLINE HEAVEN
THIS MONTH’S ROUND-UP OF
THE GREAT AND GOOD ONLINE

AGENT PROVOCATEUR
www.agentprovocateur.com
Agent Provocateur offers more than 
just titillation for schoolboys. There’s 
some impressive Flash loveliness on 
display, too, enabling you to browse its 
sumptuous lingerie collection with 
ease. One for the boys and the girls –  
for very different reasons!

DUB MAGAZINE
www.dubmagazine.com
Those of you expecting roots and 
culture from Dub will be disappointed. 
This is, in fact, a site that celebrates 
the automotive excesses of Missy 
Elliot, Fifty Cent and others. But those 
fans of “tricked-out rides” will enjoy 
this suitably blingin’ website, we think.

FERRIS PLOCK
www.ferrisplock.com
San Francisco-based illustrator Ferris 
Plock shows off his striking wares. We 
particularly like the “Catholic girls with 
knives” gallery, so check it out. Plus, 
send Plock $2 and he’ll even send you 
some stickers. Excellent.

I AM NAS
www.iamnas.com
Shy and retiring hip-hop artiste Nasir 
“nas” Jones’ website opens with a 
recreation of the Last Supper to 
coincide with the release of his album 
Street’s Disciple. Despite such 
delusions of grandeur, this is an 
undeniably slick-looking site.

PLASTIC KID
www.plastickid.dk
Jakob Printzla creates fab, messy, 
stencil graffi ti murals. A gallery of 
photos gives you an idea of how he 
works, showing a piece from start to 
fi nish. “New site soon” says the home 
page. We hope he can top this one.

USEIT
www.useit.com
Celebrated Flash-hater Jakob 
Nielsen’s website might not be pretty 
(in fact, we think it’s awful), but it has 
some good advice on how to improve 
your website’s navigation and design.

Mac Expo
EXHIBITION Mac faithful fl ock to north London to pay homage to iPod and 
iMac, while the fur fl ies at a Quark vs Adobe show-down

TEAM LinG - Live, Informative, Non-cost and Genuine!
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› GOOD MONTH 

Mac culture  We’ve always known Apple 
pretty much owns the hearts and minds of the 
creative sector, but the PC industry seems to 
have fi nally cottoned on. Hewlett Packard’s 
Mac-Connect group is now actively looking for 
growth in the imaging-heavy Mac market.

Dutch digital snappers  Researchers in 
Holland have succeeded in creating the 
largest digital panoramic photo in the world. 
The 2.5 billion pixel image of Delft was built 
by stitching together 600 single snaps, and if 
printed out would be 2.5m high and 6m long. 
If only we could call Norris McWhirter!

Monotype  Agfa has sold its Monotype font 
business to a management buy-out team for 
$169m. The new owners promise to put the 
group – home to the Times New Roman and 
Gill Sans typefaces – in a “stronger position”. 
Enter our competition on page 59.

fi BAD MONTH 

Pixar and Disney The rocky relationship 
between the animation powerhouse and 
global entertainment giant looks like turning 
critical after reports that Disney is to proceed 
with a project to make Toy Story 3 in its own 
purpose-built animation facility – against the 
wishes of Pixar founder Steve Jobs.

Video RIP The decision by UK electronic 
retail giant Dixons to stop selling VHS video 
recorders has sounded the death knell for 
the once-dominant recordable format.

‹ AND FINALLY 

If I had a real girlfriend... Male users of 
3D animation packages have given full rein to 
their imaginations in the world’s fi rst virtual 
beauty contest – Miss Digital World. The 
world’s leading 3D artists have been creating 
virtual models to parade down an online 
catwalk. Hmm... do they need to get out more?

THE MONTH 
IN BRIEF
Our review of the past four 
weeks, plus what 3D animation 
software users have been up to 
instead of getting out more

In recognition of the 
growing infl uence digital 
design has over the wider 

creative community, educational 
charity Design and Art Direction 
(D&AD) has extended the scope of its 
annual awards by adding three new 
categories for online advertising, 
viral advertising and interactive TV.

“We’re doing a huge push on 
interactive and digital this year – 
it’s a really signifi cant move for 
D&AD and a sign of the times for the 
industry,” a spokeswoman told us.

With a jury drawing on the expertise 
of big names such as The Viral 

Factory’s Ed Robinson, Tim Molloy 
of the Science Museum and Morag 
Myerscough of Studio Myerscough, 
the 2005 competition to win a coveted 
yellow pencil and a spot in the next 
D&AD annual looks set to be as hard 
fought as ever. Closing date for entries 
is 4 February 2005.

Meanwhile, the 2004 D&AD annual 
has now been published, packed with 
info on award winners from around the 
world and titled – in cheeky homage to 
the never-ending chart compilation 
CDs – Now That’s What I Call Design/
Advertising 42.
INFO www.dandad.org

D&AD expands design awards

   The great and the good of the digital 
imaging world has gathered in 

Connecticut to report on work-in-progress 
over adoption and implementation of the 
JPEG2000 image format. 

Based on state-of-the-art wavelet 
development, the fl exible standard 
should spell good news for web/graphic 

designers and digital photographers, and 
help anyone involved in digital media 
asset management. 

Among speakers at the US symposium 
– which outlined new elements of the 
standard – was Simon Cope, chief 
software architect at JPEG2000 developer 
ER Mapper, who showed off a 1-terabyte 

image compressed using the technology. 
Also under discussion were recent 

patent infringement lawsuits involving 
ER Mapper and LizardTech, which 
recently lost a case to prove the 
company’s development work with 
JPEG2000 infringed one of its patents.
INFO www.jpeg.org/jpeg2000

JPEG2000 ADOPTION
TECHNOLOGY Industry get-together reveals progress on image-compression standard

Paradise regained
ANIMATION After Effects short airs at London Film Festival

AWARDS Coveted design gongs cast a wider net with interactive push

UK-based animator Gael Dennis, 
graduate of Channel 4 and the National 

Museum for Photography Film and Television’s 
Animator in Residence scheme, has just 
fi nished the fi rst round of screenings of her 
latest short – City of Paradise. The Passion 
Pictures-backed fi lm is the tale of a Japanese 
girl’s arrival in London and discovery of a 
mysterious secret underground city. 

Following successful airings at the London 
Film Festival, the six-minute work – created 
using Adobe After Effects, Photoshop
and Premiere Pro – was also shown 
on Channel 4 and will be featured in 
forthcoming festivals..
INFO www.passion-pictures.com
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DESIGN
FREE QUARK HELP
The latest chapter in Quark’s ongoing process 
of re-invention sees the company dropping all 
support charges for its English-speaking 
customer base. “We are serious about our 
commitment to our customers – by offering 
free support we’re offering another tangible and 
positive benefi t of being a Quark customer,” 
said Manoque Wirz-Grutter, company vice 
president of operations. UK Quark customers 
can call 0080 01787 8275 during standard 
business hours to access the service. 
www.quark.co.uk

CAD
OS X SUPPORT AT FORM•Z
Trickily-named CAD expert auto.des.sys has 
released version 5.0 of its form•Z modelling 
application. Incorporating elements of the 
beta-release-only 4.5, the new iteration has a 
wide range of updated features and for the 
fi rst time supports Mac OS X. Pricing for 
release 5.0 has yet to be fi nalised. 
www.formz.com

3D
THREE-DIMENSIONAL PHOTOS
RealViz has released a Mac version of its Image 
Modeller 4.0 – a software application that 
enables you to create 3D scenes using 2D digital 
photographs. New features in the latest release 
include a 3D/2D integration tool, UV mapping 
editor and the ability to export QuickTime VR 
Object movies. Available for £840.
www.realviz.com

DIGITAL MANAGEMENT
UNFROZEN ASSETS
Asset management software group Extensis 
has updated its Portfolio 7 app to offer new 
and updated SQL connect modules for 
Microsoft SQL, Microsoft MSDE, MySQL and 
Oracle databases. Additionally, the free update 
to Portfolio 7 includes fi le format support for 
MPEG-2 and MPEG-4; as well as an updated 
fi lter for digital camera Raw images and the 
recently announced Adobe DNG format. 
Portfolio 7 should cost £129.99 with a single 
NetPublish licence.
www.extensis.com

WEB EDITING
CHEAP MACROMEDIA ALTERNATIVE
Namo Interactive’s Macromedia-challenging 
web design, set-up and editing suite, 
WebEditor, has been upgraded to version 6.0. 
It’s capable of automatically creating a website 
through its Site Wizard feature and includes 
screen capture, bitmap editing, animation, 
vector-based drawing and bulletin-board  
features. The whole package is available  for £70 
through re-publisher Phoenix Software.
www.phoenixglobalsoftware.co.uk

SOFTWARE

SILICON BEACH
BRIGHTON
With courses aimed at both beginners and 
professionals, Silicon Beach provides a 
wide range of design and 3D training, 
from public access to bespoke sessions 
delivered at clients’ premises. 
Dreamweaver, 24-25 January, £395
Fireworks, 27-28 January, £395
URL www.siliconbeachtraining.co.uk

ESCAPE STUDIOS
LONDON
Leading west-London training centre 
specialising in 3D computer animation and 
2D visual effects skills. Escape is currently 
moving from its Westbourne Park base up 
the road to Shepherds Bush. Maya Level 1, 
two weeks, starting from 17 January, 
£1,899. Digital Compositing Comprehensive, 
six weeks, starting from 10 January, £4,799.
URL www.escapestudios.co.uk

METRO NEW MEDIA LONDON
Accredited Discreet training house offering 
courses in web design, 3D animation, 
graphic design, video and multimedia. 
Metro offers an extensive programme to 
small classes and also runs evening and 
weekend courses. Introduction to 3ds max 6, 
12-14 January, £650. Introduction to 
Director MX 2004, 27-28 Jan, £475.
URL www.metronewmedia.com

DESIGN COMPUTER TRAINING
BIRMINGHAM
One-to-one and small group computer 
training. Specialising in Adobe Photoshop 
training and training for professional web 
design, image editing and DTP. Courses 
cover Photoshop (image-editing and 
design for beginners) and basic web design 
and preparation. One-day courses start 
from £380, three days from £1,050.
URL www.combined.f9.co.uk/computer

CARSON WORKSHOPS
LONDON
One-day intensive practical workshop on 
building enterprise-level, database-driven 
websites, focusing on PHP, Apache and 
MySQL. Taught by industry experts Mike 
Buzzard and Chris Lea from Newstoday.
How to build a professional database-
driven website, 19 February, £395.
URL www.carsonworkshops.com

QA TRAINING
SCOTLAND
With classrooms in Glasgow and Edinburgh, 
as well as other locations throughout the 
UK, QA offers professional courses to both 
companies and individuals.
Web technologies overview
21 January, £310.
Developing XML web services
24-26 January, £1,060
URL www.qa.com

LEARNING CURVE
Short and long-term training across the UK

Adobe has updated its Acrobat
software family with the release of 

version 7 – a range of desktop 
applications the company says extends 
the reach of Acrobat “far beyond” 
converting documents to PDFs. 

Major changes include an extended 
range of electronic reviews, so now you 
can include any number of people in a 
document review process and, using free 

bundled Reader 7.0 software, add 
comments and provide feedback.

Adobe has also improved integration 
with LiveCycle and included LiveCycle 
Designer to help you create XML and 
PDF forms. Acrobat 7.0 Professional
will be available by the end of 2004 and 
cost around £395. See page 76 of this 
issue for a full product review. 
INFO www.adobe.co.uk

SOFTWARE New version extends workgroup capability of PDFs

Adobe beefs up Acrobat

ANIMATION Industry-sponsored animators roll sleeves up

From little acorns
HP and Alias’s SE3D project to nurture home-grown 
animation talent has shifted up a gear after the seven artists 
chosen by judges to make the short fi lms began work in 

earnest. The projects – including Screenburn’s Little Angel (the 
adventures of a baby demon wrongly delivered by a stork to heaven 
rather than the fi ery pits), Dan Lane’s Two Fellas and The Box’s 
Getting Out  (pictured left) – are on schedule for an April completion 
deadline in time for the Animated Encounters festival in Bristol.
INFO www.animated-encounters.org
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WHAT’S GOOD?
ARTS CENTRE, HONG KONG
8-11 January 2005, HK$1,200 (£180)
Peter Saville, Amsterdam’s Droog Design 
and Tokyo-based Yugop are among the 
star speakers at this lofty art and design 
conference, which sets out to explore 
“creation, perception, sensitivity, conscience, 
meaning and taste”.
URL www.whats-good.com

TOCA ME EVENT AND WORKSHOP
MUNICH, GERMANY
15–16 January 2005, 270 euros
Pioneering graffi ti and graphic design team 
scien and klor (of French crew 123klan) 
host a workshop demonstrating the 
genesis of a work from a fi rst sketch 
through digital design to a live graffi ti piece.
URL http://event.toca-me.com/files/
index.html

PHOTOSHOP WORLD
LAS VEGAS, USA
8-10 March 2005, $149-$499
Massive global Photoshop exhibition and 
conference focusing on training – with 
60 conference sessions for 
photographers, designers and video 
editors – and keynote talks from senior 
Adobe staff and partners.
URL www.photoshopworld.com

ADOBE LIVE
LONDON, UK
26-27 May 2005
Following last year’s successful event, 
Adobe will be setting up camp in the 
Business Design Centre, Islington, for 
another two days of training, speakers 
and break-out sessions for the budding 
creative professional.
URL www.adobe.co.uk

ONEDOTZERO9 FESTIVAL
ICA, LONDON, UK
27 May–5 June 2005
The onedotzero team returns to London 
for its ninth annual festival of digital 
moving images and a feast of music 
video, motion graphics, architecture, 
fashion, computer gaming, Japanese 
animation, live performance and club 
visuals. Deadline for submissions to the 
event is Friday 25 February, 2005.
URL www.onedotzero.com

GLOBAL EVENTS 
Our round-up of design events worldwide
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    HARDWARE

STORAGE
FLIP YOUR LID
Portable storage specialist
Amacom has launched bigger 
and more powerful versions 
of its Flip2Disk and IODisk 
products, both with a 
capacity of 100GB.

Aimed at heavy-use video and music 
fans, the smartly designed devices are easily 
portable, can be plugged straight into your PC 
– but sadly not your Mac – and are smaller 
(and healthier) than a packet of fags. The cost? 
£245 and £197, respectively.
www.amacom-tech.com

NETWORKING
IT’S GOOD TO SHARE
TROY, the German group that specialises in 
kit which enables small offi ces to easily share 
devices such as printers made for wireless and 
traditional networks, has announced three 
brand new product releases – PocketBasic, 
Winconnect II and EtherWind Plus. All three 
products will enable you to share single or 
multiple printing devices. Full pricing has yet 
to be announced.
www.troygroup.de

SLRS
END-OF-YEAR DEAL
Canon is running a couple of end-of-year 
promotions for its EOS 300D Digital SLR 
camera and online image-sharing portal. The 
fi rst offers customers the chance to snap up a 
300D with £100 cashback; the second, the 
chance to claim a free 256MB Compact Flash 
card when you buy the 300D and register for 
the Canon iMAGE GATEWAY. The offer is valid 
until 31 January 2005. For more information, 
see the Canon website.
www.cig.canon-europe.com

PRINTERS
LEXMARKS THE SPOT
Boldly claiming to advance colour laser 
printing technology, Lexmark’s trio of new 
products – the C760, C762 and 
X762e multi-function 
printers – all aim to offer 
high-performance 
printing coupled with 
great quality. The new 
hardware features 25ppm 
speeds and 4,800 CQ 
resolution. Prices? The 
x762e tops the bill at a 
whopping £4,599, with the 
C762 coming in at £1,049 
and the C760 at £779. 
www.lexmark.co.uk

Aardman Animation has taken the wraps off some new 
promotional fi lms for the BBC aimed at attracting 

more viewers to its digital channels. The 60 and 40-second 
spots break new ground for the animation powerhouse by 
mixing 3D models with projected fi lm. 

“Initially, the models were sculpted and textured in both 
LightWave and Maya, and then animated in LightWave. The 
backgrounds were a combination of layered 3D scenes built 
in LightWave with artwork imported and matched up from 
Photoshop fi les,” explains director Steve Harding-Hill.
“For the static shots, the layered artwork was taken directly
from Photoshop and composited in combustion.”
INFO www.aardman.org

TV Combined live action and animation sees viewers fl ocking to BBC Digital

Aardman helps BBC combust

MAXimum impact
AWARDS Macromedia recognises web design excellence

In a fl urry of industry back slapping, Macromedia has dished out 
its annual MAX awards for the most effective use of its 

technology over the last 12 months. Winners include New York-based 
Digitas for its recent American Express web-marketing hit (webisodes 
featuring comedian Jerry Seinfeld and Superman), AKQA’s stunning 
nikespeed.com site and the Lightmaker Group’s offi cial JK Rowling 
site. Winners and fi nalists were selected by an expert team of 
Macromedia judges, based on design and development, and the value 
for money and return gained by the client.
INFO www.macromedia.com/macromedia/events/max/max_awards
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Computer Arts: All of your work seems to 
involve superimposing 3D onto real video. 

How do you go about doing this?
Ben Dawkins: With lower budget jobs, music 
videos, for example, I tend to do everything myself 
using LightWave, After Effects and Photoshop. The 
PlayStation 2 and Orange ads were both done in post 
houses. They use boujou to track handheld camera 
movements and Maya for the 3D. Everything is 
them composited using Flame.

CA: The 3D models are shaded simply and 
contrast highly with the video. Why?
BD:The stork in the PlayStation 2 commercial had 
to look real, so I designed it in a way that would 
make it look as if robots actually do exist. Both 
the Orange and Bogdan [music video] pieces have 
objects that are meant to look out of place in the real 
world. They’re both textured using basic colours, but 
are still rendered to look as though they fi t in with 
the surrounding environments.

CA: What did the PlayStation 2 advert involve?
BD: A creative script came to me with four lines of 
text on it. A stork needed to crash through a window 
and deliver a baby PlayStation 2. I designed the 
stork in a day, which went down a treat with the 

creatives, as well as Sony. We shot the live action in 
a house in North London. The stork design was sent 
to Framestore CFC, who developed the stork further. 
During this time, we shot the glass breaking in a 
studio against bluescreen. All of the elements were 
then brought together in Flame and composited. 

CA: What are your infl uences?
BD: I grew up in front of home computers 
– Spectrums, Vic 20s and Amigas. The basic idea 

for Bogdan came from them. I took fl at 2D block 
graphics and re-invented them to work in a 3D 
environment. I love seeing people interact with 
puppets, both digital and physical, and this particular 
idea worked really well using the technique. I don’t 
like it when CG looks too good. It’s better when it 
looks a little rough around the edges.

CA: First and foremost, what are you? A 3D 
artist/animator or a director?
BD: I like to think that I’m a director fi rst. I love the 
creative process, storyboarding and scripting. With 
pop videos, you have to be on top of these processes 
because no-one else will do it for you. Commercials 
are different; most of the initial work is done by an 
agency team. I like doing one as much as the other.

CA: How did you manage to get work with such 
high-profi le clients as Orange and Sony?
BD: My reel is different from anything else out 
there, I’m told. It’s unique and funny at the same 
time. People remember things that make them laugh.

CA: Do you have any more big projects lined up?
BD: I’m currently fi nishing a music video for Nick 
Cave and the Bad Seeds, which is looking great.

CA: How did you get started in the business?
BD: I started making commercials for the music 
industry. Lots of motion graphics layered on top of 
simple 30-second edits. I got to work with lots of 
great bands and make a lot of contacts. Before that, 
I worked as a print/web designer for three years.

CA: Tell us about the recent Nick Cave video.
BD: I had an idea in my head to make a video that 
looked like a Disney movie – I mentioned Mary 
Poppins and Bedknobs and Broomsticks in the 
treatment. It’s not very Nick Cave, which I think is 
the reason it worked so well. All the background 
stills where made using digital photos I took on 
Hampstead Heath. Bit of Photoshop and Bob’s ya 
uncle. CG animation was then added and rendered 
using a cel-shader plug-in. This made it look more 
traditional. Everything was comped using a mixture 
of After Effects and Flame. I did everything myself 
in just four weeks.

INFO Check out more of Ben’s work at
www.bendawkins.pwp.blueyonder.co.uk/
promo.html and www.hellolove.tv.

“I basically had an idea in my head to make a video 
that looked like a Disney movie… It’s not very Nick 
Cave, which I think is the reason it worked so well”

BELOW: Tron-like slabs 
of 3D colour pulsate in 
Block Party’s music vid.

MAIN IMAGES: Ben 
Dawkins’ striking 3D 
encompasses retro-
text (Orange, far left), 
model work (PS2, 
middle) and animation 
(Nick Cave’s music 
video, far right).

 Ben Dawkins
We talk to the director of the recent Orange text messaging campaign and Sony’s latest PlayStation 2 advert,
about his creative process, attracting big name clients – and his penchant for classic Disney animation
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I’m a Mac user, and proud of it. I’ve 
used Macs for over 15 years and 

generally consider the Mac OS to be the best 
around. I’ll mock Windows users, despite my 
grudging admiration for certain aspects of 
Microsoft’s XP operating system, and will 
admit that elements of the continually 
delayed Longhorn look pretty interesting. 

In short, I’m probably like most Mac users 
– happy to work in an environment that’s 
free of the debilitating viruses and blue 
screens of death that plague our less 
fortunate Windows users.

But I’m no Mac zealot, the kind of fanatic 
who engages in vicious debates concerning 
the merits of Apple over Windows or Linux. 
I don’t burst into tears when Steve Jobs goes 
into hospital, and I’m not the sort of person 
who waits 24 hours in the rain to be the fi rst 
in line at the Apple Store opening. Or am I?

The opening of Apple’s fi rst European 
store in London last month gave me a rare 
opportunity to test my mettle, to see what 
kind of Mac user I really was. I thought to 
myself, in the interests of journalism, I’ll 
embed myself among the Mac loons who 
wait to be the fi rst through the door.  

And so, after work on the evening of 
Friday 19 November 2004, I made my way 
to Regent Street. The massive double glass 

doors of the new store beckoned and a 
scattering of folk peered inside. None of 
them looked like they had any intention of 
staying the night and it occurred to me that 
I might be fi rst in the queue! Obviously, 
I reasoned, since nobody was queuing, there 
was something different about the European 
mentality, some sense of reality that 

prevented us from acting like Apple fans 
across the Atlantic. 

One look around the corner, however, 
proved me wrong. British Apple fans, it seems, 
are just as mad as our American brethren – 
there were already 20 or 30 encampments with 
tents and sleeping bags stretching down 
Princes Street. They all looked prepared for a 
mountain trek, apart from two head-banging 
mad men who jumped around playing air 
guitar to their iPods… 

It was very cold, the kind of cold that 
makes you think twice about sleeping on the 
street. So, realising there was no chance of 

being fi rst in the queue, I thought, “Bugger 
this” and went home.

Early next morning, I followed the queue 
back down Princes Street, around Hanover 
Square, down and back up George Street 
until I reached the end somewhere around 
Brook Street. The police later put the number 
of people waiting at around 5,000. 

So I randomly interviewed some of them. 
It soon became clear that there was a 
hardcore of people towards the front who had 
braved the London winter. The majority had 
turned up between 6.30am and 9.30am. But 
fi rst in the queue was an American named 
Stormy from Dallas, Texas, who’d escaped 
the rubber room to camp out since Thursday!  

As the grand opening crawled closer, a 
party atmosphere took hold, helped by the 
store staff, who travelled the line whooping 
and clapping. After chanting, “Five minutes 
to go! Five minutes to go!”, they cut the 
ribbon and the queue surged forwards…

I didn’t actually make it inside the store 
until the Monday – being one of the fi rst 100 
people to enter the store didn’t appeal in the 
cold. But for most, it seems, we’re not so very 
different from folk in the US when it comes 
to turning an Apple Store opening into an 
event bordering on the religious.  

PC users may outnumber Mac users by 
over 95 per cent, but if Microsoft ever opened 
a new store of its own, it would never be able 
to stage anything like this. So chalk one up to 
the crazy Apple asylum escapees.

Jason Arber is designer and co-founder of 

www.pixelsurgeon.com. Email your thoughts on the 

UK’s attitude to Apple to jason@pixelsurgeon.com. 

“British Apple fans, it would 
seem, are just as fanatical as
our American brethren”

OPINION

FORUMS 
Do you have any tales 

from the Apple store 

opening? Post your 

stories at http://forum.

computerarts.co.uk. 

 Mac fanatic
Self-confessed Mac fan Jason Arber immerses himself in the ultimate in 
Apple worship – and discovers he’s not quite as dedicated as he thought

OPINION
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NEWS ANALYSIS

Admittedly, the design industry has 
pulled itself up by its trainer laces since 

the dot.com bust but it turns out that 2004 
was a pretty shocking year fi nancially too. 
Turnover in the UK commercial design 
sector fell by 26 per cent over 2003, average 
fees slipped by 13 per cent, we saw a wave of 
redundancies –and a worrying trend towards 
agencies of all sizes competing on price 
rather than ideas.

The good news? While such fi ndings 
(collated from information supplied by 
1,600 UK design agencies to trade 
association the British Design Initiative for 
its annual survey) certainly make depressing 

reading, those working at the sharp end of 
the design industry believe they can see 
light at the end of the tunnel.

“Things have to get better because they 
certainly can’t get any worse,” says Maxine 
Horn, chief executive of the British Design 
Initiative (BDI). “This slump has been 
driven by a number of things over the last 
three years, such as the dot.com crash and 
business confi dence after 9/11, but people 
haven’t re-built their confi dence. They’re 
stuck in a price war and haven’t recovered.”

While this may seem bad enough, Horn 
also points to recent research carried out by 
Remedy Brand Consultants into 
comparative hourly fees charged by 
different types of businesses during 2004. 
This, she believes, shows that the value 
placed on creative and design work is 
disappearing from the radar.

“Remedy found a freelance designer 
charges around £35 to £50 an hour and a 
design agency £65, while a hairdresser 
charges £70 to £200 for a cut and colour,”  

Horn continues. “So it appears that a 
hairdressing salon can earn more for a 
service, the results of which may last two 
months, than a design consultancy creating 
products, trademarks and branding that 
could potentially last a lifetime.”

If the BDI’s fi ndings are true – note that 
the survey only accounts for the experiences 
of part of the wider industry – things will 
need to change in 2005. But is it really time 
to switch off your computer and start 
thinking about a new career?

TIME FOR A CHANGE
Stephen Gray, managing director at digital 
design group Stickee, believes not. He says 
business levels for his company have 
actually been good during 2004, but that 
it has been harder to win. He says clients are 
no longer willing to throw money into a 
project without some guarantee of a tangible 
return. If they are spending money on a 
website, they’re less likely to be pleased 
with a straight-ahead online presence. 

FORUMS 

Visit http://forum.

computerarts.co.uk  

to share your views on 

this topic and more 

with other CA readers. 

 What’s in store for 2005?
It’s hardly been a vintage 12 months, and much of the creative industry will be glad to see the back of 2004. 
But what’s around the corner? And what will you need to do to keep yourself ahead in 2005? WORDS BY DOM HALL

IN DEPTH
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“In the long run, the industry will 
still have to fi ght for creative freedom. 
It won’t be handed out on a plate”

Now they want to know exactly what the 
site is likely to produce for them. 

“Although client spending has increased, 
expectations have become much higher,” 
says Gray. “It’s simply not enough to provide 
an amazingly creative solution to a brief, 
since marketing and business issues have to 
be addressed as well.” 

This is a trend echoed by others in the 
industry. The boardroom suits who had their 
fi ngers painfully burnt during the dot.com 
boom three or four years ago are older and 
wiser, and taking a greater interest in 

creative spending than ever before. With this 
likely to intensify over the next year, will 
creative freedom and innovative risk-taking 
design step into the fi ring line?

Despite the spending slowdown, for The 
Ronin’s Rob Chiu clients have been able to 
trust their designers more in creative terms 
during 2004 and are transferring that trust 
into more open commissions, especially 
some of the bigger names. 

“I think clients are starting to see things a 
bit better now and aren’t as set in their ways 

as they were fi ve years ago,” says Chiu. 
“There’s a lot more creative work coming 
out of the big-name brands such as Nike and 
Diesel. This has a knock-on effect and 
means smaller companies want to look 
similar,” he continues. 

But for others – including Ian Anderson 
at The Designers Republic – in the long 
run, creative freedom is something the 
industry will still have to fi ght for. It’s 
unlikely to be top priority in any corporate 
commission during 2005. 

“Creative freedom is there, but only if we 
take it. I don’t see control being handed out 
on a plate in the current climate,” he admits.

INTEGRATED WEBSITES
Another trend for 2005, according to Chris 
Hassell, new media director at web design 
agency DS.Emotion, will be the increasing 
importance of the role digital and interactive 
design agencies play in the mainstream 
marketing and advertising industries. 

As the creative engine behind a number 
of high-profi le brand websites, such as 
the hugely successful deodorant line Lynx, 
Hassell believes traditional advertising 
agencies will be forced to sit up and take 
notice during the next 12 months. 

“Websites are becoming more integral, 
especially within youth brands and band 
websites. Digital agencies will get a lot 
more respect,” he says. 

But no matter what happens to creative 
commissions in 2005, the basic look and 
feel of design will  – as ever – have to move 
forward. One of the big trends during 2004 
was a move away from slick and 
homogenised computer graphics to a more 
handcrafted, personalised aesthetic. It placed 
importance on the skills of design, such as 
illustration, rather than simple software. 

Danny Franzreb from Taobot believes this 
movement will gather pace over the coming 
year. “I saw lots of people drawing sketchy 
black and white characters over their designs 
and I’d say the hand-drawn style is still 
rising and will be big in 2005,” he says.

“We’re still moving away from the clean 
technological, hi-tech and little pixel font 
style we saw in 2002, although I guess we 
might witness a little revival, mixed with 
original hand-drawn illustrations and more 
vivid colours.”

But whatever happens during 2005, it’ll 
be worth remembering that, as Maxine Horn 
says, things have to get better.  

INFO 
www.britishdesign.co.uk/newlook/d10.html
www.stickee.co.uk
www.theronin.co.uk
www.thedesignersrepublic.com
www.dsemotion.com
www.taobot.com

TEAM LinG - Live, Informative, Non-cost and Genuine!

http://www.britishdesign.co.uk/newlook/d10.html
http://www.stickee.co.uk
http://www.theronin.co.uk
http://www.thedesignersrepublic.com
http://www.dsemotion.com
http://www.taobot.com


FONT SHOWCASE

John Downer, plus a pictorial tour of India 
with Dutch designers Underware.

Building Letters hopes to repeat the 
success of last year’s issue, which raised 
money to help orphans in Africa. This 
issue aims to fund building projects in 
India and assist orphans in Uganda. 
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Cabinet is a striking yet simple serif 
font designed exclusively by an 

anonymous typographer for the Building 
Letters latest fund-raising venture. The 
Building Letters pack consists of a CD-
ROM, complete with 32 fonts, a specially 
designed magazine and two posters by 

 Building Letters
Impressive designer collective reveals a stylish font from its latest charity project

Eboy and Emigre. The fonts disk samples 
work by some of the world’s top designers, 
among them Bruno Maag, Max Kisman, 
Stefan Hattenbach, Rian Hughes, Miles 
Newlyn and Swifty.

The magazine features an essay by 
Neville Brody, an interview with Emigre’s 

FONT DESIGNERINFO

Web: The charity pack 
featuring Cabinet (and 31 
other fonts by various type 
designers) is distributed 
exclusively through the 
Building Letters website.
Price: £25
Info: For more information 
on Building Letters and its 
recent fund raising and 
charity work, please visit 
www.buildingletters.org

TYPE DESIGNERS UNITE TO HELPCHILDREN IN INDIA
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DESIGNER
NAME: JASPER GOODALL
LOCATION: BRIGHTON, UK
URL: WWW.JASPERGOODALL.COM

HOW WAS IT DONE?
Using his own reference materials, Jasper created a 
composite fi gure from a group of photos. “I have a very 
large image library that I have collected over time,” he 
explains. “Because there are so many images in that 
library I can create a fi gure doing pretty much anything. 
The fi gure featured here is made up of a montage of 
different images; an arm from here and a leg from there. 
I added the clothes at a later stage.”

Jasper made extensive use of Photoshop’s Threshold 
Adjustment layer to defi ne areas of black, and preferred to 
draw paths manually for absolute control rather than use 
an application such as Streamline. The background cloud 
and rainbow fi gures were then created in Illustrator.

The resulting print was then india inked by hand and 
reimported for colouring in Photoshop. “Using the red at 
about 98 per cent opacity gave a pretty convincing felt-tip 
pen effect,” he says. “Occasionally, I use a real felt-tip pen – 
usually in grey, so I can dictate the colour electronically. 
Scanned felt-tips can look weird when reproduced in print.”

We asked Jasper to produce an illo with a separate 
channel that we could use to introduce a spot colour (in this 
case, Pantone 810C). In this month’s cover tutorial, Derek 
Lea shows you how to achieve such an effect in Photoshop.

TURN OVER TO GET STARTED WITH THE TUTORIAL...

  

COVER FEATURE
COVER ILLUSTRATION
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If you direct your attention to 
Photoshop’s Channels palette, 

you’ll notice a menu option entitled 
New Spot Channel. This menu item 
is your gateway to surpassing the 
possibilities of printing with CMYK. 
The spot channel creates a unique way 
to add an extra ink to the existing 
CMYK ink mix within your image 
fi le. You’ll need another plate on 
press, and your costs will be 
increased, but you will also have 
unearthed a world of possibilities to 
make your printed images stand out. 

So why use a fi fth colour? Because it 
gives you the opportunity to create 
some really original effects – from 
areas of spot varnish as seen on the 
covers of past issues of Computer Arts,

to metallic ink or foil effects that simply 
cannot be achieved via a CMYK mix 
(to match the Pantone colour of your 
client’s logo, for example).

Whatever your reasons, the process 
is the same. The secret to success is to 
understand how Photoshop treats this 
channel in relation to the rest of the fi le 
and how to work properly within it.

So once you’ve decided to tread the 
uncertain waters of fi ve-colour 
printing, it is essential that you 
communicate with your printers as 
well as those who are ripping your 
page layout fi les to fi lm or plates. 
The bottom line is that you must run 
your ideas by those who are handling 
the technical aspects of your job 
before you start. They know what can 

and can’t be done. They’ll be handling 
the chokes and spreads. They’ll advise 
you on your limitations when it comes 
to graduated colour and tell you if you 
need to knock out underlying inks 
yourself or send the fi les to them 
instead. Open the lines of 
communication and make sure that 
they stay open.

Whether you create this image or 
use it as a reference for adding spot 
colour effects to your own, this 
tutorial will explain all you need to 
know about the process of creating 
and working with a spot colour 
channel in Photoshop CS.

Illustration by Derek Lea 

www.dereklea.com

COVER

SPOT COLOURS 
IN PHOTOSHOP

Whether it’s foil, fl uorescents, metallics or a specifi c pantone colour you’re after, Photoshop has 
everything you’ll need to incorporate spot colour effects. Derek Lea shows you how
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4 Leave the Solidity setting at 100 per cent. 
Like the colour swatch, this is for display 

purposes only and will not affect your colour 
separations. Because we are using solid 
Orange 021C as the fi fth colour, a Solidity 
setting of 100 per cent will give a reasonably 
accurate preview on screen.

3 It doesn’t really matter which colour 
system you choose, or the colour you 

specify for that matter. A spot channel can 
become any colour you desire when you go to 
press. This process is more about display 
within Photoshop. So choose Orange 021C 
from the Pantone solid coated book.

2 Choose New Spot Channel from the 
Palette menu to add a fi fth colour 

channel to your image. The New Spot 
Channel box will open up. Click on the colour 
swatch to open up the Custom Colours box. 
The Book menu allows you to choose from a 
list of colour systems.

CREATE A FIFTH COLOUR

1  Open up the fi fthcolour.psd fi le from the cover disc. You’ll notice that the fi le in its original state is a bit lacking, but bear in mind that it has 
been designed to incorporate a fi fth colour as part of its fi nal appearance. Direct your attention to the Channels palette menu.

ON THE CD

TIME LENGTH

INFO

ON THE CD

TIME LENGTH

4.5 hours

INFO

Derek Lea 
is an award-winning 
digital artist and 
published author based 
in Toronto, Canada. His 

work 
includes 
disciplines as 
varied as 
traditional 

illustration, photography, 
3D modelling, vector art, 
and of course, Photoshop. 
To view more of his work, 
visit www.dereklea.com.
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10 Select your spot colour channel and 
Control/Command-click on the Alpha 

Channel icon entitled Pattern to generate a 
selection from the channel contents. Invert 
the selection and fi ll it with black in your Spot 
Colour Channel. You will notice that unwanted 
areas of fi fth colour still overlap the hair.

9 Deselect and return to any layer in the 
Layers palette. Use the Magic Wand to 

select the outer purple border areas from the 
box at the lower right of the image. Return to 
your spot colour channel in the Channels 
palette. Again, fi ll your selection with solid 
black and then deselect.

5 You will notice a new spot channel, 
named after your chosen colour swatch, 

appear in the Channels palette. Select the 
alpha channel entitled Pattern in the 
Channels palette. Now use the Lasso tool to 
draw a rough selection around one of the 
pattern components and Copy it.
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7 Deselect and then choose any layer in the 
Layers palette. This will select the CMYK 

composite channel instead of your spot colour. 
Use the Magic Wand tool with Use All Layers 
enabled to select the purple background 
areas. Invert the selection and choose your 
spot channel in the Channels palette.

11 Deselect and then Control/Command-
click the icon for Alpha 3 in the Channels 

palette. Fill the area within your spot channel 
with solid white and deselect. Switch off the 
visibility of the CMYK channels for a moment 
and you’ll notice that your spot channel 
looks just like other alpha channels.

6 Select your spot colour channel in the 
Channels palette and then Paste. Enable 

the visibility of the CMYK channels to preview 
the fi rst fi fth colour element against the 
image. Use Free-Transform to re-size and 
position the selected area. Alt/Option-drag 
the selected area to create a number of 
duplicates in the channel.

8 Delete the selected areas in your spot 
channel and deselect. Again, select any 

layer in the Layers palette. Next, use the 
Magic Wand to select the border that 
surrounds the main box. Return to your spot 
channel and fi ll the selected areas with black. 
Solid black equals 100 per cent Opacity for 
your spot channel.

DUOTONE IMAGES

There is another way to 
incorporate a spot colour 
into your images in 
Photoshop. This involves 
starting out with a greyscale 
image and converting it to a 
duotone image. Here, you 
can see that we’ve created a 
greyscale version of the 
illustration and then chosen 
Image>Mode>Duotone.

First we created an ink made up of a  
mix of 100 per cent Cyan, 25 per cent 
Magenta, 0 per cent Yellow, and 0 per 
cent Black. The second ink contains the 
same Pantone Orange 021C used 
throughout this tutorial. In essence, this 
has now become a four-colour image that 
contains a spot colour.

The main difference is the way the 
colours are blended. The CMYK mix is 
treated as a single colour, as is the 
Pantone spot colour. Each colour has a 
duotone curve that can be altered to 
control the way that the inks mix. Using 
this method applies the spot colour as a 
tint throughout the entire image.

COVER

If you decide you’d like to 
create a CMYK 
representation of your 
fi ve-colour image, select 
the spot colour channel in 
the Channels palette and 
select Merge Spot 
Channel from the 
Channels palette menu. 
This will convert the 
channel to CMYK and 
merge it with the other 
channels, discarding the 
spot channel and 
fl attening any layers in the 
fi le. The resulting CMYK 
colour won’t exactly 
match the custom colour, 
as CMYK inks are not 
capable of the same 
range of colour.

MERGING A SPOT 
CHANNEL
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TUTORIAL

PHOTOSHOP

18 Deselect and use the Pen tool to draw 
a number of similar closed path 

components on appropriate areas of the hair 
throughout the image. Generate a selection 
from the path and again fi ll the selected area 
with 100 per cent black within the spot colour 
channel. Deselect.

30 |  January 2005

16 Hold down the Control/Command key 
and the Alt/Option key and click on the 

layer icon entitled Main Outlines in the Layers 
palette. This will subtract the contents of the 
Main Outlines layer from your current 
selection. In the spot channel, fi ll the 
selection with black and then deselect.

12 Wherever the black exists in the spot 
channel, you’ll notice that it is 

displayed by your specifi ed colour when you 
enable the visibility of the CMYK composite 
channel. In the Layers palette, try switching 
off a couple of layers and see what happens.

13 Switching off layers has absolutely no 
effect on your spot colour channel. 

Note that what you do to your layers within 
your image is entirely independent of what 
you do within your spot channel and vice 
versa. The spot channel co-exists in the 
Photoshop workspace along side your colour 
and alpha channels.

14 Control/Command-click the Alpha Channel icon entitled Words in the Channels palette. 
With the selection active, select your spot colour channel, fi ll the selected area with 

solid black and deselect. Now select the Pen tool from the toolbox – you’ll need to create some 
new areas to fi ll with the spot colour.

17 Zoom in on an area of her hair. Use 
the Pen tool to draw a closed path that 

resembles a thin highlight, similar to the 
highlights that already exist in the image. 
Generate a selection from the closed path 
and fi ll the selected area with black within 
your spot channel.

15 Draw a closed path in the teacup to 
create an area where the surface of 

the liquid would appear. Don’t be too fussy 
about where the area overlaps the black 
lines; you can fi x that in a moment. Generate 
a selection from your completed path and 
return to the Layers palette.

COVER

It is possible to convert an 
existing alpha channel into 
a spot colour channel 
within your file. Double-
click a Channel icon or 
select a channel and 
choose Channel Options 
from the Channels palette 
menu. Select Spot Channel 
from the Colour Indicates 
options. You can also alter 
the colour and solidity 
within the Channel Options. 
The parts of the alpha 
channel that contain 
greyscale values will be 
converted to corresponding 
spot colour values.

CONVERTING AN 
ALPHA CHANNEL
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19 Select the Magic Wand tool and click 
on any layer in the Layers palette to 

create selections from within the CMYK 
composite channel instead of your spot colour 
channel. Use the Magic Wand tool to select 
the solid areas of her hair next to the teacup. 

20 Fill the selected areas with black 
inside your spot colour channel and 

deselect. Select any layer and use the Magic 
Wand tool to select the neck area. With the 
Gradient tool, specify a black 
foreground colour and choose 
Foreground to Transparent. 

25 Select your spot channel in the 
Channels palette, choose Edit>Stroke 

from the menu and add a large black stroke 
outside of the selected area. At this point, 
you’re essentially fi nished, but there is an 
unused channel containing a fl ower shape if 
you want to embellish the image further with 
layer and spot-channel content.
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21 Select your spot colour channel from 
the Channels palette and use the 

Gradient tool, with the Linear option enabled, 
to draw a black-to-transparent gradient 
within the selected area. Deselect and choose 
the Pen tool from the toolbox.

24 You should start to understand the 
relationship between the percentages 

of black in the spot colour channel and their 
visual representation by the coloured preview 
against the composite CMYK. Enable the 
visibility of the CMYK composite channel and 
Control/Command-click the Layer icon for 
the alpha channel entitled Alpha 3.

22 Look for areas of hair that will lend 
themselves to this effect and use the 

Pen tool to draw some closed path 
components in those areas. Generate a 
selection from the path and subtract the 
contents of the Main Outlines layer from your 
selected area as before.

23 Use the Gradient tool with the Radial 
option enabled to create a series of 

gradients within your selected areas inside of 
your spot colour channel. Disable the 
visibility of the CMYK composite channel 
momentarily and have a look at your 
gradients within the spot channel.

ABOUT SOLIDITY

When you create a spot 
colour channel, a couple of 
things will affect how the 
channel is displayed as an 
ink against the CMYK 
composite channels – 
Colour and Solidity. 

At fi rst this value may 
seem a lot like an Opacity 
value, but it’s not. The actual 
density of the ink in the spot 
channel is not affected by the Solidity 
value. It affects the on-screen preview 
only as well as any composite print outs, 
but varying this value will have no effect 
on colour separations.

Using a high solidity value of around 
100 per cent will simulate the look of an 
opaque ink. However, in cases when your 

spot colour channel is going to be used as 
a varnish, it may be useful to use a very 
low Solidity setting to aid a more accurate 
preview. As this image reveals, on the left 
we used a Solidity setting, but on the right 
the Solidity was reduced to 20 per cent, 
allowing us to preview the imagery that 
shows through the spot channel.

COVER

Photoshop image fi les 
are usually imported 
into applications such 
as QuarkXPress, 
InDesign, or Adobe 
Pagemaker to be 
placed within your 
layout fi le. But in order 
for a fi le containing a 
spot colour channel to 
be compatible, you 
must fi rst save it in 
a DCS 2.0 fi le format. 

The DCS 2.0 format 
will preserve the spot 
channel within your fi le 
and is supported by the 
aforementioned 
applications. But 
remember that when 
saving your fi les in DCS 
2.0 format you’ll need 
to deselect the Include 
Halftone Screen and 
Include Transfer 
Function options.

PRESERVE YOUR 
SPOT CHANNELS
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Jim Coudal (above left) and his 
team of six colleagues who, 
despite their huge workload, 
always have time for pizza.
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It’s two days after the US Presidential 
election, and Coudal Partners’ own 

small attempt at infl uencing the outcome 
almost paid off. Rather than placing 
hectoring or impassioned pleas on their 
website, the forthright design studio 
created lowercasetees, a spin-off business 
selling T-shirts for kids. Two text designs 
were available: one proclaiming, “Mommy 
wants a new President”, and the other, 
“I wouldn’t vote for Bush if I were you.”

“The funny thing is, we’ve actually sold 
a bunch of them in the last two days,” says 
Jim Coudal, Coudal’s affable founder.
“We produced a lot more of the Mommy

T-shirts as, fortunately or unfortunately, 
depending on how you look at it, the 
Mommy message is still valid to a large 
part of the US.”

While it may not be unusual for this 
“fairly traditional small design fi rm in 
Chicago” to launch a clothing design site, 
the political messages have caused a stir – 
as has the business, which went from idea 
to end product in just over two weeks. 

“We made a conscious effort about 18 
months ago to fi nd ways to take greater 
control over our creative output,” says 
Coudal. “So last summer, we started 
Jewelboxing, to produce great-looking 
packaging for CDs and DVDs. That was 
one of the fi rst examples of what we 
wanted to do.”

A simple but effective idea, Jewelboxing 
gives designers and artists the chance to 
produce professional-looking CD/DVD 
cases. Coudal couples high-quality cases 

“We had the idea, the shirts produced, the 
site built and everything sorted in about
15 days. Two weeks later, we broke even”

CA INTERVIEW
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COUDAL PARTNERS

A limited-edition poster for Coudal’s Summer Reading series, by Jay
Ryan of The Bird Machine in Chicago (www.thebirdmachine.com).

Poster for the Museum of Online Museums, 
one of the most popular sections on Coudal’s 
website – and updated quarterly.

with precise design templates for every 
component, and sells both as a package.

“What’s interesting is that the entire 
marketing plan for that was defi ned by
us,” Coudal explains. “We built it for us; 
we needed those cases for a project we 
were doing, and developed the entire thing 
with us in mind.

“Lowercasetees came more from the 
political situation in America. My wife 
came up with the idea at dinner, in fact, 
and then my seven-year-old daughter said 
that she’d like a shirt saying, ‘I won’t vote 
for Bush, I can’t, but I wouldn’t if I were 
you.’ This was only a month before the 
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election, so we had the idea, the shirts 
produced, the site built, the IP issues and 
everything sorted in about 15 days. Two 
weeks later, we broke even.”

Predictably, lowercasetees attracted its 
share of negative feedback. “Some people, 
mostly Conservatives, have criticised us 
for putting a political message on a child, 
but my boy Spencer’s mommy does want a 
new President, and my daughter Isobel 
wouldn’t vote for Bush, so there’s no 
exploitation at all there.”

Although it launched at a fortuitous 
time, lowercasetees isn’t a fl ash in the pan. 
Coudal intends to grow the brand in the 
same way as Jewelboxing: “We’re using 
the attention from the political shirts as a 
way to build an ongoing brand for kids. If 
you search Google for kids’ T-shirts you 
can click from now until next Tuesday 
before you fi nd something you’d even put 
your kid in. It’s a bunch of crap.”

But 15 days? Really? “We worked hard 
on it. We had one person on the identity of 
the company, another on the shirt designs, 
another building the site, and another 
interfacing with a fi rm called Threadless, 
who are good friends of ours, to handle the 
quick production of the shirts. Then there 
was someone jockeying a spreadsheet to 
make sure we weren’t making a terribly 

expensive mistake. We used PayPal for 
transactional stuff, because we didn’t have 
time to do our own,” says Coudal.

“I’m not sure we could have been 
successful if we had started it cold – if we 
didn’t already have a built-in audience for 
Coudal Partners. So, yeah, it was a busy 
week. But without a client involved, 
creative can get done really quickly.”

If you build it, they will come
Coudal’s not boasting about the company’s 
built-in audience – the website regularly 
pulls in 10,000 hits a day, and more on 
Fridays. The site looks more like a 
community portal than a design fi rm: there 
are blogs, discussions of Stanley Kubrick, 
book recommendations, photography 
submissions, short fi lms... Indeed, just 
about everything but a standard portfolio.

“You have to do a little work to fi nd
out what we do,” admits Coudal. “That 
was intentional from the beginning in 
1999. We do great work and we love to 
show off our portfolio, but our experience 
is that assignments are given based on
the dynamic between the people involved 
fi rst, and the actual work you’ve done for 
other people second.

“So we’ve built our site as a way
for a potential client to see what we’re 

CA INTERVIEW

LEFT: Recent “cover art” 
from the Coudal site has 
featured a Jewelboxing 
promo, a Crash Ballet 
compo, a job opening at
the company and an image 
from a client installation.

LEFT: Created out of Coudal’s own need for 
high-quality, custom-designed CD and DVD 
cases, Jewelboxing is now Coudal’s biggest 
client and a thriving business in its own right.

RIGHT: Various logos 
and identities by Coudal 
Partners (from top to 
bottom): The United 
Center, Champps Sports 
Bars and Restaurants; 
Chicago Bus Tour 
Company, Papagus 
Greek Taverna and the 
Lost Dunes Golf Club.
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RIGHT: “For ten years, we’ve 
created a custom holiday 
hot sauce and the packaging 
to go with it for our friends 
and clients,” reveals Coudal 
founder Jim Coudal. 
“The brand is Whoa!”

all about as people. Someone here once 
said: if you’re chatting up a girl in a bar, 
the fi rst thing you don’t talk about is the 
other girls you’ve dated. And that’s how
we feel about the portfolio.”

When the website launched, says 
Coudal, the company was trying to fi gure 
out the internet just like every else. Even 
before blogging became a recognised term, 
everyone on the team would post links and 
thoughts on an ad hoc basis.

“We saw the traffi c patterns of our site 
go north all the time, so we thought, ‘Well, 

that’s interesting.’ It’s like 
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that phrase from Field of Dreams: if you 
build it, they will come,” says Coudal. 
“Our whole thing is to turn that on its head 
and say, ‘Well, if they come, we will build 
it.’ We built the audience before we even 
knew what we wanted to do, and the site 
easily pays for itself. We have a unique 
policy for ads: we won’t take an ad from
an advertiser whose product we haven’t 
paid for and used ourselves.”

Identifying the “real” work
Coudal seems almost as modest about the 
company’s “real” work as he is the website, 
casually tossing out the names of some 
huge projects. Roughly a third of their time 
is spent developing brand names, company 
names and identities. A third is advertising: 
“We do TV commercials, websites, print 
ads, all that sort of stuff, especially in 
sports.” And the other third is indefi nable, 
involving projects such as Jewelboxing, 
lowercasetees, and so forth. “Jewelboxing 
is now our biggest client, which is 

interesting,” says Coudal. One recent 
triumph is the naming and entire identity 
for a new fast-casual restaurant chain 
called Go Roma. “It’s really high-end, 
quality food, it’s growing fast, it’s a major 
brand and a huge project for us. We’re 
involved on a work-for-hire basis and
also in a small participation in the success 
of the project.”

To Coudal, the company’s work for the 
Tom Peters Company is a perfect example 
of how building a community can lead to 
better results. Tom Peters is a well-known 

CA INTERVIEW

COUDAL PARTNERS

One of the designs from the infamous 
lowercasetees brand/shop, which went from 
idea to fully-fl edged business in 15 days. The 
shop is currently dormant, but will eventually 
be a spin-off site – www.lowercasetee.com

The Astros baseball team home jersey: “We designed the mark, the 
business materials, collateral and the uniforms,” says Jim Coudal.

business guru in the States, yet the website 
wasn’t performing as well as expected. 
“We immediately turned them into a
portal and a blog. Their traffi c went up 

fi vefold. Tom’s very popular, but they 
didn’t realise that all they needed was to 
have him personally post to the site.”

Coudal Partners has also just rebuilt
a network of sites for Fox in Chicago, 
while rebranding and renaming “a big 

“My seven-year-old daughter said that 
she’d like a T-shirt saying, ‘I won’t vote for 
Bush, I can’t, but I wouldn’t if I were you’”
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Chicago biz media company, which we 
can’t talk about.” Actually, there’s a lot 
Coudal can’t talk about: “Lately we’re 
being brought in early in a product’s 
development,” he explains. “Sometimes, 
no-one else knows we’re doing it, we 
hand over the creative, and we walk away 
never knowing what happened to it.”

Thank God it’s Friday
Lowercasetees isn’t the fi rst project to 
have made Coudal Partners “instantly” 

famous. That project occurred a few
years ago when the studio unleashed
the concept of Photoshop Tennis on the 
world. It’s simple enough: two designers 
send an image back and forth, adding one 
layer for each turn, each trying to outdo 
the other. Games can last for hours, and 
the winner emerges when everyone’s
had enough. It’s frenetic, demanding, 
sometimes cruel and huge fun to watch as 
the image develops.

So, Jim, when’s it coming back? “I’m 
not at liberty to tell you that...” he says 
mock-ominously. “That was a catalyst to 

our success on the web. When that was at 
its peak, we were doing 35,000 people for a 
match on Friday. I think it will come back.”

But why on earth was it so popular? And 
why hadn’t anyone thought of it before? 
“It captured people’s imagination. We hired 
witty smartasses to write commentary in 
real time, which added a whole other layer. 
Also, as designers, we all work in our quiet 
little offi ces and do work for our quiet little 
clients, and have small victories here and 
there. We compete with each other in 

broad, general ways, in terms of businesses, 
but we never compete as individuals.

“And, more importantly, it was scheduled 
on Friday afternoon, and no-one schedules 
anything on the web… It’s guaranteed that 
if and when Photoshop Tennis comes back, 
it’ll be on Friday afternoons – because, 
frankly, no-one’s working anyway.”

“It’s always Friday afternoon, all around 
the world. People have decided, ‘Well, 
that’s all I’ve got for this week’.” Coudal 
pauses, then adds wryly: “After all, if 
you’re looking to go online and waste time, 
Coudal is a very good place to do it.”

“The winner in Photoshop Tennis emerges 
when everyone’s had enough. It’s frenetic, 
sometimes cruel, and huge fun to watch”

Name: Jim Coudal
Role: Writer/designer
Inspired by: My colleagues 
Favourite designers/illustrators: 
Josef Müller-Brockman, Mies and 
Stanley Kubrick. I guess I lean towards 
the cold and dispassionate.
Best website: www.0015.org

Name: Ryan Sievert
Role: Jewelboxer/design grunt
Inspired by: Independent musicians, 
designers, artists and companies 
worldwide for proving that you can 
follow your muse and still pay the rent.
Favourite designers/illustrators: 
Andy Mueller
Best website: www.pitchforkmedia.com

Name: Susan Everett
Role: Designer
Inspired by: Objects and bits of lettering 
or illustration done by people who did 
not mean them to be critically 
viewed. I like the handmade and 
surprising nature of these things. 
Favourite designers/illustrators: Eric 
Gill, Frank Gehry, Hannah Hoch, Neville 
Brody and Paul Rand, to name a few.
Best website: www.google.com

CA INTERVIEW
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Contact Coudal Partners by calling
+1 312 243 1107, visiting www.coudal.
com or emailing info@coudal.com. 
For more info on Jewelboxing and 
lowercasetees, visit www.jewelboxing.
com or www.lowercasetees.com.

COMPANY INFOCOMPANY INFO

COUDAL PARTNERS

Despite only having a team of seven, Coudal Partners 
always seems to have time for ad hoc ideas, despite 
major client work and a sprawling portal to continually 
update. Yet another idea that sprang from nowhere was 
the Crash Ballet competition.

“NASA released footage of these tests they did 
crashing planes,” explains Jim Coudal. “No-one was hurt 
of course. It was all crash test dummies. It’s beautiful, in a 
horrifi c sort of way, and we started just screwing around 
– cutting the footage to music. That was at 11 o’clock in 
the morning – and by one o’clock in the afternoon we’d 
announced a competition, asking people to do the same, 
with a deadline of the end of the next day.”

Gratifyingly enough, the team received dozens of 
entries from people who had stayed up all night to edit 
their work. “There was a monstrous amount of traffi c, 
because the web is like that,” says Coudal. “I guess the 
moral of the story is that people like explosions... But 
also as a meme, as an idea, it went from our site to the 
world in ten hours.

“Did that do anything for us? Well, it increased our 
page views for that month exponentially, but in the long 
run it probably also sold some Jewelboxes, because 
that’s how we branded it. When you have your own brand 
that is targeted to people who read your site, you can 
always get it to sponsor you.”

SPONTANEOUS CRASHING

TO COUDAL, JUST ABOUT EVERYTHING IS A SOURCE OF INSPIRATION, NO MATTER HOW ODD...

Coudal’s website is more 
like a portal or a magazine, 
with regular sections on 
books, photography, and 
inspirational material –
even stuff about design.

 COUDAL PARTNERS Q&A
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SPRAY-CAN EFFECTS
CINEMA 4D & PHOTOSHOP 

1 I try to continually create textures to use 
across a range of projects. That way, I 

always have a constant supply of images to 
use at any time. Here, I’ve created a texture by 
building up acrylic and spray paint on foam 
board. This texture will be used later on in this 
tutorial and is included on the cover CD.

4 Once you are happy with your stencils and 
spray-can effects, photograph them or 

scan them in. Using a digital camera can save 
time, but make sure the camera has a good 
close-up lens and that you take a high-res 
picture. You could also enhance this image in 
Photoshop before you start. Two graffi ti 
textures have been included on the cover CD.

2 Once you have experimented with spray 
paint techniques, create some text and 

print it off. Next, cut out the text to create a 
stencil. By spraying around the text, you’ll 
be able to create a silhouette effect, too. 
Experiment a little, as sometimes the 
mistakes you make create excellent effects.

3 Create more than one stencil effect as 
then you’ll have more choice once you 

start working in Cinema 4D and Photoshop. 
The image above shows the use of the spray 
stencil effect on one of the special characters 
of a custom font. These characters can be 
used to create abstract effects and shapes.
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2D and 3D images work well together, but only if they’re mixed correctly. So take a different approach to your 3D 
illustration by mixing up original elements with Photoshop layers and Cinema 4D. Ben Miners shows you how 

By mixing 2D and 3D elements, it’s 
possible to create an image that is so 

complex it’s virtually impossible to work 
out which program has been used to create 
it. The beauty of this technique is that no 
image will ever be the same. You can add 
original artwork and interesting layers that 
will give your work instant originality. 

This tutorial will explain, step by step, how 
to create 2D spray-can effects and stencils, 
which will then be transferred into Cinema
4D as a background for a 3D composition. 
Only then will Photoshop be used to add the 
all-important fi nishing touches. 

We will demonstrate how some of the 
more traditional methods of image making 
can be used within a 3D program – in this 
case, Cinema 4D – and you’ll learn how to 
successfully combine 2D with 3D to create 
unique designs and textures. Used correctly, 
2D and 3D elements compliment each other 
brilliantly, and the results are always far more 
interesting than an ordinary glossy render. 

So to start with, we’ll take a look at how 
best to go about creating spray-can effects 
and stencils by hand and then the process of 
photographing and transferring them into a 
Cinema 4D scene. From there you’ll be 
shown how to make the most of lighting, 
textures, layering and how best to build up a 
range of 3D elements in the 3D space. 

Finally, you’ll use Photoshop to mix 
elements, create layers and add colour to 
your image using the program’s extensive 
blending options. I hope this new approach 
and range of techniques will show you how 
to produce original, modern effects 
throughout your 3D illustration work.

Illustration and tutorial by Ben Miners

www.graphikboutique.com

DOWNLOAD

TIME LENGTH

25 hours

INFO

Ben Miners is a 
professional freelance 
designer and creative 
based in Leicester who 
has designed and 
illustrated for Sony, Sega 
and Mattel. To see more 
of his work visit www.
graphikboutique.com.
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CINEMA 4D & PHOTOSHOP 

7 Assign one of your background textures to 
the fl oor plane, by dragging it into the 

scene. Set Texture Mapping to Frontal 
Projection. This will form your background. 
Don’t just use the Background tool, as it won’t 
be possible to change its position or angle.

8 Now you can start to build up the 3D 
elements. Create a simple rectangular 

plane by clicking on the Objects menu at the 
top of the interface. You can assign various 
textures to this plane if you wish, but here it 
has been left white. Make sure that as you add 
objects to the scene, you place them in front of 
this fl oor – unless the fl oor is transparent, the 
objects won’t be seen. Try adding textures and 
transparencies to the shapes. 

9   Add a few of the textures you made 
earlier to existing and new planes using 

the techniques you used in steps 7 and 8.  It is 
important that you concentrate on building a 
strong composition. Use the angles and 
composition of the spray-can texture as a 
guide. Play around with the scale and depth 
of fi eld to strengthen your composition.

6 Cinema 4D has a tool called Floor, which is located with the lights and cameras at the top 
on the C4D interface. Click on Floor and a 3D fl oor will be added to your scene. This plane 

will act as a background/wall when you rotate it to a frontal view. 
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5 Open Cinema 4D. Choose File>NewMaterial and double click on the new material. 
A window will appear, which will allow you to add a new texture. Click on the Colour box on 

the left of the interface and then click on Image to locate your new texture fi le. Use a Specular 
light (see 3dgraffi ti.c4d on the cover CD) to add refl ection and set the Transparency at 70 per cent.

To get the best results 
from your spray-can 
effects it’s important to 
use the best materials. 
Foam board is perfect 
for applying all kinds of 
paint as it has a gloss 
surface and does not 
absorb the paint. Spray 
paint applied to some 
other surfaces looks 
dull and the vibrancy of 
the colours does not 
show through. Car 
spray paints work well 
and always maintain a 
strong colour. It’s also 
worth remembering 
that you don’t need to 
buy hundreds of paints 
as you can change the 
paint colours to 
anything you want once 
in Photoshop. 

YOUR MATERIALS
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10 You can now start to add new light sources. Lighting is the key to successful 3D work. 
Add the main lights to the centre position (see 3dgraffi ti.c4d for more details). Position a 

few smaller lights throughout the composition. You’ll notice that interesting shadows will now be 
cast upon the background wall. You may want to try changing the colours of these shadows, too.

11 You can now place a main 3D element. Here, I have used added a virtually transparent 
texture to some 3D type. Position the element, found within the 3dgraffi ti.c4d fi le, in the 

spot where the main light source hits so that it absorbs the main focal light. Don’t worry if the 
light isn’t perfect as you can enhance the colours in Photoshop. Double-click on the lights and 
enter a Shadow Map of 500x500 to enhance the render. 

12 Once you have confi rmed the render 
settings, render the whole image out 

for use in Photoshop. It is possible to add 
further texture and spray-can effects to the 
background in Photoshop if you wish, as long 
as the main part is created in Cinema 4D. Just 
make sure that you avoid the extra elements 
appearing as if they’ve been stuck on.

13 Bring in some of the stencils you 
made earlier and add them to a new 

layer. Drag the fi les into the composition and 
erase any unwanted parts with the Erase tool. 
Double click on one of the layers in the Layers 
palette toolbox and adjust the Layer Blending 
options to merge the image layers. Use the 
Darken blending option to make the image 
look like part of the layer underneath it.

14   Slowly start to build up the layers. This 
layer set was also created using the 

Darken blending option. Often, I’ll have used 
every blending option in Photoshop by the 
time I’ve fi nished a piece. The more you 
experiment with Blending Modes, the more 
interesting results you will achieve. 

FEATURE
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If you are unfamiliar 
with Cinema 4D and 
struggle to get the 
correct lighting, go and 
buy a well-lit model 
from www.turbosquid.
com. Here you will fi nd 
a range of 3D models, 
created by 
professionals, for a 
range of 3D apps. It’s 
worth buying a model 
and placing your own 
3D object into the 
scene, removing the 
original and working 
out how your new 
object has now been lit.

LIGHTEN UP
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CINEMA 4D & PHOTOSHOP 

22 Take the fl attened image and 
duplicate the layer. Change the new 

layer style to Screen in the Layer Styles menu 
within the Layers palette. Set the Motion Blur 
to 50 per cent horizontal and vertical and 
reduce the Opacity to 30 per cent. This will 
reduce the harshness of all of the lines in 
your piece. You can now experiment with new 
textures and light styles.   

21 Go to Layer>FlattenImage and make 
any fi nal adjustments. Up the contrast 

slightly by choosing Image>Adjust and make 
a few minor colour tweaks using the Colour 
Balance options in the Image Adjust menu.

18 Continue to build up the layers. For 
examples, take a look at the 

example fi le, 3dgraffi ti.psd, on the cover CD.

16 Here, I used a scan of sprayed lines of 
spray paint on foam board to create 

lines of paint splatter. This was then placed in 
the middle-right of the composition. You can 
use any texture you like here, but, once again, 
use the Darken Light option to merge it 
subtley into the composition.

17 Create a spray can in Cinema 4D, or 
open the can provided on the cover 

CD, and bring it into Photoshop. Cut it out 
with the Lasso tool and place it into the 
composition. Apply the Hard Light blending 
option and move it underneath several of the 
layers. Use the Pen tool to add some white 
pencil lines and pull the Opacity down to 
around 40 per cent.

15 Using the same techniques, you can 
now start to build more layers into 

your image. By adding new elements to the 
image, you can really start to add depth to 
your composition. Examples of these layers 
can be found within the 3dgraffi ti.psd fi le on 
the cover CD.

FEATURE

19 Use the graffi ti stencil once again, 
placing it on the spray can itself by 

dragging the opened stencil fi le into the 
composition. By using the Luminosity 
blending option you can give the stencil a 
highlighted greyscale effect. Ensure that you 
keep the Opacity low at around 10-15 per cent.
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PHOTOSHOP KNOW-HOW
More tools, tips and tricks from 
our panel of experts

NEXT ISSUE IN 20 Create a new top layer and fi ll it with 
solid red. Next, change the layer 

blending option to Luminosity and reduce the 
Opacity to around 30-40 per cent. This will lift 
the red and help to merge all of the colours in 
the composition. You will also notice that the 
bright white has been toned down. 

The rendering of a 3D 
scene can be extremely 
time consuming, so it 
pays to use this time 
wisely. Do test renders 
at low resolution to 
check how your effects 
are working and 
optimise your 
rendering settings. 
Turn off Anti-aliasing 
(the process that gives 
your surfaces smooth 
edges) for test renders 
as it slows the 
rendering process – 
you can turn it back on 
for the fi nal render for 
that “fi nished” look.

RENDER SMARTER
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13 ISSUES FOR £46.80*

 JANUARY SALE!

“ THIS OFFER WON’T BE BEATEN ” 
Gillian Carson, senior editor

SAVE 40% WHEN YOU SUBSCRIBE TODAY

TURN OVER 
FOR DETAILS
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 ICON

Ë
What proves a brand’s success? Recognition, 
loyalty, enduring design and profi tability, for 

starters. According to recent fi gures, 70 cans of 
Campbell’s Soup are bought in America every 
second, and each US household larder contains an 
average of eight cans… But while Andy Warhol’s 
silkscreen tributes to the brand have undoubtedly 
sealed its place in popular culture on both sides of 
the Atlantic, the red and white label seeped its way 
into consumer consciousness long before then.

The Campbell Soup Company was established in 
1869 by Joseph Campbell, a fruit merchant, and 
Abraham Anderson, a tin ice-box manufacturer. In 
1876, their canned beefsteak tomatoes won a medal 
for quality at the Centennial Exposition, but it 
wasn’t until 1897, when company chemist Dr. John 
T. Dorrance developed a way to remove water from 
the mixture to produce condensed soup, that the 
products really began to fl y off the shelves. 

The now legendary red and white label was fi rst 
conceived in 1898. The story goes that a company 
executive was attending a traditional football game 
between rivals Cornell University and the University 
of Pennsylvania. He was so entranced by the 
striking new red and white strip of the Cornell team 
that he immediately proposed that the same colour 
scheme be used on all Campbell’s labels. A stroke of 
luck, as red and white has consistently proved itself 
to be a successful colour combination – take the 
branding of drinks giant Coca-Cola, for example.

For Campbell, true brand success came when the 
progressive company started advertising – a concept 
still rare at the time. The fi rst Campbell’s Soup 

adverts, released in 1899, featured a large picture of 
the red and white can and graced the sides of New 
York streetcars. The result? Sales in the city 
increased by a staggering 100 per cent.

Gold seal of approval
In 1900, the soups won a Gold Medallion for 
excellence at the Paris Exposition, and it was this 
circular gold badge that graced the modern-day cans 
depicted in Andy Warhol’s posters. These days, the 
badge has, on all but the classic brands, been 
replaced by images of tasty serving suggestions,
but the red and white label still remains.

“Its success is all down to the simplicity and 
colour co-ordination of the layout,” explains Nick 
Hayes of design studio Identikal. “Because of its 
simple format and striking shapes, it leaves the 
typography as the only thing to be brought up to 
date. Designs like these could go on forever.”

It was during the sixties that Andy Warhol, leader 
of the pop art movement, picked the Campbell’s 
Soup can from the shelf and threw it into the 
shopping trolley of popular consciousness.

In the fi rst of his serial works, the prolifi c artist 
illustrated individual canvases with each of the 32 
soups in the Campbell range. The initial works in 
the soup series were shown at his fi rst solo 
exhibition at the Ferus Gallery in Los Angeles in 
1962. The works were arranged along a shelf to 
parody the supermarket experience and contrast 
with the idea of art as a unique commodity.

By the end of the exhibition, the canvases had 
attracted the art world’s attention. Warhol was 

persuaded by gallery manager Irving Blum to keep 
the collection, and eventually sold the entire series 
to him for $1,000. Warhol captured all 32 fl avours in 
a simple yet striking design that served to show how 
conformity could still be present in variety.

Why soup?
The thinking behind Warhol’s choice of subject 
matter was, and still is, the subject of debate. 
According to Victor Bockris’s The Life and Death 
of Andy Warhol, the illustrations came about 
following a conversation with art dealer Muriel 
Latow, who suggested he paint what he liked 

The “Big Tomato” fi rst appeared in Campbell’s 
ad campaign, which featured in leading women’s 
magazines, in 1926 and preached the message of 
wholesome tomato goodness. A can cost 12 cents.
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The Campbell’s Soup label
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Computer Arts: The original red and white 
Campbell’s label was designed in 1899. Why do
you think that design has endured so long?
Dan Moore: To me, the design is very Americana 
– very Norman Rockwell. It portrays a sense of 
quality and wholesomeness. The packaging seems 
to indicate a great sense of tradition and heritage, 
something that is missing in a lot of American 
culture. It’s for this reason that the design still 
exists, coupled with the fact that the product itself 
(especially the condensed soups) remains virtually 
unchallenged in terms of competition. 

Heinz has recently re-branded some of its range 
to keep up with the new fresh soup brands and also 
to keep the Heinz brand fresh in its other product 
areas. The Campbell’s product is still unique.

CA: What do you think is particularly striking about 
its colours and style?
DM: The design by itself is pretty striking, but I think 
you have to give some weight to the fact that many 
people know the brand simply because of Warhol’s 
work, and not because they actually buy it.

CA: Why did Andy Warhol choose that particular 
product over others?
DM: I think Warhol wanted a great American brand, 
one that everyone used. He used others in a similar 
way – Coca-Cola, Brillo, etc. – as part of a series that 
dealt with the American way of life.

CA: Have you seen the Campbell’s brand, or 
Warhol’s portrayal of brands, parodied anywhere? 
DM: The Warhol style and attitude towards image-
making is everywhere, from colourful Marilyns to 
Maos. I think the one factor that helps it prevail is the 
ease with which anyone who owns an image-editing 
app can “Warhol-up” their photo album.

ICON

most in the world – adding that he should paint 
something that everyone would recognise. 

The widespread familiarity of the label also 
served to emphasise the saturation of advertising 
and commercialism in America at that time. By the 
sixties, Campbell’s was still using a 50-year old 
design and had managed to keep its prices stable for 
almost 40 years. He chose the iconic can to refl ect 
the monotony of commercial images seen on 
everything from newspapers and TV to the 
supermarket shelf. Warhol later applied the same 
technique to the saturation of celebrity with his now 
famous Marilyn Monroe and JFK prints.

The fi rst image in the Campbell’s Soup series was 
illustrated and hand-painted using a basic stencil for 
the can. On each canvas, the gold medallion is a 
crude approximation and the text is deliberately 
inconsistent. This contrasted the machine-printed 
label with the less automated nature of art.

Warhol didn’t stop with the original 32 canvases 
acquired by Blum. There are hundreds of different 
representations of the cans, individually or in their 
hundreds. Variations on the original paintings were 
developed by the artist’s later experimentation with 
silkscreen techniques and bright new can colours.

Over 40 years on, the artist’s vision continues to 
inspire. “I’ve seen the brand manipulated and turned 
into a nineties rave fl yer, which was interesting,” 
says Hayes. “I’ve also seen Warhol’s portrayal of 

brands used for album sleeves, art shop windows, 
fl yers and magazine covers. It’s a technique that has 
been overdone now.”

But despite the possible overload of imagery, the 
original Campbell’s Soup can is still revered by both 
brand designers and product manufacturers alike. 
Put simply, it’s one of the greatest success stories in 
both brand design and American modern art. 
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A DESIGNER’S VIEW  
Dan Moore, 
Studio Output

Last year, Campbell’s celebrated Andy Warhol’s silkscreen tributes to their soup cans with a range of four 
limited edition colourful cans. These were only made available in Pittsburgh, USA, Warhol’s birthplace.

TITLE: American Visions: The Epic 
History of Art in America 
AUTHOR: Robert Hughes
ISBN: 0-37570-365-9 
PUBLISHER: Tate Publishing, 2001
PRICE: £20.49

TITLE: Warhol
AUTHOR: Heiner Bastion
ISBN: 1-85437-410-9
PUBLISHER: Alfred A. Knopf, 1999
PRICE: £29.99

TITLE:  Ernst Beyeler, et al
AUTHOR: 
Heiner Bastion
ISBN: 3-77571-163-5
PUBLISHER: Hatje Cantz, 2002
PRICE: £16.70

ESSENTIAL READING
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       LEARN MORE ONLINE

•  The complete history of The Campbell Soup Company
www.campbellsoupcompany.com/history.asp

•   The Andy Warhol Museum
www.warhol.org 
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MISSED AN ARTICLE? 

WHAT DO I NEED? 
All tutorials are in PDF format. 
You’ll need Adobe Acrobat to open them, 
which you can download free from 
www.adobe.co.uk

Once you’ve paid for your tutorial, you’ll 
have 24 hours to download the fi le. You can 
then download all supporting fi les for the 
tutorial via a link embedded in the PDF

BT CLICK&BUY 
BT click&buy is a secure way 
to pay for online content. If you 
have a BT telephone, you can 
have the 99p charge added to 
your phone bill. If you don’t 

have a BT account, simply charge it to your 
credit or debit card. Both options are safe 
and secure ways to pay.

Don’t worry! You can download previous 
Computer Arts tutorials online with our 
secure, one-stop shop. Just go to 
www.computerarts.co.uk/tutorials 
to fi nd out more

 

THESE 
TUTORIALS 

FROM 
99p!

THIS
TUTORIAL

FREE!

TEAM LinG - Live, Informative, Non-cost and Genuine!

http://www.adobe.co.uk
http://www.computerarts.co.uk/tutorials
http://www.computerarts.co.uk/tutorials


ISSUE 66: ON SALE NOW

 

EXPLORE THE POTENTIAL OF DIGITAL TYPE
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TURN TO 
PAGE 54

TUTORIALS
Top tips and tricks from the experts

SWISHMAX
Ever wanted to create an online game without 
the help of Flash? Now you can with Flash 
rival SWiSHmax. Expert action scripter Justin 
Mills solves this fully-interactive puzzle. 
TUTORIAL FILES ON THE CD

PHOTOSHOP
Anthony Robinson recreates the look and feel 
of the 1972 Olympics artwork with movement 
and striking colour effects courtesy of 
Photoshop’s Duotone and Posterize features. 
TUTORIAL FILES ON THE CD

Did you know you that there are more tutorials 
available on our website? Premium tutorials can 
be bought online starting from just 99p. There’s 
also a range of tutorials available free of charge. 
Just visit www.computerarts.co.uk/tutorials.

TUTORIALS ONLINE

AVID FREE DV
If your Super 8 film is damaged and tired from 
storage and over use, transfer it to digital video 
and return it to its former glory without losing 
its character. Chris Kenworthy explains how...
TUTORIAL FILES ON THE CD

TEAM LinG - Live, Informative, Non-cost and Genuine!

http://www.computerarts.co.uk/tutorials


TEAM LinG - Live, Informative, Non-cost and Genuine!



TUTORIAL

DUOTONE & POSTERIZE
PHOTOSHOP

By using Photoshop’s duotone and posterize features, it’s possible to add spectacular colour and shape to your 
work. Anthony Robinson explains how to use these techniques to recreate the look and feel of the Munich Olympics
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In 1972, Munich played host to the 
Olympics. At the time, the graphics 

and artwork used to promote the world-
famous games took on a Swiss graphics 
style, using duotone techniques and a range 
of colours that have since inspired many 
generations of artists.

This tutorial aims to recreate this iconic 
style step by step. You’ll take an ordinary, 
full-colour photograph and, using a range 
of techniques, create a stylised colour-
processed image using Photoshop to add 
duotone and posterize effects. 

The secret to creating successful images 
of this nature is to layer multiple images. 
You can then blend these images together 
using masks to create a stylised colour-
processed appearance. 

By using more than one image you can 
increase colour and tone to give your work 
added depth and originality. Plus, if you 
then include a range of shapes, colours and 
effects within several images, it’s much 
easier to go back and change a small part of 
one of those images if you are unhappy 
with something than it is to change an 
important part of a single image. 

Using and layering multiple images is a 
technique that I often use when creating 
illustration work of my own. I fi nd that it 
gives the fi nal image much more impact. 
By following this tutorial you will learn 
how to use Photoshop’s duotone and 
posterize features effectively – a process 
that can be used over and over again to 
create striking, eye-catching and original 
results, that look different every time.

1Before you start, launch Photoshop and 
import the fi le named dancer.psd from 

the Tutorial\Swiss folder on the cover CD.

2 Use the rectangular Marquee tool and, 
starting in the bottom left-hand corner 

of the image, select a square that contains 
the girl at the centre (but slightly to the left) 
of the selection. Hold down the Shift key and 
drag the selection until you create a perfect 
square. Next, go to Image>Crop.

3 Select the Pen tool and trace around the 
edge of the girl until the path closes. 

Don’t worry too much about the detail around 
the girl’s hair; just make sure that the bulk is 
selected as shown in the image above. This 
step may be time consuming, but it will save 
you time reselecting it later. 

Illustration and tutorial by Anthony Robinson
www.anthony-robinson.com

4 Duplicate the background layer and then 
go to Image>Adjustments>Brightness/

Contrast. Gradually increase the Brightness 
and Contrast until the hair starts to appear 
more isolated against the background.

DOWNLOAD

TIME LENGTH

2 hours

INFO

Anthony 
Robinson is 
a digital 
illustrator 
with over 14 

years experience. He has 
worked for a large 
number of editorial 
publishers, publishing 
houses, production and 
record companies 
worldwide and has also 
exhibited his work at the 
Buckingham Palace 
Gate, Soho Square and 
Mycene House galleries. 
To see more of his work 
visit www.anthony-
robinson.com.
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PHOTOSHOP 

9 With the hair selected, go to the Paths 
palette, hold down Apple+Shift and click 

on the Work Path layer so that her entire 
outline is selected. Go to the Channels 
palette and click on Save Selection As 
Channel (this will create an alpha channel) 
before removing the duplicated layer and 
keeping the original.

6  Select the Lasso tool and, while holding 
down the Alt key, remove any of the 

selections that don’t form part of the hair.

7 With the hair now roughly selected, hold down Apple, Alt and D to call up the Feather 
Selection dialog box (this can also be done by choosing Select>Feather). Set the Feather 

Radius to one pixel and press OK. This will soften the edges of the hair.

10    Inverse the selection by choosing 
Select>Inverse (or Apple+Shift+I). 

Next, use the Clone tool to take a sample by 
holding down the Alt key and clicking just 
above the ground. Finally, paint out the fl oor.
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5 Choose Select>ColourRange and then 
make sure that the Select pull-down 

menu is set to Sampled Colours. Click on 
the hair with the sampler and adjust the 
fuzziness until it really stands out against 
the white. Hit OK.

8  Press the Q key to select the Quick Mask 
and then, using the Brush tool, carefully 

start to paint-in any additional areas of the 
hair that haven’t been selected (the selected 
areas will be shown in red). Push the Q key 
again to exit the Quick Mask.

Hold down the Alt key 
while selecting the 
Marquee tool and you’ll 
be able to toggle 
between different types 
of that particular tool.

Hold down the Shift 
key while using either 
the Elliptical or 
Rectangular Marquee 
tools, and you will easily 
create a perfect circle 
or square.

THE MARQUEE TOOL
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14 Repeat the same process as step 13 with the original image, but this time set Ink 1 to a 
deep red, Ink 2 to pink and the Overprint Colour to a very dark yellowy green. It is 

interesting to experiment with this area of Photoshop, so don’t feel that you have to stick rigidly 
to the colours I’ve suggested here.

11    Once you have removed the fl oor, 
ensure that the image is still selected 

and choose Filter>Render>LightingEffects. 
Set the Light Type to Omni and the Light 
Colour to a peachy skin tone. You can now 
move the centre of the light so that it appears  
behind her hair. Hit OK.

13 With the duplicate in front of you, go 
to Image>Mode>Duotone. Make 

sure the Type is set to Duotone. Set Ink 1 to a 
pale orange and Ink 2 to a bright green and 
name them 1 and 2. Next, click the Overprint 
Colours button at the bottom of the dialog 
box and set the 1+2 colour to a deep green. 
OK that and the Duotone dialog box.
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16 Select all of the green copy by going to 
Select>All (or Apple+A) and Copy it 

by choosing Edit>Copy (or Apple+C). You can 
now Paste it into the purple image by 
choosing Edit>Paste, or using Apple+V.

15 Convert the image back to RGB by 
choosing Image>Mode>RGBColor. 

Go to Duplicate and again convert it to RGB.

12 Deselect the image and convert it to 
greyscale by choosing Image>Mode> 

Greyscale. Now duplicate the image by 
choosing Image>Duplicate. There’s no need 
to change the fi le name suggested.

You can quickly zoom in 
and out of an image 
without changing the 
tool you are using by 
holding down the space 
bar and the Apple key to 
zoom in (and the space 
bar, Apple and Alt keys 
to zoom out). Double 
clicking on the Zoom tool 
will take the image back 
to 100 per cent. If you 
hold down the space bar 
you can temporarily 
change to the Hand tool, 
which enables you to 
scroll around the image.

ZOOM & HAND TOOLS
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PHOTOSHOP 

PROTECT YOUR IMAGES
How to stop the thieves from 
stealing your images

NEXT ISSUE IN 

20 Duplicate the Swirls layer, fl ip it vertically and then rotate it 30 degrees anti-clockwise. 
Change the Opacity of this layer to 29 per cent and then go to Image>Adjustments> 

Levels. Drag the far-left triangle of the histogram slightly to the right to darken the shadows 
of that layer and hit OK.

21 Now fl atten the image by choosing 
Layers>FlattenImage and then go to 

Image>Adjustments>Posterize. The level 
has been set to ten, but again this is 
something you can experiment with.

22 It is advisable, although not essential, 
to tweak the image by adjusting the 

Hue and Saturation. This can be done by 
choosing Image>Adjustments>Hue/
Saturation. You can also make any minor 
alterations you require by going to Image>
Adjustments>ColourBalance.  

17 With the top layer active, click the Add 
Layer Mask icon in the Layers palette. 

Go to the Channels Palette, hold down the 
Apple key and click on the Alpha Channel you 
created earlier. In the Layers palette, click on 
the Layer Mask thumbnail. Now, using the 
Brush tool, mask out parts of her skin, 
ensuring that the fl ow is set to 20 per cent. 
This will make subtle tonal changes.

19Open Swirls.jpg from the cover CD, 
Select All, then Copy. Return to the 

main image and Paste. Change the Blend 
Mode of the Swirls layer to Screen (to 
eliminate the darker areas) and the Opacity to 
49 per cent. Move the Swirls layer to just 
below the top layer, hold down the Apple key 
and click and drag inside the image to place 
the swirls in a position of your choice. 

18 Create a new layer at the top of the 
Layers palette. Use the rectangle 

Marquee to select the left of the image, 
stopping just to the right of her left shoe. Go to 
the Channels palette, hold down Apple+Alt and 
click on the Alpha Channel to remove the 
selection of the girl from the new selection. On 
the new layer, fi ll the selected area with white.

Layers can be linked 
together by selecting 
one layer and then 
clicking in the box 
between the eye and 
thumbnail of the layer 
you want to link. If you 
hold down Apple+Alt+ 
Shift, you can even drag 
the layers to a new 
document (keeping them 
as separate layers). You 
can then move both of 
those images around at 
the same time. You can 
also change the size of 
the layer thumbnails by 
going to the arrow on the 
right-hand side of the 
Layers palette and 
selecting Layer Options.

LAYERING TIPS

TUTORIAL
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COMPETITION

Win fonts worth £2,999 and see your
own typeface in the Monotype Library!

WIN THE ENTIRE MONOTYPE 
FONT LIBRARY 

Computer Arts and Computer Arts Projects have teamed 
up with Monotype Imaging to bring you the chance not only 

of winning the company’s complete library of typefaces (worth a 
massive £2,999), but also to have your typeface feature in the 
celebrated Monotype Library. Just think – your hard work could 
soon join the likes of Gill Sans, Cartier Book and Baskerville!

This competition gives aspiring typographers the chance to get 
noticed and have their work feature in one of the world’s biggest 
collections of commercial typefaces. For details on how
to enter, plus rules and conditions, simply check out the 
“How To Enter” box, below-right… Good luck!

The Monotype Library includes...
1,352 fonts, including nearly 400 new releases and other fonts new 
to the collection • All of the classic Monotype fonts – Bembo, Dante, 
Ellington, Gill Sans, Fournier and Palatino – plus recent 
contemporary favourites such as Cartier Book, Mosquito, Mundo 
Sans and Scene • Licensing for 20 users and two printers 
• Both Macintosh and Windows PostScript data for all fonts.

Ë

Robin Nicholas
Head of typography
Monotype Imaging

Gillian Carson
Senior editor
Computer Arts

Rob Carney
Associate editor
Computer Arts Projects

The rules: The closing date for this competition is Friday 15 April, 2005. Employees 
of Monotype Imaging and Future Publishing, their agents and families are not 
permitted to enter. Multiple entries are not accepted. The Editor’s decision is fi nal 
and there are no cash alternatives. No other correspondence will be entered into. 
If you are entering by post and do not wish any of the companies involved in this 
competition to contact you with further offers, please indicate this on your entry. 
We will not pass your details on to third parties.

 HOW TO ENTER HOW TO ENTER

PRIZEWORTH £2,999!

In association with

THE JUDGES
In order to win this fantastic prize, 
all you have to do (!) is send us a font 
that you’ve designed. The font can be 
in TrueType, Postscript 1 or OpenType 
format, but must be your own work and 
designed within the last two years. For 
your font to be eligible, it cannot currently 
be sold by any commercial font foundry.

If judged to be good enough, your font 
will be included in Monotype’s Library 
alongside such classics as Bembo, Dante 
and Ellington. The winner will also receive 

the entire Monotype Library, worth £2,999.
Send your entries via email to: 

gillian.carson@futurenet.co.uk with the 
subject heading Monotype Competition. 
Alternatively, you can send your font
on CD, with contact details, to the 
following address: Monotype Library 
Competition, Computer Arts, 
30 Monmouth St, Bath, BA1 2BW.

Judging will take place on Friday 15 
April, 2005. Any entries submitted beyond 
this date will be disqualifi ed.
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TUTORIAL

SLIDER WEB GAME
Ever wanted to build an online game but can’t afford or understand Flash? Justin Mills explains step by step how 
to create an online slider puzzle using SWiSHmax – one of the most exciting software packages to hit the market

SWISHMAX

SWiSHmax, the latest SWiSH 
iteration, is sure to dispel the myth 

that this Flash creation program is merely 
a text effects package. In reality, this new 
and improved Flash alternative is jam-
packed with features, including 230
new effects, a JavaScript-like scripting 
language and support for dynamic 
content and input forms. SWiSHmax has
everything you could need to create fully 
interactive Flash presentations.

So why use SWiSHmax rather than 
Flash? Most users fi nd SWiSH much
easier to learn. SWiSH is designed to 
create complex effects without the need 
for code, and some of the built-in features 
just make life easier. Through this 
tutorial, I hope to introduce you to some 
of the program’s built-in features, which 

will ease development and help you to 
create fantastic effects.  

SWiSH provides strong scripting tools, 
which you can use to create dynamic 
content and interactive games, such as the 
puzzle featured here. SWiSHmax doesn’t 
implicitly support creation of classes,
but functions are scoped to their sprite, 
enabling functions to be used as methods.

This tutorial concentrates on creating 
simple graphics and centralising script. 
To polish things off, you’ll even be able 
to add a range of timeline effects… It’s 
the perfect introduction to SWiSHmax.

Since the differences between SWiSH 
and Flash scripts are minor, and some of 
the SWiSH effects and tools are great, 
this tutorial will interest Flash, SWiSH 
and future SWiSH users alike.

1 Choose File>Import and import 
sliderPicture.png. This will be the main 

image for your puzzle. Stage dimensions
can be set in the Movie Panel or dragged 
manually if you decide to use a larger image. 
Import your image to the stage and make 
sure the Layout Panel is selected before 
choosing View>FitSceneInWindow.

ON THE CD

TIME LENGTH

1 hour

INFO

Justin Mills
is a freelance 
action-
scripter and 

watercolour teacher. A 
former internal beta tester 
for SWiSHmax, he’s 
passionate about pushing 
the SWiSH-scripting 
boundaries. Find out more 
about his work at www.
justinfront.net.
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7 Create a sprite by choosing Insert>
Sprite to centralise your code within. 

Sprites (MovieClip to Flash users) can be 
considered a form of customisable class, 
since multiple instances can be used from
the Contents panel. Name the sprite 
“codeSprite”. In the Layout panel, drag 
codeSprite, so that it’s out of the way above
the visible stage. 

8 The Script panel relates to the object currently selected. Select codeSprite and drag 
the Script panel so that it’s fl oating. Select Expert mode from the Guided drop-down 

menu to enable direct typing of script and the use of the Add Script drop-down menu.

3 Rename the group “sliderGroup”, so
the tiles can be targeted by the code. 

Locate the Group panel and select the Target 
tick box. Open the Group and select all the 
pictures using the Shift key. Right-click and 
select Convert>ConvertToSprite.

6 In the Outline panel, select Scene1, and 
from the toolbar select a rectangle shape 

and draw a large rectangle on the layout. 
Select Modify>Transform>Rotate90. Go to 
Shape>Fill Type Linear and click on the 
arrows of the gradient to adjust the colours. 
Resize the shape to the stage dimensions. In 
the Outline panel, drag the Shape icon to the 
bottom layer. (See the CD fi le graphic.swi.)

5 Select the bevelled button shape and choose Modify>Convert>ConvertToSprite. Name 
the button solveButton in the Sprite panel. Open the solveButton in the Outline panel. Use 

the T tool to draw a text fi eld within the bevelled button. Make sure you set the Text panel 
exactly as shown and type “solve” in the bottom area of the panel.

4 Select Scene_1. Rollover the toolbar, 
locate autoShapes and select the bevel 

shape. Draw a box within the Layout panel 
to use as a Solve button. Adjust the bevelled 
button using the modifi ers (green circular 
anchor points). In the Shape panel, click on 
the large colour sample to display the 
Colour palette and pick a colour.

TUTORIAL

2 To create the slider tiles, go to Modify>
Break>BreakIntoPieces. Select a 

Regular grid with fi ve columns and fi ve rows 
and Allow non-triangular pieces. Finally, set 
the Cascade order, which will determine 
how SWiSH automatically names each piece.

Your image should 
occupy a distinct new 
depth/layer on the 
Timeline panel with
the name of the image
(in our case “slider
Picture”). It’ll also 
appear as an icon in 
the Outline panel.
The Outline panel
is a visual means of 
representing the 
depths and grouping 
within your movie, akin 
to a directory structure, 
with an additional 
clickable eye symbol 
that toggles to a cross 
or padlock for hiding 
and locking during the 
editing process. Most 
panels have useful 
right-click menus.

THE OUTLINE 
PANEL
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SWISHMAX

14 Another stage is added 
(“moveIfNear”) to check if a tile is 

positioned near to the lastTile and suitable 
to swap. movelfNear checks if either the x or 
y values (not both) (ex -or operator “^“) are 
the same as the lastTiles x and y. If the tile is 
near, then it will swap tile positions with the 
“swapPos” function (see script4.swi).

9 All “SWiSHScript” must be contained within an event or a function and (with the exception of 
the last line) must be terminated with a semi-colon. Missing just one semi-colon will turn 

the code red – denoting errors. This simple script will trace some text to the Debug panel when 
the sprite is placed by the SWiSH internal Flash player.

11 Add the code to put the tile references 
in an array (see script2.swi on the CD). 

Creating a property to store all your tiles, by 
looping through all the objects (tiles) in the 
sliderGroup, using a “for...in” loop.

10 Enter the code shown above. When the codeSprite fi rst loads, the “onLoad” event will 
fi re – declaring instances’ properties/variables and running the initialisation function 

“init”.  The init function will set up the values of the custom properties and then call functions to 
run the game. Go to Control>PlayMovie and the Debug panel should trace out “initialise 
script”, “create tiles”, and “randomise tiles”. (See script1.swi on the cover CD.)

12 Run Control>PlayMovie and you’ll 
notice that the last tile disappears

in agreement with the last tile’s “_visible” 
property, set to false in the script. Subsequent 
steps will describe code added.

13 The “onPress” event is triggered 
when you click on a tile, but only 

works when tested in an external Flash 
player. With SWiSH, you can use “on(press)
{}” and “onSelfEvent(press) {}”, but these 
events would need to be placed in every tile. 
Instead, the onTilePress function loops 
through your tiles using a “for (... in ...)” loop, 
and assigns a function (swapPos) to each tile 
“onPress” event. The “swapPos” function 
swaps the x and y values of two sprites so 
that they change positions (see script3.swi).
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15 Instead of a simple swap, you can 
tween the tile into position. Initialise 

your tween and set the end frame position or 
target the invisible tile or lastTile. Set the 
speed of the tween and then the “tweening” 
function to run each frame of the tile using 
the onEnterFrame event. The “tweening” 
function uses Math.approach() to calculate 
deceleration. But if you adjust the easing 
parameter (“speed”) for every frame, you’ll 
achieve an acceleration and deceleration to 
the target position (see script5.swi).

SWiSH now allows 
strict typing, but does 
not do any checking. 
This is a future-proof 
feature. You’ll often use 
declaration of a data 
type after the variable 
name – for instance, 
var variableName:
TypeOfvariable;

STRICT TYPING
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18 Now that you’ve implemented a
step backwards, adjust tweening to 

continue stepping backwards until there is no 
history. An array’s length property describes 
how many items it contains. So “swapPos” 
until history.length is 0 (see script8.swi).

17 To solve the puzzle, you must store a 
history of movements, assigning the 

solveButton’s onPress event initially to an 
undo (single stepBackwards). Use Push to 
push references to moved sprites (tiles) into 
the history array and Pop to take off the last 
tile pushed. Use a “solve” property to control 
the history – you don’t want to record history 
moves (see script7.swi).

20 To check that the game is solved, you 
need to store the original tile positions 

(“info” array) and compare them with the 
current status using the checkingIfFinished 
function (or tweening function). When 
fi nished, the “hasFinished” hides the 
solveButton and removes all the onPress tile 
events. Add an “info” variable declaration to 
the onLoad event (see fi le script10.swi).

19 Modify the randomise function so that 
it will generate (suitable) random tiles 

within an iterative tile jumbling loop. The loop 
is formed with “swapPos” and the other tile 
movement functions (see script9.swi). 

21 Consider improving your code so that 
your code is more reliable and future 

modifi cations are simpler. We used several 
onLoad events, but it’s wise to collect these 
events into one onLoad event. It’s now 
obvious that the solveButton.onPress=step
Backwards; shouldn’t have been in the 
onLoad, but rather actioned after the tiles 
have been randomised (see fi le script11.swi).

22 Now polish the project! After selecting 
the sliderGroup, press the Fx button, 

select Blur and adjust the Blur Settings. Run 
the Movie <alt> + F, T, P. The code you 
wrote won’t work (see effect1.swi). This is 
because the effect needs to fi nish before code 
can be applied to the sliderGroup.

16 The Math.distance function checks 
that the tile has reached the target

to within one pixel, preventing the onEnter
Frame running forever. Delete the onEnter
Frame event from your tile and set its position 
to the target (see script6.swi).

23 Select the end of the codeSprite 
timeline and right-click to Place the 

codeSprite. Add script to the scene to stop the 
movie on frame six. Then, on frame seven, 
Remove the codeSprite ready for the next 
step. Run the movie in the external player –
it should now work (see fi le effect2.swi).

24 To end, click on frame seven of the 
sliderGroup, click on the Fx key, 

choose Fade>FadeOut and change the 
duration to about 30 frames. Add “_parent.
play()” to the last script line of the 
“hasFinished” function in the codeSprite.
This will play the fade out effect (in the 
codeSprite’s _parent) when the puzzle has 
Finished (see fi le effect3.swi).

25 You may want to try using a different 
picture with more tiles or change the 

effects. You could even try a video version of the 
slider puzzle (which is possible) or add other 
features. Having used centralised code, you’re 
now in a good position to create your own 
game, but there’s still a lot to learn. 

TUTORIAL

You may notice a
magic word “this” in 
swapPos: it references 
the sprite that a 
function exists on (the 
tile pressed); omitting 
“this” references the 
properties where the 
function is defi ned 
(codeSprite) (ie, this._x 
= x position of a tile, _x 
= x position of the 
codeSprite).

SWAPPOS

ANIMATION MASTERCLASS
Bring your images to life in our 
in-depth animation tutorial

NEXT ISSUE IN 
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 The realities of home storage 
and decades of repeated 

projection means that most 8mm 
fi lm is damaged. Watching 8mm 
footage is time-consuming, and 
editing raw fi lm requires patience 
and persistence. So why not turn 
your fi lm into video? You can then 
archive your footage, edit at will, 
correct the picture quality and watch 
the movies as often as you like.

Many people still shoot on 8mm 
fi lm rather than video. Film is richer, 
and more detailed. But to make the 
most of any 8mm footage, you’ll 
need a good telecine system.

Telecine is a way of fi lming the 
projected image that retains the 
quality of the original footage. But 
you can’t just set up a normal screen 
and try to fi lm from the side of the 
projector – by recording off-centre, 
the image would appear distorted. 
Instead, you should project your 
8mm footage onto a translucent 
screen. You can then angle an 
adjacent mirror, point your DV 
camera at it, and start recording.

Once your footage has been 
transferred to DV tape, you can 
import it to Avid Free DV (free on 
the cover CD), clean up the frame, 
correct poor exposure, edit out the 
mistakes, and brighten the colours.

When shooting Super 8, it’s 
possible to record on a DV camera or 
MiniDisc. To synch that sound to the 
picture, you’ll need to load the audio 
into Avid Free DV. Load the sound 
by transferring the cassette sounds to 
DV tape, then to your computer.

Some old Super 8 fi lm contained 
a magnetic stripe to record live 
sound. If you’re converting this type 
of material, connect the projector’s 
sound output to your DV camera’s 
sound input. Sound synch will be 
slightly easier, but you’ll still need to 
make manual adjustments.

Sound synch is vital – if the image 
is out of step with the sound, your 

audience will notice immediately. 
They may forgive a poor picture, but 
not dodgy sound. Traditional 
synching involved precisely 
increasing or decreasing the audio’s 
speed. These days, editing software 
makes it so easy to manipulate audio 
tracks that you can synch clips with a 
simple cut and paste, without 
changing the speed of the track itself.

SUPER 8 TO VIDEO
AVID FREE DV

Super 8 isn’t just a nostalgic throwback, it’s a format that’s still used by fi lmmakers worldwide. 
So make sure your own efforts endure – by transferring them to digital video using Avid Free DV

DOWNLOAD

INFO

Chris 
Kenworthy is 
a writer and 
director 
based in 

Perth, Australia. He works 
with digital video, fi lm and 
computer-generated 
material and has written 
two novels, countless 
features and works on 
several TV series.

THE PROBLEM

Super 8 fi lm looks terrifi c 
when it’s transferred to 
video. But how do you go 
about transferring your 
latest short fi lm or 
archiving your old home 
movies without sacrifi cing 
that unique, freshly 
projected look?

1. Projector Use a new bulb to 
prevent the image becoming too 
yellow. Place the projector on a level 
surface and tape it down with gaffer 
tape, so there’s no need to readjust 
each time you change the reel.

2. Mirror Place the mirror at a 45-
degree angle to the translucent 
screen and keep it clean.

3. Translucent screen Focus the 
projected image onto the translucent 
screen. The screen should be placed 

at the end of a lightbox, which will 
stop refl ected light hitting the screen 
and fl aring the image.

4. Lightbox Build you own lightbox – 
or buy one cheaply with a built-in 
screen and mirror. Again, tape it to 
the table so that nothing moves. 

5. DV camera Place your camera 
close to the mirror at a 90-degree 
angle to the projection set-up. Don’t 
place the camera too far away and 
zoom in as focusing will be diffi cult.

TRANSFER FILM TO DIGITAL 

1

2

5

3

4
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1 Import Stunt.mov and Stuntsound.mov 
from the cover CD into Avid Free DV. 

Although there are no gaps in either clip, they 
don’t quite match up. To synch the clips, fi nd a 
point where the sound clearly matches the 
image. Arm movements or shirt rustles, are 
always a good choice.

2 Select the sound clip and drag it slightly 
until the sound you’ve chosen matches the 

picture. In an ideal world, you would use the 
sound and image of a clapperboard to synch 
up. Instead, use the clearest sound you can 
fi nd; in this case, an arm movement towards 
the end of the clip.

4 Use Insert Edit to make a cut at a quiet 
point, just a few seconds into the clip. Drag 

the left-hand clip slightly to the right, making 
tiny adjustments until the opening moments 
synch properly. You can now synch the rest of 
clip by making these small cuts further along.

5  Place the playhead on a transition; go to 
Fast Menu and Quick Transition. Set to 

Dissolve on the Cut for about 12 frames. When 
you listen back the cut should be inaudible, but 
if you do fi nd sound overlaps, reduce the 
Dissolve to six frames. 

SOUND SYNCHING
It’s best to get cracking on sound fi rst, as this can be knocked back out of synch as you work on the images. We’ve 
supplied both sound and images, so that you can perfect your synching skills before you get started on your own project

3 Once you’re happy with your sound synch, 
watch the clip through. You’ll notice that 

although the sound is well synched in the last 
quarter of the clip, it’s way off in the fi rst half. 
This will be caused by common errors and 
discrepancies between the sound and fi lm 
recording speeds.

6Repeat this process throughout the clip 
until everything’s synched up and dissolved. 

If you’re ever in doubt about a synch, it’s 
probably wrong. It can also help to leave your 
work for half an hour before watching it afresh 
to double-check that everything is accurate.

CRYSTAL SYNCH
The nirvana of Super 8, 
crystal synch, enables 
you to record sound and 
picture at an identical 
rate. When magnetic 
Super 8 fi lm was 
available, this wasn’t a 
problem because the 
sound was recorded on 
the fi lm strip. But 
because sound is now 
recorded separately, 
many Super 8 users buy 
a device that synchs 
their camera to a 
sound-recording device. 
Far from cheap, crystal 
synch won’t solve all 
your synching 
problems; the sound is 
always slightly mis-
timed (due to the way 
projection systems 
work), so you’ll still 
need to make one 
manual adjustment 
when you’re converting 
to video.

FILM INTO VIDEO: A GUIDE TO 
MERGING THE TECHNOLOGIES 
(SECOND EDITION)
Stuart Blake Jones, 
Richard H. Kallenberger and 
George D. Cvjetnicanin
PRICE: £42.99 
PUBLISHER: Focal Press 
ISBN: 0-240-80411-2

If you want to know more about 
8mm transfers, there’s plenty of 
home-made advice on the web. 
But for the best information, 
shell out for Film Into Video. 
It’s far from cheap, but gives 
you the inside information on 
software, hardware, and just 
about every approach to fi lm 
and video transfers.

READ THIS...
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1 First go to File>Import and then load the 
Holiday.mov clip included on the cover CD. 

Click the Effects Mode button, then the purple 
Effects button in the bottom left-hand corner. 
Next, choose Image>Resize and drag this 
fi lter to the clip. Finally, call up the Effect Editor 
and adjust the Scaling and Position to resize 
the main image.

3 Editing physical fi lm is diffi cult, but now 
you’ve converted your fi lm to DV, cutting 

out the waste is easy. Position the blue 
playhead just after the opening, fl ickering 
section. Choose the Insert Edit button, select 
the fi rst section of the clip and hit Delete.

2 The Resize tool also enables you to 
eliminate scrappy edges. If you’re using an 

old Super 8 projector, the edge of your movie 
might look ragged, so crop hard to remove this. 
Drag the Crop sliders in until the image has 
sharp, equally sized edges, not quite at the 
perimeter of the screen.

4 Remove fl ashes and brief moments of 
blurring. Make two Edit points on either side 

of the errors. Place the blue playhead just before 
the damaged frame and click Insert Edit. Do the 
same to the frame following the damage. Select 
the offending frames and delete.

5 Apply the Colour Effect fi lter by dragging it to 
each clip in turn. To correct poor exposure, 

go to Luma Range in the Effects Editor. Click-
hold the White Point box and drag the Eye-
dropper to a point where your image should be 
pure white. Do the same for Black Point. 

6 Use Chroma Adjust to increase the 
Saturation, particularly if your fi lm is old 

and faded. Finally, use Colour Gain to adjust the 
colours so that fl esh tones, greenery and the 
sky appear as natural as possible. 

EXPERT ADVICE

1 That synch-ing feeling Sound takes less 
time to process and is easily knocked out 

of synch, so always edit for sounds fi rst and 
then work on the picture. You can correct  
effects and colour once you’ve fi nished.

2 Archiving Don’t just burn a playable 
DVD, because DVD is a highly 

compressed viewing format. To archive, 
create a QuickTime fi le at full resolution 
and Best Quality, and store it on a DVD or 
hard drive.

3 Projector focus You’ll need to refocus 
the projector each time you use a new 

spool of fi lm. Don’t assume that the focus 
can be set once; it changes according to the 
thickness and fl exibility of each fi lm.

4 DV focus In theory, you should be able 
to set the focus on your DV camera 

once and leave it. To focus, switch the 
projector on without any fi lm running 
through it and hold a piece of paper fl at 
against the translucent screen.

5 Steadyshot If your camera comes 
equipped with a Steadyshot feature, 

switch it off. The square of light doesn’t 
move, so Steadyshot can overcompensate, 
making the image wobble.

6 Darkened room Set up your telecine 
suite in a darkened room, but not in 

pitch black. Although arguments rage over 
the best solution, most users fi nd that a 
near-dark room yields the best results.

7 Reversed spool If you fi nd a spool of 
fi lm that seems impossible to put 

through your projector, it could be that it 
was never originally rewound. Your 
projector’s rewind setting should help.

8 The projected look You could perfect 
your image in Avid, but some users 

prefer to leave soft edges, jumpy cuts and 
leader images on, for an authentic feel. 

9 Sound replacement If you’re using 
footage that was shot without sound, 

you could add music. Some purists even 
add a recording of the projector sound, to 
ensure the home-movie feeling isn’t lost.

10 Monitor Focusing, setting exposure 
and checking your results can be 

tricky with a DV camera viewfi nder. So 
connect your camera to a TV while you work.

TOP TEN TIPSPROTECT YOUR IMAGE
Now make a start on the moving images. You’ll need patience – editing fi lm can 
be a tricky process – but get it right and your Super 8 will really come to life

LEADERS
Every reel of fi lm 
comes with a short 
“leader”, a piece of fi lm 
used to lead the fi lm 
through the projector. 
The leader often has 
tiny holes in it, with 
times, numbers and 
words printed into the 
fi lm. Leaders allow you 
to handle the ends of 
the fi lm without 
damaging the picture. 
Use leader images to 
focus the projector so 
that you don’t damage 
the important footage.

DYNAMIC RANGE
Film can record detail 
from the darkest 
shadows to the 
brightest glows. Video, 
unfortunately, cannot, 
as its range is far less 
dynamic. The upshot is 
that no matter how 
good a job you do of 
converting your DV 
footage, it will never 
have the dynamic range 
of the original, 
projected fi lm. To get 
the best results, set 
your camera’s exposure  
so that shadows remain 
detailed, but you can 
still clearly see clouds 
in bright skies.
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Professional software training 
is all about boosting your 

effi ciency quickly and effectively. 
It can provide you with essential skills 
to improve your workfl ow, attract new 
clients, or even just beef up your CV. 
But it’s an expensive game, so it’s only 
really worthwhile if you know you’re 
going to get the most out of it. That 
means understanding what’s on offer.

How will I know?
Anyone considering this type of 
training should have identifi ed a
skills gap before going on to think 
about the course itself. George Snow 
of 3D3 World runs a range of software 
courses from Maya and Photoshop
to Flash, all from his converted 
Tuscan villa.

“If the student knows what he 
wants from a course,” he explains, 
“that will inform the teaching staff 
and ensure that he gets value from the 
time and money invested.”  

There are two basic approaches to 
determining the need for training: 
reactive and pro-active. Responding to 
a perceived skills shortfall by reading-
up on the relevant software will be the 

most familiar scenario for many. 
Sandip Bhathal is a marketing 
executive at Sphinx IT distributors:
“I could ask my colleagues for help 
with programs such as Dreamweaver,” 
she says, “but I knew I could do 
things a lot better.” 

Bhathal underwent training at 
Symbiosis and returned to work with 
new HTML, Photoshop and Flash
skills. She was immediately more 
comfortable with her work: “You 
know yourself when you’ve got the 
hang of things, because you can just 
come back to the offi ce and get on 
with it,” she says, adding that, “The 
little books they gave me to take away 
have become like my bibles.”

This highlights the questions 
surrounding the quality of course 
materials and after-sales support.

Meanwhile, the pro-active school 
believes, like most training fi rms,
that it’s best to be prepared before
the cracks in your knowledge show 
up. As Highlander’s managing 
director Andy Gardiner puts it: “The 
most successful organisations have 
a strong investment in training.” 
Employers must be aware of 

Ë

The increasing speed of technological development means that if 
your skills stand still, you’ll quickly fall behind. Mark Penfold takes 
a look at how best to keep yourself ahead of the competition

Ë

GET STARTED WITH… 
PROFESSIONAL 
TRAINING
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Garrett McKeagney is an alumnus of George Snow’s 
acclaimed 3D3 World training course in Tuscany:
“I’d just bought Maya for the company and having 

looked at the programme I knew that I needed 
help. George is a great teacher,” says Garrett. 

“I did another course with him last year and I 
would like to do another this year.”

technological developments and keep 
abreast of them, acquiring skills that 
could improve your work. 

Won’t books do?
The obvious alternative to expensive 
training is to pick up a textbook that 
covers your subject and get stuck in. 
And indeed for many this is a viable 
option; particularly as the range and 
quality of titles dealing with creative 
software continues to expand. 
However, not everyone is suited to 
self-teaching: “I’m a ‘show me’ type 
of person,” admits Bhatal. Some 
people need the interaction provided 
by classroom teaching to learn. 

“It’s all about people,” says 
Macromedia’s Ian Turner. Yes, the 
quality of instructor will, of course,
be of primary concern, but not to be 
overlooked is the chance to interact 
with other designers. “Being in a room 
with a number of like-minded people 

gives you a chance to interact with 
other users and learn from them
too,” says Turner.

“The big problem with learning 
from books is that you have to follow 

the instructions to the letter and not 
miss out a sentence,” says Snow, 
highlighting a need for interactivity. 
“With a teacher, you analyse the 
problem together and come up
with an alternative.”

The criteria
Once you’ve established your needs 
and have decided you can’t go it 
alone, the next thing is to ensure your 
course ticks all the right boxes; that it 
covers all the key areas in a way 
you’re happy with. According to 
Tidalfi re’s Louise Scott, “Not every 
company publishes a course outline, 
but it’s essential that you agree with a 
training provider what the training 

will be before you confi rm. 
Otherwise, how can you complain if 
you didn’t get what you paid for?”

As Turner points out, “One person’s 
easy could be another’s advanced.” 

He also goes on to say that this type of 
discrepancy is particularly evident 
among the self-taught, as never using 
an objective yardstick makes it hard to 
judge your own level. The message is 
clear: “Do plenty of research. There’s 
a huge [Macromedia] community out 
there. All you have to do is ask for 
advice on a forum.”

And this is true for virtually every 
major software package. 

Certifi cation
This is the big one, particularly if 
you’re using a course to improve your 
employment profi le. Most courses 
will supply you with a certifi cate of 
attendance, but even the trainers are 
willing to admit that, in most cases, 
these prove little more than your 
ability to turn up.

Tom Jeffs teaches Photoshop skills
at Metro New Media: “The problem is 
that there’s no system to distinguish 
between a £50 evening class and a 
full-time course in a group of four.” 
This dilemma makes selling these 

“The problem is that there’s no system 
to distinguish between a £50 evening  
class and a full-time course for four”

The classroom isn’t the only 
place you can develop your 
skills as a designer

The range of alternatives to 
classroom learning continues to 
expand daily. From books and DVDs 
to online resources, there’s 
something for every level, 
application and budget.

Books are probably the fi rst port 
of call for many. “There’s a myriad of 
books to match almost every 
learning style,” says Hannah Latham 
of Pearson Education. These range 
from offi cial training resources, such 
as Adobe’s Classroom in a Book 
series, to tutorial-based 
introductions – the Visual Quickstart 
series, for example.

The boundary between books 
and DVDs continues to blur as 
numerous titles increasingly sport 
their own video instruction. Sybex 
has been working with Alias for 
some time to produce the Maya 
Fundamentals series, combining 
the two media. The excellent
Final Cut Pro 4 And The Art Of 
Filmmaking prompts the question 
– book with DVD, or vice versa?

Meanwhile, pure video training 
is also gaining in popularity, with 
companies such as Digital Tutors 
producing materials to cover just 
about every digital medium 
imaginable for a fraction of the 
cost of classroom-based courses.
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ALTERNATIVES
While most institutions provide 
their students with certifi cates to 
show that they’ve fi nished a course, 
the most important qualifi cations 
involved in professional training
are those hanging on the wall 
behind your tutor.

Most big software manufacturers 
go to great lengths to ensure that 

certifi ed trainers are fully qualifi ed. 
As Symbiotic director Sally Day 
points out, “The exams the 
instructors sit are incredibly hard. 
They aren’t just a formality.”

Ian Turner, Macromedia’s head 
of European marketing, agrees. 
Macromedia’s accreditation policy 
is well known for being one of the 

most technically demanding in
the industry.

“There are levels of qualifi cation, 
each of which demands the tutor 
present one of our courses on 
video,” he says. “These [videos]
are sometimes sent to the US
for approval [by Macromedia].
It’s a rigorous procedure.”

CERTIFICATION FOR BEGINNERS

The big guns are eager to ensure you’re being taught by the very best
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Find a fulfi lling course…
Knowing what to look for is easy if 
you already know something about 
your software, but beginners can 
fi nd it hard to determine whether a 
particular syllabus will give them a 
good grounding. Here’s an overview 
of some major applications. 

PHOTOSHOP
Getting started • Working with 
selections • Layer basics • Painting 
and editing •  Masks and channels
• Photo retouching • Basic Pen tool 
techniques • Vector shapes and 
clipping paths.

FINAL CUT PRO
Introduction to DV and QuickTime • 
The anatomy of Final Cut Pro • 
Starting a project and setting a 
capture scratch • Digitising footage
• Managing clips • Creating 
sequences and setting sequence 
preferences • Three-point editing 
with the viewer, canvas and timeline 
• Creating movement using motion 
properties • Using transitions and 
fi lters with video and audio • 
Creating titles and effects • 
Importing and animating Photoshop 
layers • Exporting material for 
multimedia and internet • Laying off 
to tape using Print to Video.

DREAMWEAVER WEB 
DEVELOPMENT
Getting started • Adding content to a 
site • Formatting text • Working with 
graphics • Navigating your site • 
Designing layouts using libraries 
and templates • Creating forms • 
Testing, maintenance and uploading.

MAYA 3D BASICS
Building models using polygons
and NURBs • Texturing using image 
fi les and procedural shaders • 
Lighting and camera control • 
Hierarchical relationships • 
Animation and keyframing.

FEATURE

courses on your CV a bit diffi cult. 
“My advice is to ‘big it up’ as much as 
possible,” says Jeffs. Good advice, but 
this would only be a problem if you 
haven’t already put the skills you 
learned into practice.

Highlander is an exception. Andy 
Gardiner describes his courses as 
good prep for sitting the Adobe and 
Macromedia-certifi ed user courses: 
“If a trainer is confi dent in their 
courses,” he says, “they should bill 
them as leading to certifi cation.” 

Gardiner has a point, but only if 
certifi cation is your reason for 
attending the course in the fi rst place. 
For most delegates, the question 
becomes more one of whether your 
course and its tutor are sanctioned by 
the developer itself. This is easy to 

SYLLABUS CHECKER

As an IT manager, Greg Mumford needed
to rapidly brush up on his knowledge of 
Acrobat, Flash and InDesign – Symbiosis 
training helped him do that. “The real 
advantage for me,” he says, “was being
able to ask questions, to adapt the material 
to my own situation.”

Andy Donovan went to training providers Ubiq (www.ubiq.co.uk) to update his knowledge
on the arcane science of Cascading Style Sheets, and couldn’t have been happier with the 
results. “CSS was the answer to all our HTML problems,” he recalls.

THE IDEAL PATH TO TECHNICAL ENLIGHTENMENT

Finding the right course to suit all your needs – a case example

establish. All the major manufacturers 
maintain up-to-date lists of their 
training partners, usually online.

Class of your own
Once you’ve decided that the school 
is suitably qualifi ed and your tutor 
makes the grade, check the facilities 
and materials. As Tidal Fire’s Louise 
Scott says, “You have to make sure all 
the equipment is up to date and every 
student has their own machine.”

This advice may seem obvious, but 
if you’re paying £500 for a two-day 
course, your equipment must be up to 
scratch. Today’s graphics applications 
are incredibly memory intensive and 
on a 3D course, for example, your 
machine’s RAM complement could 
determine the success of your 

Andy Donovan, a new media 
designer for Emap Automotive, 
subscribes to the forward thinking 
approach: “I’d been thinking about 
web standards for a while,” he says, 
“and Cascading Style Sheets (CSS) 
seemed to be the obvious solution
to all the problems we’d been 
fi ghting with HTML.”

Having identifi ed a technology 
that could improve the online 
materials that Donovan’s 
department produced, the next step 
was to fi nd a suitable course. “The 
Ubiq website [www.ubiq.co.uk] 
infl uenced my decision because, 
aside from being well designed, 
it was constructed using CSS.” 

The next important consideration 
for Donovan was the size of the 
class, which turned out to be one 
to one: “It was great being able to 
recap my needs.”

This is a textbook example of
how training should work. It’s easy 
to get it right providing you take a 
considered approach.

learning experience. So check the 
standard of equipment, presentation 
materials and technology.

Class sizes vary from between 
three and 15, depending on level and 
institution. Generally, though, the 
higher the level, the smaller the 
numbers. As Tom Jeffs of London’s 
Metro New Media says, “Avoid big 
groups. If you’re paying £50 for a 
course, you might as well buy a 
multimedia CD as you’re not going to 
get much time with the tutor.” 

Mind the skills gap
Media Training Northwest (MTNW) 
was set up primarily as an industry 

Ë
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FEATURE

body designed to resolve a perceived 
skills gap in the broadcast, fi lm and 
multimedia industries of the North 
West. “The problem isn’t regional,” 
says chief executive Lynne McCadden. 
“The problem is inherent in the rapidly 
changing nature of the industry.” 

With sponsors including the BBC, 
ITV and Cosgrove Hall Films, 
MTNW is attempting to give the 
creative industry the training boost it 
needs to fulfi l its economic potential. 
“Employers often complain that the 
students they take on just aren’t job 
ready,” says McCadden.

There are many reasons for this, not 
least the cost of providing cutting-edge 
hardware and software, which makes 
this type of training provision diffi cult, 
even for universities. But the trouble 
doesn’t stop there. “In terms of 

training providers, the South East is 
pretty well catered for, but there just 
isn’t the supply elsewhere,” says 
McCadden. MTNW has sent its 
trainees, sponsored by up to 70 per 
cent, to attend courses in London.

So MTNW plans to source funding 
from the likes of Skillset and use the 
money, in partnership with industry, 
to deliver the kind of training that is 
currently so lacking. Jon Wetherall’s 
games company, Onteca, has been 
collaborating with MTNW in an 
attempt to develop a new generation 
of technically capable games 
developers. “Some employers are 
good about training. Codemasters, for 
example, gives new recruits a six-
month introduction to bring them up 
to speed.” But, says Wetherall, “The 
majority of companies just don’t have 

the resources for that, so training 
needs to happen elsewhere.” 

Learning curve
Even though the creative industries 
have an almost insatiable need for
new skills, getting access to quality 
training is diffi cult and expensive. For 
those not backed by an employer, the 
challenge is to hunt down a good but 
inexpensive school or to get funding 
from organisations such as Skillset
or MTNW. But neither option is 
particularly straightforward.

Even for the professional, it seems, 
there’s plenty of learning to do before 
you set foot in the classroom. Clear 
objectives are obviously a priority. 
But then you need to fi nd a course that 
matches your needs exactly – and 
ensure the reality measures up.

If you’re paying full whack for a course, 
you’ll want the best, so ensure you get just 
that. Check the equipment is cutting edge, 
that you’ll have your own machine, and that 
your instructor is well versed in the ways of 
the classroom. This Highlander suite gives 
you some idea of what to look out for.
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REVIEWS
All the latest kit, put to the test

HARDWARE
HP COLOUR LASERJET 2550N P81
EPSON PERFECTION 2580 P83
LACIE 40GB MOBILE HARD DRIVE P84

SOFTWARE
ADOBE ACROBAT 7 P76
PRINTDEVIZOR 1.0 P78
VIDEO TOASTER 4 P80
FOLDUP! 3D 1.5 P82

All our products go through rigorous testing and 
only truly outstanding and essential pieces of kit 
receive the coveted fi ve-star rating.

REVIEWS

GROUP TEST: 3D SOFTWARE
MAYA 6.0 P90
SOFTIMAGE XSI 4.5 P90
3DS MAX 7 P91
LIGHTWAVE 8.0 P91
CINEMA 4D 9 P92

BOOKS
GRAPHIC DESIGN SCHOOL P87
THE DIGITAL DESIGNER’S BIBLE P87
MOVING PIXELS P87
CALLIGRAPHY WITH PHOTOSHOP P87

RECOMMENDED
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REVIEW

AT ITS MOST BASIC, ACROBAT
IS A SINGLE-CLICK OPERATION

FOR MANY  TYPES OF DOCUMENT

Adobe’s Portable Document 
Format has established itself

as the de fact standard for sharing 
digital documents of all stripes and 
colours. Of course, it’s also an 
invaluable solution for digital print 
processes; Computer Arts has been 
produced using the PDF for around 
fi ve years now.

So it’s diffi cult to imagine exactly 
what Adobe could add to the latest 
version of its PDF creating package, 
Acrobat. Quite a lot, as it happens – 
although many of the additions are 
aimed at business users rather than 
creative professionals. We took a 
look at a late beta version which was 
running remarkably smoothly.

Acrobat 7 Professional actually 
consists of three programs: the main 
app itself, Distiller 7 (for converting 
PostScript fi les to PDF) and 
Designer 7 (for creating electronic 
XML forms for distribution as PDF or 
HTML). At its most basic, Acrobat is 
a single-click operation for many 
types of document, automatically 
installing a Convert to PDF toolbar in 
any compatible app found on your 
system (be it Microsoft Word, 
Internet Explorer, AutoCAD…). 

Interestingly, there’s now support 
for Microsoft Outlook, so you can 
convert a folder-full of emails into one 
PDF document for archiving if you like.

Alternatively, you can use the 
virtual PDF Printer to output just 

about any document as PostScript, 
which is then automatically 
converted to PDF. And if push comes 
to shove, you can even scan a paper 
document and use OCR to create a 
rough-and-ready translation.

Acrobat 7 adds the capability to 
create a PDF from multiple fi les,
be they images, text or whatever. 
Bookmarks are automatically 
generated for each fi le, and the 
elements of such “combined” PDFs 
can even be extracted again, back to 
their original fi le formats. As before, 
the app provides comprehensive 
options for controlling the 
compression of bitmaps, colour 

policies and so on for each format – 
although, curiously, you can’t alter 
any of these parameters for a page 
converted from HTML. For software 
that revels in fl exibility, this seems 
oddly restrictive.

Once a PDF has been created, 
there are numerous ways to add 
comments and notes to its content. 
For engineering and CAD docs, the 
new Dimension tool enables you to 
check an existing measurement and 
add a corrected one if necessary. 
Then there’s the new Callout tool 
for adding location-specifi c 
comments, complete with arrows – 
rather more subtle than the old Note 
tool, which often obscures the doc. 
All types of comment can now 
accommodate cut-and-pasted text, 
too, which means you can refer to 
Web links or the like – or even attach 
a specifi c fi le as a comment.

MAC Yes    PC Yes

PRICE

Professional £464
(upgrade £159)
Standard £288 (upgrade £93)

CONTACT

Adobe 020 8606 1100
www.adobe.co.uk

SYSTEM

MAC: PowerPC G3,
128MB RAM, 495MB HD, Mac 
OS X 10.2.8
PC: Pentium processor, 
128MB RAM, 460MB HD, 
Windows 2000, XP

FEATURES

• Improved performance
•  Extended commenting 

capabilities (free Reader)
•  Assemble multiple fi les

into one document
• New pre-press tools
•  Collect and manage

review feedback
•  Apply advanced document 

control and security
•  Improved attachment 

capabilities
• Design PDF forms
•  Organise PDF collections 

more easily

FOR

• Faster to launch and use
•  Good pre-press capabilities
•  Opens up document 

reviewing

AGAINST

•  Rather sprawling and bitty
•  Too many versions in range
•  Mac version not as well 

integrated with other apps

VERDICT

            

More evolution than revolution, 
Acrobat 7 nevertheless 
incorporates a good number of 
tweaks and useful new features. 
The ability to make documents 
reviewable by just about 
everyone is a welcome addition, 
and might even change the way 
you submit roughs.

RESOURCE

Acrobat is so 
much more 
than a humble 
PDF generator. 
Check out 
studio.adobe.
com for a wealth 
of advanced tips, 
such as how to 
incorporate 
JavaScript into a 
PDF or exploit 
Acrobat’s batch-
processing tools.

  RECONFIGURED PDF CREATOR SHOWS OFF NEW FEATURE-SET AND ENHANCED INTERFACE
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Acrobat 7 Professional

LEFT: The Output Preview 
is improved, and now you 
can view ink changes via 
the Ink Manager.

BELOW: Creating PDFs 
from multiple sources
is relatively simple, 
although you can’t access 
format settings from here, 
which is a little annoying.

TEAM LinG - Live, Informative, Non-cost and Genuine!

http://www.adobe.co.uk
http://studio.adobe.com
http://studio.adobe.com


One of the biggest changes to 
version 7 comes as rather a bold 
step for Adobe. Recognising that not 
everyone who receives a document 
will have Acrobat, version 7 enables 
anyone with the free Adobe Reader 
to add comments and notes (given 
the author’s permission). Such 
documents can then be emailed to 
any group. This great addition should 
make collaboration a lot simpler.

While much of this is welcome
but hardly exciting, the new Print 
Production toolbar proves far more 
intriguing. This groups several 
options from previous versions, but 
adds some new ones, too, most 
notably Convert Colours and Printer 
Marks. With this handy feature, you 
can now convert from CMYK, RGB, 
greyscale or spot to any installed 
gamut, although unfortunately 
there’s no preview or undo facility.

Meanwhile, the Ink Manager 
enables you to modify the way inks 
are treated while the PDF is open 
(although you still need to use Convert 
Colours to make permanent changes). 
In addition, you can add Printer 
marks from one handy dialog box, 
and crop accordingly.

January 2005   | 77

The Output Preview has also been 
beefed up, for viewing separations, 
while the new Flattener Preview 
enables you to view any 
transparency information in the 
current PDF. Finally, there’s a useful 
Fix Hairlines tool to ensure ultra-low 
line weights don’t vanish altogether.

One of the biggest complaints 
levelled at Acrobat 6 was its slow 
launch speed. The glacial pace at 
which PDF documents in a web 
browser were displayed put off many 
surfers, too. Adobe has remedied 
both problems in version 7 by adding 
the Speed Launcher, which runs on 
start-up and sits in the background 
(although only in Windows), 
accelerating the display.

There are numerous other 
improvements and tweaks in 
Acrobat 7. The tidier interface is less 
confusing – and, fi nally, we get an 
auto-save option. Some are really 
only of interest to hardcore business 
folk, admittedly, while others (such 
as the ability to embed Atmosphere 
3D objects) are just plain obscure.

But the overall impression is that 
Adobe has listened to its customers. 
Acrobat fi nally feels like a stable and 

integrated program, instead of a 
rather random collection of tools. 
There’s still room for improvement, 
of course, especially with some of 
the new pre-press functions, but one 
step at a time...

The ability to add comments and 
other notes to a doc using just the 
free Reader seems to publicly 
acknowledge that PDF is now
the all-conquering format for 
collaboration. It should help any 
design studio get better work-in-
progress feedback from  clients, and 
without them having to shell out a 
fortune for the privilege. 

So what exactly is the 
difference between the 
various fl avours of 
Acrobat 7? Well, most 
importantly, the Standard 
version lacks the ability to make 
docs reviewable in Adobe 
Reader. It also comes without 
the Designer forms software
and doesn’t support AutoCAD.

Acrobat Elements is much 
more basic, and intended for 
volume licensing only. Then, of 
course, there’s the ubiquitous 
Adobe Reader (nee Acrobat 
Reader), which is read-only and 
available entirely for free. 
(Note that other versions, such 
as Capture and Messenger, are 
highly specialised.) For a full 
comparison of the range, visit 
www.adobe.com/products/
acrobat/matrix.html.

PROFESSIONAL? STANDARD?

1

2

3 4

5

ACROBAT 7 
PROFESSIONAL
NEW FEATURES

1. REVISED TOOLBARS
Adobe has grouped many of the 
old menu functions into relevant 
toolbars. These act like those in
any other application.

2. TAKE A NOTE
You can now cut and paste virtually 
anything into the PDF notes, as well 
as type directly into the text fi eld.

3. ANNOTATIONS
The new Callout annotation tool has 
confi gurable arrows and is mainly 
designed for engineering plans.

4. TEXT AMENDS
Any textual additions, deletions, etc., 
made are displayed as shown, along 
with the replacement text itself.

5. CONVERT COLOURS
The new Convert Colors dialog is
one of the many additions geared 
towards pre-press and creative use.

ABOVE: The Organiser, a comprehensive PDF browser, also 
provides access to common features such as printing.
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REVIEW

 PANTONE COLOUR 
SUPPORT WOULD  

MAKE THIS APP GREAT

The problem with spot colours, 
varnishes, metallic inks, 

embosses and other special fi nishes 
is that you can’t really tell what they’ll 
actually look like until you’ve got the 
printed result in front of you. Of 
course, by this time, if there’s 
anything that looks wrong or out of 
place you’ll either have to live with it 
or send the whole run again. The 
latter, in a deadline-based 
environment, just isn’t feasible.

Cue PrintDevizor, a tool that aims 
to simulate the look of certain print 
fi nishes within an interactive 3D 
environment. This sounds like an art 
director’s dream; no more explaining 
to clients that it’s not your fault that 
the gloss doesn’t look right over that 
metallic spot…

But there’s no direct support in 
PrintDevizor for Pantone colours. 
Sure, you can select a coloured spot 
or metallic ink using the system 
colour palette, but you can’t quickly 
change a Pantone swatch – when a 
client wants to see his logo in “pink”. 

The obvious workaround is to 
create your spot colour in Photoshop 
– using swatches rather than 
channels – and then import the 
image back into PrintDevizor. Or 
alternatively you could note the 
CMYK values of your Pantone 

PrintDevizor 1.0
swatch in Photoshop and apply them 
using the colour-picker. Adding 
native and accurate Pantone colour 
support would make this app great.

That said, PrintDevizor is 
impressive in its ability to simulate 
surfaces – gloss and matt UV, 
different papers, embosses and 

more are represented with notable 
realism. As you drag and rotate your 
creation in the main window, light 
refl ects off the surfaces.

The process of applying fi nishes to 
your document is simple, but, 
depending on the complexity of 
your project, can take a while to set 
up. When recreating last issue’s 
cover (pictured), for instance, we had 
to make a mask of the metallic 
background and border, text, woman 
and logo in Photoshop.

We then adjusted the document’s 
geometry to our specs, applied a matt 
paper and added the metallic ink 
using Photoshop to choose the 
swatch. We imported it in at a 75 per 

cent mix and then added a process 
colour layer. We then added the spot 
UV varnish to the woman and logo 
and adjusted the micron thickness 
based on our printer’s advice.

The masks act as, well, masks, for 
special fi nishes; the black sections 
appearing where the special fi nish is 
applied. And you can, at any time, 
reverse the effect by hitting Invert in 
the context-sensitive menu to the left 
of the interface. You can then output 
the virtual mock-up as an image or 
QTVR fi le – so you can easily share 
the simulation among colleagues or 
clients. The software also supports 
all major image fi le formats.

PrintDevizor is undoubtedly a 
great idea, and we imagine the 
greeting cards companies will lap it 
up. It’s also pretty good for 
publishing and general design 
environments – if you use a lot of 
varnishes or embosses – and very 
fast at rendering effects and image 
rotation, zoom and so on. 

The package is expensive at 
£1,169 though, and dongled, which 
really got on our nerves. Add native 
Pantone support, halve the price, 
ditch the hardware key and we’d be 
interested in using it on a monthly 
basis. Until then, we’ll keep hold of 
our cash and trust our instincts.

MAC Yes    PC Yes

PRICE

£1,169 (licence packs available 
– see website)
PrintDevizor Lite (Viewer) – 
available free of charge

CONTACT

Stonecube
0117 905 8706
www.stonecube.com

FEATURES

• Simulates spot colour,
    varnishes, paper stock,
    metallic inks, embosses,
    foils and more
• Interactive 3D preview
• Stack-based interface
• Output image or QTVR
• Supports a range of fi le 
formats, including GIF, JPEG, 
PCT, PSD (including selection 
of one or more layers), PNG, 
RGB, SGI, BW, RGBA, TIFF, 
TGA, BMP and PDF (Mac 
version only)

SYSTEM

MAC: PowerMac G4 (with ATI 
Radeon 9800 Pro Mac 
Edition), PowerMac G5, iMac 
G5, 2004 PowerBook G4, 
QuickTime 6.5.1 or later, 
Mac OS X 10.3 or later
PC: 1GHz P4, 256MB RAM, 
QuickTime 6.5.1 or later, 
DirectX 9 class graphics card, 
Windows XP or 2000

FOR

• Good special finish simulation
• Intuitive “stack” interface

AGAINST

• No Pantone colour support
• Expensive

RESOURCE

Visit Stonecube’s 
website and fi nd 
tutorials to help 
you get started 
with PrintDevizor. 
You’ll fi nd 
PrintDevizor Lite 
on the cover CD, 
which allows you 
to view PrintDevizor 
projects and 
create simple 
special fi nish 
visualisations.

  VISUALISE YOUR PRINT FINISHES WITHOUT EXPENSIVE MOCK-UPS OR CHROMALINS
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VERDICT
PrintDevizor is a great idea, 
especially if you work regularly 
with print fi nishes. But it falls 
short in one important area. It’ll 
need to include Pantone colours 
if it is to work effi ciently within a 
pro design environment, and a 
few quid knocked off the price 
tag wouldn’t do any harm either.

ABOVE: PrintDevizor Lite is a Viewer 
app that enables you to create basic 
mock-ups – with a maximum of four 
stacks – and save them with a 
watermark. You can’t edit those made 
in PrintDevizor, though.

LEFT: PrintDevizor allows you to output 
your print fi nish simulation as either a 
JPEG or QTVR – so sharing fi les among 
colleagues and clients is a doddle.

TEAM LinG - Live, Informative, Non-cost and Genuine!

http://www.stonecube.com


TEAM LinG - Live, Informative, Non-cost and Genuine!

http://www.bluegfx.com


REVIEW

THE EDITOR IS 
INTUITIVE, IF A LITTLE 

UNCONVENTIONAL

The original Video Toaster, back in 
the days when the best graphics 

computer on the market was the 
Commodore Amiga, introduced 
television to the idea that computers 
might just have a role in the 
production process.

In its more recent PC incarnation, 
the Toaster combines hardware
and software to produce a system 
that’s not only capable of editing 
uncompressed video in real time,
but also running a live TV studio. 
In addition, the program comes 
bundled with a full suite of post-
production effects software, so that 
everything you need for a live multi-
camera shoot or a post-production 
suite fi ts into a single fl ight-case.

The Toaster prides itself on 
making software work harder than 
hardware. In other words, the tough 
job of working with video and 
applying effects in real time is done 
on your PC’s own hardware. The 
Toaster’s machinery consists of a 
patch bay into which you can plug 
multiple cameras or tape machines 
(up to eight component or 24 
composite), four microphones, a
PCI card and a T-bar control unit, 

Video Toaster 4

which lets you fade or cut from one 
input to another.

The software includes its own 
editor, vision mixing software, full 
copies of LightWave and Aura (better 
known as Mirage). There’s also a 
hard disk recorder, a titler and a
DVD editing program.

The editor itself is intuitive, if a 
little unconventional. You can use any 
video fi le, compressed using any 
codec on your system, and combine 
different types of video fl awlessly 
and without pre-rendering. There’s 
also an absence of audio and video 
tracks on the timeline, so you can 
put anything anywhere on it and it’ll 
still work. You can also put a gap for 
a live feed onto the timeline as 
though it’s a pre-recorded video clip.

For live work, you can combine 
outputs from your cameras with a 
feed from the editing package, or a 
window from any other app. In other 

words, you can bring in a website or 
Flash animation and fade it, live, into 
your programme.

Version 4 doesn’t completely 
overhaul the Toaster, but it does 
address some of its old weaknesses. 
Audio is improved with a full graphic 
equalizer, 3D surround sound and a 
range of audio effects, as well as 
four audio inputs. However, a 
hardware audio mixer would’ve been 
useful. As it is, you can fade audio 
tracks on screen, but there’s no 
physical mixing desk for them.

In addition, Chromakey tools (spill 
suppression) have been improved, 
there’s simpler internet streaming 
so you can record a full quality 
master to disk while streaming a 
compressed version of the show live 
online, and better background 
rendering is available for effects too 
complex for real-time manipulation.

The Toaster comes in two fl avours 
– Toaster Live (reviewed here) and 
Post. Post includes all the software 
of the Live version, but no breakout 
box for multiple cameras and no 
T-bar to mix between video sources. 
A slightly cheaper version (sans 
LightWave) is also planned.

MAC No    PC Yes

PRICE

Toaster Live £3,999
Toaster Post £2,299

CONTACT

NewTek +1-210-370-8000
www.newtek.com

FEATURES

•  Live video capture and 
mixing from up to 24 sources

•  Real-time editing
• Full version of LightWave 3D
• Aura (video painting package)
• Internet streaming
• DVD authoring
• Titling package
• Complete TV studio
• Live chromakey
• Live audio tools

SYSTEM

•  Intel P4 520 (2.8GHz), Dual 
Xeon 2.4GHz or faster

•  512MB RAM
•  UDMA IDE system drive 

with 600MB free HD space; 
16GB for installation of 
DVEs and content

•  Video Stripe Set: Four 
10,000 RPM Ultra 160 or 
320 SCSI hard drives

•  SCSI Controller for Video 
Stripe Set on the 64-bit
PCI interface

FOR

•  Everything you need for a 
multi-camera shoot

• Excellent real-time facilities
• Great post-production tools

AGAINST

• No compositing package
• No audio mixer
• You’ll have to buy a new PC

  A COMPLETE TV STUDIO WITH A POST-PRODUCTION SUITE THROWN IN
 

RESOURCE

The original Video 
Toaster caused 
quite a stir when 
released, and still 
has its fans today. 
In fact, it’s still 
being run on 
Amigas and 
Amiga emulators. 
NewTek has even 
made the source 
code available,
so enthusiasts
can re-program
it for fun. Check 
out www.open
videotoaster.org.
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VERDICT
Toaster’s specs are impressive, 
and if you want to set up a 
multi-camera shoot, or even a 
studio, there’s little to touch it. 
For Toaster to work at its best, 
though, you’ll need some fast 
hard drives and a decent PC. 
If you have the kit, there’s not 
much you can’t do with it.

LEFT: The improved 
titling package enables 
you to apply basic title 
animations with ease, 
courtesy of some quick 
and easy presets.

BELOW: You can set up a 
playlist containing video 
clips on disk, and then 
play them in a live show.
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REVIEW

Epson took the gloves off in the 
budget colour laser market with 

its £450 C1000 – then went one 
better with the C900, which came in 
at under £270. Hewlett Packard has 
taken a while to come up with a 
worthy rival, and at fi rst glance the 
2550N doesn’t seem up to scratch. 
But dig a little deeper and things 
start to get interesting…

First off, the 2550N outputs in 
mono at a lively 24ppm, 50 per cent 
faster than the C900’s 16ppm 
(although both printers provide a 
more modest 4ppm in full colour). 
HP’s baby also sports an impressively 
quick warm-up time; it took 2.5 
minutes to churn out the fi rst full 
page of a colour 300dpi A4 print, for 
instance. Not bad at all.

Sadly, the printer’s drivers, along 
with its limited memory, leave you 
waiting longer. A lot longer. 
Sometimes, in fact, print jobs don’t 
appear at all… This is particularly 
worrying given the 2550N’s 
positioning as a network printer. 
For some reason, the device doesn’t 
communicate properly with the 
drivers to manage queued print jobs. 
Indeed, the drivers often had 

HP Colour LaserJet 2550N
insuffi cient memory to print our 
pages. Unsurprising, given the pitiful 
64MB fi tted as standard. It may 
knock the C900’s 16MB into touch, 
but it still isn’t enough for complex A4 

jobs at 300dpi. Our advice? Upgrade 
the unit to 192MB, using dirt-cheap, 
industry-standard SDRAM sticks. 
Why the printer isn’t fully confi gured 
already is beyond us…

In terms of print quality, the 2550N 
offers great colour and vibrant 
primaries. Despite HP’s blurb about 
“superior gamut”, though, the printer 
(or its drivers) produces less tonal 
gradation than the cheaper Epson 
C900. This makes it less useful for 
proofi ng. Although the drivers offer 
various ICM colour-management 
options, none of them managed to 
reproduce the subtle variations of our 
test images. Laser printers aren’t as 

subtle as inkjet printers anyway, 
but the HP 2550N’s output was 
noticeably inferior to that of the 
Epson C900 and C1000 families. 

In terms of running costs, the 
2550N just pips the C900. It’s a 
classic gambit by printer 
manufacturers to deliver printers 
that are cheap to buy, but expensive 
to run. The bare-bones 2550 costs 
£305, yet a full set of replacement 
consumables £433.95! This includes 
the imaging drum, which must be 
replaced every 5,000 pages. The 
black toner also lasts 5,000 pages, 
and colours for only 4,000 pages.

Even so, the printer only works out 
at 9.8p per page (at fi ve per cent 
coverage) – cheaper than most 
inkjets. Furthermore, while Epson 
only includes a reduced capacity 
toner with its C900 (1,500 pages 
instead of 4,500), HP includes a full 
4,000/5,000-page set with the 2550N. 

When you consider that the 
difference in toner would set you back 
about £150-£200, the initial price 
difference becomes almost 
insignificant. Factor-in the 2550N’s 
networking capability and the balance 
definitely starts to tip in HP’s favour.

MAC Yes    PC Yes

PRICE

£459

CONTACT

Hewlett Packard
0845 270 4000
www.hp.com/uk

FEATURES

• 24ppm (mono)
• 4ppm (colour)
• Fast warm-up time
• Compact
• 64MB of RAM, upgradeable
   to 192MB
• Parallel, USB or network
   connection
• Handles media up to
   170GSM card
• 30,000 pages per month
   duty cycle
• One-year on-site warranty

SYSTEM

MAC: No Mac software – only 
connects via network
PC: 233MHz processor, 32MB 
of RAM, 150MB HD space, 
Windows 98, USB, parallel 
or network

FOR

• Low running cost
• Decent print quality
• Attractive machine

AGAINST

• High outlay for
   toner replacement
• Inadequate memory
• Terrible print queue
   management, especially
   for a workgroup printer

VERDICT

            

A compact and elegant printer, 
the 2550N desperately needs 
more memory and an easier-
to-understand error reporting 
system. It quickly produces 
great prints, but with a limited 
gamut and limited drivers. It’s 
fairly inexpensive to run, but ink 
replacement is far too steep.

  A COLOUR LASER PRINTER THAT PERFECTLY SERVES ANY SMALL WORKGROUP
 

RESOURCE

There are three 
HP2550 models to 
choose from: the 
2550L, 2550LN 
and the 2550N. 
Check out all three 
at http://h10010.
www1.hp.com/
wwpc/uk/en/sm/
WF25a/5043-
5047-5051-5051-
5063-4846693.
html.
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ABOVE: Although compact and elegant in 
appearance, this laserjet could keep you 
hanging around for prints.

LEFT: The 2550N is fairly inexpensive to run, 
but could benefi t from extra memory.

THE 255ON OFFERS 
GREAT COLOUR AND 
VIBRANT PRIMARIES
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REVIEW

FOLDUP! 3D CAN
AUTOMATICALLY FOLD 
THE DESIGN FOR YOU

Understanding how your design 
will look in three dimensions

is obviously of vital importance to 
packaging professionals. Sadly, 
Adobe Illustrator boasts limited
3D capabilities, so the only way to 
preview your latest design is to print 
it out, cut and paste, then fold the 
prototype up by hand.

This can be a problem if you’re 
pushed for time, or need to make 
numerous changes or electronically 
send a design to a client for approval. 
A fl at design, laid out on a cutter 
guide, really can’t convey the 
fi nished product as well as a fully 
transferable digital 3D mock-up.

Which is where Comnet’s easy-
to-install FoldUP! 3D comes in 
handy (demo on the cover CD). It’s an 
Illustrator plug-in aimed at 
packaging designers and artists, 
and, once installed, appears as one 
of the app’s many tabbed function 
windows, alongside such favourites 
as Pathfi nder. It also adds a new tool 
called Base to the toolbox.

When you select FoldUP! 3D via 
the appropriate menu, you’re 
greeted with a simple interface 
consisting of fi ve palettes. 

FoldUP! 3D 1.5
The enclosed PDF manual covers 
each one in detail, but we found 
using the tutorial sample fi les a good 

hands-on alternative. Comnet’s 
plug-in relies on layer-like functions 
to ensure it’s intuitive to work with.

To create a basic folding mock-up, 
you simply need to set up a “base”,
a “cut layer” (this enables the app to 
see the edges of your design) and a 
“fold layer”. All graphics are then 
assigned to the artwork layer, and 
set up in the Layer Mapping palette. 
FoldUP! 3D can now automatically 
fold the design for you, or you can
do it yourself by assigning the 
appropriate angles and folding 
directions using the Fold palette.
You can then preview your design
by hitting the Fold button.

It’s possible to view your design in 
a variety of ways: as a wire-frame, 

white paper or hidden line solid, 
among others. You can also adjust 
the lighting effects, reorientate your 
object in virtual 3D and choose 
between low and high-resolution 
output. It’s also possible to export 
the animation as a 3D raster image, 
a 3D model file or a QuickTime movie. 
At fi rst glance, the interface seems 
complicated, but again the bundled 
sample fi les will help you out.

With FoldUP! 3D, you can
create digital mock-ups entirely in 
Illustrator, a task that not so long 
ago would’ve required you to master 
an entirely new 3D package. Sure, 
it’s never going to replace physically 
holding a mock-up in your hands, 
but the advantages are legion – 
accurate 3D digital models that are 
easy to pipe to clients for approval.

This latest version of FoldUP! 3D 
tweaks several functions, including 
the Positions palette and modelling 
functionality. QuickTime support is 
also provided. For retail packaging, 
direct-mail pieces and any kind of 
folded design, it should prove a 
godsend, fast-tracking the process 
and saving your sample-cutting for 
the fi nished product. 

MAC Yes    PC Yes

PRICE

£292

CONTACT

Xchange International
(reseller) 020 7588 5588
www.comnet-network.co.jp

FEATURES

•  Palettes integrate with 
Adobe Illustrator palettes

•  Intuitive layer-mapping
•  3D lighting effects
•  Comprehensive manual 

and sample fi les
•  Improved Positions palette
•  Enhanced 3D modelling 

functionality
•  QuickTime compatibility
•  Customisable 72 or

360dpi export

SYSTEMS

MAC: PowerPC G3 or above, 
RAM suffi cient to run 
Illustrator, graphics card 
supporting OpenGL 1.1 or 
later, OS 9.0 or later
PC: Intel Pentium processor 
or above, RAM suffi cient to 
run Illustrator, graphics card 
supporting OpenGL 1.1 or 
later, Microsoft Windows 98, 
98SE, ME, 2000, XP

FOR

•  Digital mock-up capability
•  Looks like just another 

Illustrator palette
•  Gentle learning curve

AGAINST

•  No specifi c help or topic 
search built in

•  Complicated shapes can 
take a while to set up RESOURCE

FoldUp publisher 
Comnet produces 
a host of other 
Adobe plug-ins 
including tools for
sign making, vinyl 
cutting and 
touching up and 
fi nishing off poorly 
designed logos. 
For more 
information see 
www.comnet-
network.co.jp/eng/

  VIRTUAL PACKAGING MADE SIMPLE WITH COMNET’S USER-FRIENDLY ILLUSTRATOR PLUG-IN
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VERDICT
Comnet’s software will only 
appeal to specialist users – 
namely, packaging or direct-mail 
designers – but it works well and 
extends Illustrator’s capabilities 
beyond just 2D design and 
artwork. It’s commendable
that Comnet has targeted this 
niche market so well.

ABOVE: Those already familiar with 
Illustrator will fi nd this plug-in’s layer-
based design system pleasingly simple.

LEFT: Creating a basic mock-up is a 
straightforward job – and FoldUP! 3D
can even fold the design up for you.
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REVIEW

The digital photography revolution 
has taken the world by storm in 

what seems like a matter of months, 
so it’s easy to forget there was once 
life before the megapixel and the 
bargain basement digital camera 
and that taking pictures once 
revolved fi rmly around 35mm fi lm. 

Ever keen to spot a trend and tap 
into a new market, scanner 
manufacturers have developed ways 
to help those undertaking fi lm to 
digital archiving projects get the most 
from their 35mm fi lm negatives. 

Epson, always a powerful force in 
the scanner market, has tapped into 
this growing area with a number of 
models, including the affordably 
priced Perfection 2580 Photo –   a   
light and compact device that scans 
both prints and negatives and offers 
all of the standard features of any 
competing colour fl atbed scanner. 

Standard issue fl atbed scanners 
have been able to digitise prints for a 
while now, but the arrival of built-in 
35mm fi lm loaders is relatively new. 
The Perfection 2580 features an 
automatic loader, which makes the 
process of scanning negatives  
simple and pain-free. A fl ap  opens 

Perfection 2580 Photo
up to give access to a motorised 
feed, which niftily sucks in a strip of 
up to six negatives. Slides can be 
loaded too, but need to be dealt with 

manually. The whole process is 
simple and far preferable to loading 
negatives into holders. 

Once the negatives are loaded, the 
Perfection 2580 can get to work – 
simply check the negatives using the 
Preview mode and push the Scan 
button. The scanner quickly captures 
images at a whopping 2,400 dpi. 
A 35 x 24mm negative will take 
around 60 seconds, resulting in a final 
image of around 3,000 x 2,500 pixels.

While our tests found a little fade 
in terms of colour reproduction, the 
images produced were faithful to the 
originals and of a pretty high quality.

But aside from its negative scanning 
capabilities, the Perfection 2580 
behaves in much the same way as 
any fl atbed scanner of this price and 
easily and quickly scans and 
previews any media you chuck at it. 

As the photo processing element 
of the package’s functionality is so 
important to Epson’s target 
audience, the company has included 
a number of extras to improve the 
fi nal image. The Image Quality 
Enhancer includes dust removal, 
colour restoration, exposure 
correction, focus and noise removal 
features, while a bundled software 
package includes ArcSoft’s 
PhotoImpression, for image editing, 
and an image-to-text converter for 
document text editing. 

While the Perfection 2580’s low 
price may put some users off, the 
results, for a scanner of this type, 
speak for themselves. It’s a great 
investment. 

MAC No    PC Yes

PRICE

£99

CONTACT

Epson
08702 416900
www.epson.co.uk

FEATURES

• Automatic fi lm loader
• 2,400 x 4,800 dpi
• Colour restoration and
    dust removal 
• Image enhancement
• Image-editing software
• USB 2.0 connectivity
• Colour CCD sensor with
   Micro lens
• Compact design
• One year replacement
    or repair warranty

SYSTEMS

• Pentium 4, 2.4GHz, 512MB
   of RAM, USB2.0 Hi-Speed
• Windows XP Professional
   Edition

FOR

• Simple and automatic
   negative scanning
• Easy to use
• Inexpensive

AGAINST

• Image quality doesn’t
   quite match that of more  
   expensive scanners
• Doesn’t feel solid

VERDICT

            

The Epson Perfection 2580 is a 
low priced but effective scanning 
device that produces great 
images, fast. The scanner is well 
designed and easy to use and its 
brilliant automatic loader makes 
the once-tricky process of 
scanning 35mm fi lm negatives 
simple and painless.

  A CHEAP BUT CHEERFUL COLOUR FLATBED THAT MAKES LIGHT WORK OF SCANNING NEGATIVES
 

RESOURCE

All the info you 
need on driver 
downloads, FAQs, 
warranties and 
support can be 
found at www.
epson.co.uk, as 
well as e-Talk – 
a live online help 
centre, which lets 
you fi re off email 
enquiries to 
technical support.  
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MAIN IMAGE: The 2580’s motorised  top 
loader can quickly suck in a strip of up to 
six negatives.
INSET: Once your negatives are loaded, 
it’s simple – just press the Scan button.

A LIGHT AND
COMPACT DEVICE THAT 

SCANS BOTH PRINTS 
AND NEGATIVES

TEAM LinG - Live, Informative, Non-cost and Genuine!

http://www.epson.co.uk
http://www.epson.co.uk
http://www.epson.co.uk


REVIEW

AN EFFECTIVE STORAGE  
DEVICE THAT’S QUITE 

NICE TO LOOK AT, TOO

Mobile storage units don’t usually 
score highly in the rankings of 

must-have accessories, especially 
when compared to the ubiquitous 
iPod, but peripherals specialist Lacie 
is making an effort to make these 
wholly functional devices just a wee 
bit more glamorous. 

Sure, portable devices ranging 
from storage keys to the likes of the 
Iomega REV drive (reviewed in 
Computer Arts, issue 103) have got 
smaller and more user-friendly over 
the years, but in terms of pure 
aesthetics, a rectangular piece of 
plastic is usually presented by its 
manufacturers as just that. 

But, with its eye fi rmly on the 
massive cross-over gadgets market, 
Lacie has handed its latest mobile 
storage unit over to the legendary 
design team at F.A Porsche for a 
complete external makeover. The 
result? A product that is both 
effective as a storage device and 
quite nice to look, too. 

With its brushed metal fi nish and 
minimalist shell, the Porsche team 
has done a great job of transforming 
a boring looking piece of kit into 
something that’s more aesthetically 

Lacie 40GB USB 2.0
pleasing. But design aside, is this a 
storage unit you can take seriously, 
or does it just look good?

One of the most important 
considerations for the Lacie drive is 

that it should be easy to store and 
move around. Weighing-in at 
just 200g and with dimensions of 
17x76x129mm, the drive is certainly 
light and easy enough to carry in a 
coat pocket. The drive also seems 
durable, with a tough metal exterior 
that gives a robust impression – it 
should certainly be able to take a 
couple of knocks and stand up to 
general wear and tear. 

In terms of performance, ease of 
use and convenience, the Lacie drive 
scores highly. The device works 
straight out of the box, connecting to 
Windows PC or Mac via a USB 2.0 
lead and appearing instantly on your 

desktop. There’s no software to 
install either, so you really do just 
plug it in and get started. The bus-
powered drive doesn’t have a power 
supply, but draws power from your 
PC or Mac via the USB cable. If it 
can’t, Lacie has included an additional 
power-sharing cable, which can be 
plugged into a second USB or PS2 
port. This means you don’t have to 
carry a power supply around with 
you, saving even more room.  

In terms of data transfer speeds, 
we found the 40GB model perfectly 
adept at dealing with large transfers 
at a rate of around 6.5MB per second 
– a reasonable speed for a drive of 
this size and price. We were also 
impressed with the speed at which 
the drive transferred data back to 
our source Mac. 

At £103 for the 40GB model, the 
price tag is not the lowest available 
for a device of this type, but neither 
is it too infl ated. At this point, it’s a 
little diffi cult to see exactly how much 
value Porsche has added with its 
sleek design job, but the product 
works excellently well in terms of 
mobile storage and is very easy to 
carry around.

MAC Yes    PC Yes

PRICE

£103

CONTACT

Lacie
020 7872 8000
www.lacie.com/uk

FEATURES

• 40GB storage space
• USB 2.0
• Lightweight and
   compact design
• Easy to use, with no driver
    software to install
• Powered by USB bus
   – no adaptor needed
• Cross platform
• PS2 power-sharing cable
• Two-year warranty
• 12ms seek time

SYSTEM

PC: Built-in Hi-Speed USB 2.0 
or FireWire interface; 
Windows 98 Second Edition, 
Windows 2000, Windows Me 
or Windows XP
MAC: Mac OS 9.x or greater; 
Intel Pentium II 350MHz-
compatible processor or 
greater; iMac, Power MacG3 
or greater; minimum 32MB 
of RAM.

FOR

• Easy to use
• No power adaptor needed
• Looks good

AGAINST

• Expensive
• Not the fastest drive
   available

RESOURCE

Problems with 
your new hard 
drive? Diffi culties 
transferring or 
naming fi les? 
Need advice on 
USB cards and 
adapters? Visit 
Lacie’s website at 
www.lacie.com/uk 
to fi nd all the info, 
answers and 
drivers you’ll need 
to get started.

  AN EFFECTIVE AND HIGHLY-PORTABLE MOBILE STORAGE UNIT WITH A SLEEK PORSCHE MAKEOVER
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VERDICT
The Lacie Mobile Hard Drive is 
not the fastest or cheapest 
portable storage product on the 
market, but it is durable, 
hardworking effective and very 
easy to use. In addition, the 
sleek and minimalist Porsche 
design makeover adds a little 
extra individuality.

ABOVE: Porsche’s sleek design 
makeover may look great, but will it 
add much value?

LEFT: Weighing-in at just 200g, Lacie’s 
latest mobile storage device is 
lightweight and easy to carry around.
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THE WORLD’S BEST–SELLING CREATIVE MAGAZINE

SUBSCRIBE TO THE DIGITAL EDITION NOW
WWW.COMPUTERARTS.CO.UK/ZINIO

ALL 
TUTORIAL 

FILES 
INCLUDED*

•   Get the digital version of the world’s 
best-selling creative magazine sent 
straight to your desktop

•   Receive 13 digital issues for just 
$75 (around £42)

•  Subscribe online now!
     *Due to licensing restrictions we cannot include CD software
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Get your hands on these great design reads

BOOKS

THE DIGITAL DESIGNER’S BIBLE
AUTHOR: Alistair Dabbs
and Alastair Campbell   
PRICE: £24.95
PUBLISHER: Ilex
ISBN: 1-904-70527-8
This in-depth trawl through digital
design aims to cover the development

of a project from fi rst idea to completion, taking in everything 
from software issues and copyright to printing and web 
design. A thoroughly comprehensive guide.

GRAPHIC DESIGN SCHOOL
THE PRINCIPLES AND PRACTICES
OF GRAPHIC DESIGN
AUTHOR: David Dabner 
PRICE: £14.95 
PUBLISHER: Thames & Hudson
ISBN: 0-500-28526-8

Some working in the professional design fi eld 
insist that graphic design is a skill that cannot be 
taught. Potential designers need to have a “feel” 
for design, they argue, an intuitive understanding 
of what works on the page. No training, they 
believe, can compensate for a lack of innate talent.

They may have a point, but few designers could 
get by without some kind of formal training – and 
all, when pushed, admit that when it comes to, 
say, mastering the intricacies of industry-standard 
software, it’s easier with (rather than without) a 
mentor to show you the way. 

Certainly, David Dabner, who has written 
widely about graphic design, and teaches a course 
in the subject at the London College of Printing, 
believes everyone deserves a chance… His latest 
book aims to provide a self-teaching guide for 
those wanting a solid grounding in the basics. 

Split into two sections dealing with the 
language and principles of design, his book covers 
pretty much everything you need to know when 
considering a career as a professional designer. 
Part one looks at the principles of basic layout, 
colour theory, composition, photography and 
typography. It also provides a brief introduction to 
layout, print and web design, and 3D software. 

Part two then seeks to draw all these elements 
together, and demonstrate how to apply them to 
specifi c projects in real-world situations, with the 
help of tips, examples and even written seminars.

In trying to be a jack-of-all-trades, Dabner’s 
book acts a good introduction to the fi eld, but 
covers too much in too little detail. The chapters 
attempting to deal with QuarkXPress, InDesign, 
Dreamweaver and even Toon Boom, for instance, 
do little more than scratch the surface. Still, as 
a hands-on overview, it does the job.

 ALSO RECOMMENDED 

 BOOK OF THE MONTH 

MOVING PIXELS:
BLOCKBUSTER ANIMATION, 
DIGITAL ART AND 3D
MODELLING TODAY
AUTHOR: Peter Weishar, Phil Tippett
PRICE: £19.95
PUBLISHER: Thames & Hudson
ISBN: 0-500-51208-6

A quality coffee-table guide to computer-generated imagery 
in blockbuster fl icks, Moving Pixels features hundreds of 
illustrations from the likes of Pixar and Dreamworks.

CALLIGRAPHY
WITH PHOTOSHOP
AUTHORS: George Thomson
PRICE: £16.95
PUBLISHER: Ilex
ISBN: 1-904-70554-5
This well-put-together guide 
explains how to produce calligraphy 

in Photoshop and covers everything from letterform basics to 
how to transfer calligraphy to design packages. Some effects 
are cheesy, but it’s a useful reference guide.
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3D ANIMATION 
SOFTWARE

 MAYA 6.0 P90

GROUP TEST

C hoosing the right 3D animation 
package is never easy – particularly 

when so many of them seem to offer a 
similar set of features. 3D programs
can usually be divided into four areas – 
modelling, texturing, animation and 
rendering – and each program will tackle 
these sections differently. For example, all 
the applications on test here offer some 
kind of polygon modelling, although some 
also provide mathematical representations 
of 3D geometry, or NURBS (Non-Uniform 
Rational B-Splines), and/or Bézier 
patches. Likewise, each app provides 
keyframe animation, although the related 
tools and interfaces vary considerably. 

Specifi cations matter when buying any 
kind of product, but they should not be the 

determining factor. Far more important is 
how well the application integrates various 
features and, of course, how well it works. 
For example, HDRI (High Dynamic Range 
Image) support is catered for in all the 
applications featured in our Group Test,
but the level of support and the ease with 
which you can use HDRI fi les in the 
program differs considerably.

We’ve judged all of these programs not 
just on features, but on the usability of the 
feature-set in real production terms. After 
all, there’s not much point having the latest 
buzzword feature if it’s painfully slow or 
diffi cult to use. So read on, and see which 
one of these fi ve industry-standard 
packages would best suit you…
Illustration by Scott Hansen. www.iso50.com

SOFTIMAGE XSI 4.5 P90

With 3D computer-generated imaging now a staple of the fi lm, television, 
print and web industries, selecting the right app for your needs demands 
more than a bottomless wallet and Ferrari-specced hardware…

LIGHTWAVE 8.0 P91

CINEMA 4D R9  P92 

3DS MAX 7 P91
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N o 3D Group Test would be 
complete without Maya. It’s 

become the standard package in
the high-end visual effects and
post-production markets and the 
yardstick by which to compare other 
3D apps. So you might wonder why 
this mighty program hasn‘t taken 
the top slot in our Group Test? Well, 
while it’s pretty much top dog for 
effects and character animation 
work, it has some mighty fl aws. 

Modelling, however, is very good, 
with both NURBS and polygon 
modelling well catered for. You’ll
also fi nd hierarchical Subdivision 
Surfaces and the more regular kind, 
labelled by Alias as the Polygon 
proxy mode. Animation is excellent, 
too. There’s a very good keyframing, 
f-curve and set-driven key interface, 
which – coupled with deeper tools 
such as Expressions and MEL (Maya 
Embedded Language) scripting – 
offer a solution to just about every 
animation problem. Other versatile 

technologies include Trax (non-
linear animation), IPR, Paint FX and 
Dynamics systems. 

Helpfully, rendering has 
integrated support for the excellent 
Mental Ray 3.3 renderer, plus Maya’s 
own software and hardware 
rendering, as well as a RavX Flash 
output tool for web-based 3D work. 
The material/shader system is less 
satisfactory, though, and could 
benefi t from a simpler and more 
user-friendly interface.

But there’s one main problem. 
Maya requires a huge amount of 
dedication, and despite attempts by 
Alias to make it more accessible to 
new users, the program is much 
less artist-centric than the other 3D 
apps on test here. To get the most 
out of it, you’ll need to make your 
way into the guts of the program, 
whether you want to or not.

If you’re looking for a more casual 
3D system, you may fi nd Maya just a 
little too uncompromising.

A FUNCTIONAL BUT FEATURE-HEAVY PROGRAM THAT MIGHT JUST SURPRISE YOU
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O f the high-end 3D programs on 
test here, XSI 4.5 is arguably

the most balanced, offering a rich, 
even-handed toolset for modelling, 
animation and rendering. Rendering 
is a strong point, mainly because XSI 
was designed to work seamlessly 
with Mental Ray from the outset. 

Interactive preview rendering can 
be accomplished in any viewport at 
any time, although it’s not quite the 
same as true interactive systems 
that only update parts of the image 
that change, as in Maya’s IPR 
(Interactive Photorealistic 
Rendering). Nevertheless, the 
graphical shader-building system is 
well designed and relatively easy to 
use, and automatic insertion of data 
conversion nodes makes connecting 
shaders with disparate data types 
much easier for newbies.

NURBS are catered for, but the 
system isn’t as complete as Maya’s. 
However, XSI makes up for this 
shortfall with an excellent polygon 

modelling toolset that is a joy to use. 
Subdivision smoothing is available 
as property of all polygonal objects 
and makes fl ipping between low and 
high-res modes really easy.

Animation is also excellent, with 
features comparable to Maya 
combined with a smooth workfl ow. 
However the organisation of 
animatable parameters can be 
confusing, which leads to a more 
complicated selection and general 
set-up process than we think is 
necessary. That said, XSI has fi ne 
tools for managing high-level 
animation, and does a great job of 
applying existing animation data to 
different character rigs.

XSI Essentials costs $1,995 
(approx. £1,082) and includes cloth, 
soft body dynamics, particles, a six-
node rendering licence and some 
superb general-purpose tools. It’s a 
great system, and boasts one of the 
best implementations of modelling 
history we’ve seen.

Maya 6.0

RESOURCE

Alias’s Maya 
Resource Centre 
offers excellent 
tips and tricks for 
Maya users. Want 
to know how to 
import 3ds max 
fi les? Or add 
motion blur to an 
animated texture? 
Then visit www.
alias.com/eng/
support/maya/
index.jhtml

MAC Yes  PC Yes     PRICE   £1,470

CONTACT     01494 441273   www.alias.com CONTACT     01753 650 949   www.softimage.com 

A great 3D app for the die-hard character animator or effects artist, but 
a lack of fl exibilty lets the software down. Maya features some 
phenomenal technology, but is less inviting for digital content creation 
and general-purpose 3D work.

VERDICT
All in all, Pinnacle Studio Plus offers the fastest way you’re likely to fi nd 
to get from raw footage to a fi nished production. However, it’s also got 
some incredibly sophisticated tools, which quietly get on with their work 
without the user having to understand them.  But editing tools and 
effects keyframing aren’t quite as smooth as Premiere’s.

VERDICT                         
A great all-round system, with superb rendering and a solid character 
toolset. Not as easy to use as some other apps – and only available for 
the PC – but workfl ow is consistent. Advanced scripting is also available.

VERDICT             

MAC No  PC Yes     PRICE  £1,082

Softimage XSI 4.5
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I n essence, LightWave 3D hasn’t 
changed that much since it was 

launched way back in 1995. Yet it’s 
managed to keep up with its peers 
and even maintain a lead in some 
key areas. It’s a system that breaks 
with 3D convention, yet remains 
simple enough to beguile even the 
most techno-illiterate of artists.

LightWave doesn’t offer the 
complexities of true NURBS 
surfaces, for instance, but it was one 
of the fi rst to integrate subdivision 
surface modelling (then called        
MetaNURBS, now dubbed Subpatch 
modelling) and developed a strong 
toolset around the concept. It’s a 
strong polygon modeller, too, but 
could benefi t from some form of 
modelling history.

Unlike the other programs 
featured here, LightWave is also a 
dual app, with separate programs for 
modelling/surfacing and animation/
rendering. This approach actually 
works well in production, and makes 

it easy to refi ne a model even if it’s 
already been rigged and animated.

Rendering is one of LightWave’s 
strong points, with the best native 
rendering of any of the apps on test. 
The program offers all the usual 
niceties, such as Radiosity, Caustics 
and HDRI support, plus VIPER 
interactive rendering and soft 
shadow caching (new in 8.0).

In this latest iteration, NewTek 
has also tried to address one of 
LightWave’s weakest features: 
character animation. The app is fi ne 
for occasional work, but we wouldn’t 
recommend it for dedicated 
animation, since Maya, XSI, and 
Cinema 4D, have more fl uid and 
refi ned workfl ows in this area.

There’s also a good particle 
system, soft and rigid body dynamics 
and even basic hair and fur. Stand-
out features include morph maps, 
which store multiple morph targets 
in a single object fi le, and decent 
unlimited rendering as standard.
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3 ds max is the one package 
featured here that hasn’t yet 

succumbed to a drastic price-cut.
At £2,695, it’s an expensive package 
and, unlike the modular Cinema 4D, 
must be swallowed in a single 
chunk. But despite the high price, it 
remains one of the most popular 
choices for 3D artists. 

The toolset is broad and diverse 
enough to cater for almost all 3D 
situations, including character 
animation, an area in which 3ds max 
has become much more suited 
thanks to a Character Studio plug-in. 
The biggest bonus? 3ds max 7 now 
includes Character Studio 4.0 at no 
extra cost. This is a wise move by 
Discreet, because max has been 
losing mind-share to Maya and XSI 
in this area for a while now.

One great feature – particularly 
for game designers – is Normal 
Mapping. This enables you to 
“imprint” the normals of a high 
resolution model onto a low-res 

model in a similar way to bump-
mapping (except that the details are 
referenced from actual geometry). 
Another is Skin Morph, similar to 
Maya’s Wrap Deformer, which 
enables you to deform a high-res 
mesh using a much simpler proxy 
that’s also easier to rig and weight.

3ds max is a good all-round 
system, despite its bias towards 
games development, but there are 
drawbacks. The core of the program 
is dated compared to Maya and XSI, 
which both offer deeper access to 
features and better integration with 
different aspects of the 3D pipeline 
(such as modelling and animation).

Rendering is supplied by a Mental 
Ray plug-in, but it’s not quite up
to Softimage XSI standard. The 
material system is fairly good, but
it can be diffi cult to keep track of 
complex set-ups because of the 
weak interface. 3ds max is a good 
program in terms of features, but the 
core is already showing signs of age.

3ds max 7 LightWave 8.0

RESOURCE

You may have 
already seen 
LightWave 
imagery in fi lm 
and on TV without 
really realising it.
Check out what’s 
possible at http://
www.newtek.
com/products/
lightwave/lw-
gallery/index.
php?cat=2

CONTACT     0207 851 8000   www.discreet.com CONTACT      1-210-370-8000   www.newtek.com 

A feature-rich system that’s been built on a less-than-ideal foundation 
and workfl ow, but it’s capable of good results nonetheless. Unlike 
competitors such as XSI and Maya, 3ds max 7 is expensive, but still 
remains a popular choice. 

VERDICT             
LightWave 8.0 is a great all-rounder with a relatively easy learning curve 
and excellent rendering quality. But a lack of modelling history can be a 
pain and the character tools are still a little weak.

VERDICT             

MAC No  PC Yes     PRICE   £2,695 MAC Yes  PC Yes     PRICE   £995
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Cinema 4D R9
Cinema 4D R9 is unique in that it 

enables you to custom-build its 
feature-set with the help of modules. 
Unlike plug-ins, these programs give 
access to totally integrated feature 
sets in areas such as character 
animation, 3D painting and UV 
editing, rendering and dynamics.

The core application, Cinema 4D 
R9, costs a modest £499 and 
includes a full set of modelling and 
keyframing tools, as well as good 
basic rendering. The Studio Bundle 
on test here features all eight extra 
modules (Advanced Render R2, 
MOCCA R2, Thinking Particles, NET 
Render, Dynamics, BodyPaint 3D R2, 
PyroCluster R2, Sketch and Toon). 
The best thing about this modular 

system is that you can expand the 
program as and when budget allows, 
which is much more cost-effective.

In use, Cinema 4D feels halfway 
between a full-on, uncompromising 
3D app such as Maya, and a more 
user-friendly low-end package. But 
this isn’t a criticism; it has the added 
benefi t of combining a comfort zone 
for new users with the depth or 
access required by pros, without 
compromising either. 

There are weaknesses, though, 
such as rendering, which we 
think lacks a certain something, as 
well as the fl exibility of advanced 
raytracers such as Mental Ray. 
However, the default 16x geometry 
anti-aliasing delivers perfect edge 

results every time. There’s a lack of 
refi nement and access to advanced 
rendering features, but the program 
has a very good multi-pass rendering 
solution that outputs layered 
Photoshop fi les, a highly 
straightforward rendering option.

The MOCCA character module 
broadens Cinema 4D’s scope. You 
could argue that Maya and XSI are 
better in absolute terms, but Cinema 
4D does a better job of simplifying 
the process. Indeed, the usual 
horrors associated with bones and 
IK have largely been eradicated. 

R9 introduces a new cloth engine, 
ClothHilde, which makes this task 
relatively easy and solves most 
problems, including collision and 
penetration. Results look good, too.

The built-in Xpresso system 
combines the power of expressions 
with the ease of use of a GUI, which 
gives access to this most useful of 
3D tools to even the most non-
program savvy artist. It’s this feature 
that keeps Cinema 4D 9 one step 
ahead of the game. 

Maxon has spent a lot of time 
making advanced 3D tools easy to 
use, and creating a consistent user-
interface and workfl ow for both 
casual and advanced 3D artists. 
Features are one thing, but 
implementation is everything, and, 
as such, Cinema 4D R9 is the most 
accessible and usable of all the 3D 
packages on test here.
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MAC Yes    PC Yes

PRICE 

£2,199 

CONTACT

01525 718181
www.maxon.net

FEATURES

• Innovative Soft IK
• Micropolygon displacements
• N-gons
•  Set-and-forget 16x edge

anti-aliasing
• GUI-based expressions
• Intuitive, powerful interface
•   Novel object manager with 

construction history
• Excellent Cloth simulation
•  Rigid and soft body dynamics 

with springs and constraints
•  Dedicated BodyPaint 3D 

painting and UV editing interface
•  Deep integration between 

toolset and interface
• Powerful Attribute Editor

FOR

• Easy to use 
• Deceptively powerful

AGAINST

•  Rendering quality could be
less CG-like 

•  Currently no third-party 
alternatives

VERDICT

            

An excellent all-purpose 3D 
system that can tackle most 
3D scenarios without making 
you jump through hoops. The 
program is well designed, 
stable and has growing 
support from third-party 
developers. Consistently 
strong across the board, too.

RESOURCE

Maxon’s fl agship 
3D modeller 
has a massive 
and dedicated 
following. Visit 
www.maxon.net/
index_e.html for 
an index of links 
to competitions, 
tutorials and 
free-to-use
3D models.

  MAXON’S TOP MODELLER FINELY BALANCES VALUE FOR MONEY WITH POWER AND FEATURES

RECOMMENDED
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C inema 4D R9 wins this Group Test because it has the 
most to offer for the widest range of 3D work. It’s as 

capable an architectural visualiser (offering some useful 
camera perspective tools) as a character animation tool, 
and the interface is easy on the eye, fast and eminently 
customisable. The default layouts are excellent, too. 

Modelling and its associated workfl ow is particularly 
well confi gured. In addition to an excellent polygon 
modelling toolset, Cinema 4D also offers spline drawing 
tools, from which you can derive surfaces in the usual 
fashion (extrude, lathe, etc). These polygonal surfaces 
are generated “live”, affording a much greater degree of 
modelling history. With the Object Manager, you can also 
group so-called generators that produce geometry with 
deformers, such as Bend, FFD or Bones.

While not offering as deep a history scheme as Maya 
or Softimage XSI, the tight integration of all features 

means that you rarely run into confl icts when animating 
such hierarchical set-ups. In fact just about all 
parameters can be keyed, including those used to 
generate geometry in the fi rst place. This offers a great 
deal of consistency throughout the program, regardless 
of the task you’re performing, providing a level playing 
fi eld for newbies learning the app and pros fi nding a 
solution to a production problem. 

With Cinema 4D R9, you can have multiple scenes 
open at once – a feature currently unavailable in any of 
the other apps on test. It’s a simple feature, but one that 
gives you lots of extra virtual working space. You can Cut 
and Paste between open fi les to modify an object in an 
empty scene fi le instead of in its main scene, which is 
extremely helpful if you’re working on complex jobs.

Overall, Cinema 4D R9 combines ease of use with 
powerful features and an elegant interface. 

CONCLUSION

MODEL MAYA 6.0 SOFTIMAGE XSI 4.5 3DS MAX 7 LIGHTWAVE 8.0 CINEMA 4D R9

MENTAL RAY SUPPORT Yes Yes Yes No No

OTHER THIRD-PARTY 
RENDERER SUPPORT

Yes No Yes Partial No

RADIOSITY/GI Yes Yes Yes Yes Yes

NURBS Yes Yes Yes No No

NETWORK RENDERING Yes Yes Yes Yes Yes

SOFT BODY DYNAMICS Yes Yes Yes Yes Yes

RIGID BODY DYNAMICS Yes No Yes Yes Yes

CLOTH No Yes No Yes Yes

ADVANCED CHARACTER 
TOOLSET

Yes Yes Yes Yes Yes

MODELLING HISTORY Full Full Modifi er stack only No Partial

INTEGRATED 3D PAINTING Yes No No No Yes

RECOMMENDED
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BUYER’S GUIDE

IMAGING EQUIPMENT P97

GRAPHICS CARDS P97

DIGITAL CAMERAS P97

ANIMATION PACKAGES P99

WEB DESIGN SOFTWARE P99

STORAGE DEVICES P96

What sort of designer are you?

Having the latest software is a must for the high-
fl ying web designer – that and a well-specced 
workstation, digital image capture devices 
(cameras, camcorders) and a portable hard drive.

For the best bargains online, remember to
visit www.computerarts.co.uk/compareprices 

WEB DESIGNER

MOTION GRAPHICS DESIGNER 
DIGITAL VIDEO SOFTWARE P97
PLUG-INS P96
DIGITAL SLRS P97

3D ANIMATOR
ANIMATION SOFTWARE P98
GRAPHICS TABLETS P99
MONITORS P99

ILLUSTRATOR
GRAPHICS SOFTWARE P96
PRINTERS P97
LAYOUT SOFTWARE P96

TEAM LinG - Live, Informative, Non-cost and Genuine!
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GRAPHICS AND LAYOUT SOFTWARE

 NAME MAC
PC?

DESCRIPTION MANUFACTURER PRICE WEBSITE ISSUE VERDICT

STUDIO ARTIST 3 Mac Image processing and real-time video effects in this, the 
latest edition of the world’s only “graphics synthesiser”.

Synthetik Software $379 www.synthetik.com 95 ★★★★  Not the easiest graphics package to get to 
grips with, but persevere and it comes into its own.

ILLUSTRATOR CS Mac 
PC

Industry standard vector graphics software – a vital tool 
for anyone who needs to design for print or the web.

Adobe £511 www.adobe.co.uk 89 ★★★★   Offers smaller improvements across the 
board, but not exactly what you’d call a huge upgrade.

PHOTOSHOP CS Mac 
PC

The design daddy, the creative king, and the industry 
standard professional image editor. 

Adobe £605 www.adobe.co.uk 89 ★★★★   Improvements across the board 
make this a more versatile tool than ever.

FREEHAND MX Mac 
PC

An easy-to-learn graphics environment for designing 
illustrations and organising data for print/web or Flash.

Macromedia £299 www.macromedia.
com

82 ★★★★★  A rock-solid release that 
offers a plethora of invaluable tools.

QUARKXPRESS 6 Mac 
PC

The tried-and-tested publishing tool of yesteryear plods 
into the present. Better late than never…

Quark £1,095 http://euro.quark.
com

87 ★★★    A comfortable and familiar upgrade,
but InDesign still has the edge, design-wise.

INDESIGN CS Mac 
PC

Adobe’s DTP upstart comes of age as QuarkXPress-
killer InDesign approaches industry-standard status.

Adobe £716 www.adobe.co.uk/
products/indesign

67 ★★★★   InDesign now simply amazes – and
utterly trounces QuarkXPress.

SKETCHBOOK 
PRO

Mac 
PC

Fuss-free paint and drawing application with 
customisable markers, pens, brushes and airbrushes.

Alias $179 www.alias.com 100 ★★★★  A well-designed app that focuses on ease of 
use rather than unnecessary extra features.

PAINTER 9 Mac  
PC

The number one natural media tool now delivers an 
Artists’ Oils system, a batch of KPT fi lters, and more.

Corel £249 www.corel.co.uk 102 ★★★★★ If you want realistic digital paint,
there really is no other option.

JAWS PDF 
CREATOR 3.4

Mac  
PC

PDF creation utility; its Jaws virtual printer drive
enables delivery from any program.

Jaws £62 www.jawspdf.com 102 ★★★★  Equally adept at outputting pre-press
quality PDFs as everyday offi ce documents.

FLASHPAPER2 PC Enables you to create cross-platform electronic 
documents (SWF and PDF fi les) from any program.

Macromedia £49 www.macromedia.
com

102 ★★★★  A slick way of creating high-quality versions 
of your documents. Customisation options are limited.

CLICK TO 
CONVERT 5.3

PC A mini-publisher of two fi le formats (PDF and HTML), 
which you can output simultaneously, if required.

Click to Convert $89 www.clickto
convert.com

102 ★★★  Ideal for churning out documents in the two 
formats, but keeping fi le sizes down can be tricky.

PDF CREATE PC Complex and sophisticated PDF creation utility, 
reminiscent of Adobe Acrobat itself.

Scansoft £40 www.scansoft.co.uk 102 ★★★★  Not a one-click solution – but when precise 
confi guration matters, PDF Create! is a godsend.

PDFFACTORY 
PRO 2.27

PC This PDF creation utility offers pre-conversion document 
preview, batch processing and a virtual printer driver.

FinePrint £59 www.fi neprint.com 102 ★★★★  For overall fl exibility, speed and compact 
fi les size, this conversion utility is a must.

QUARK XPRESS 
6.5

Mac
PC

Latest iteration offers expanded Print Styles, 
expanded PDF generation and Vista Xtension.

Quark £1,169 euro.quark.com/
en

104 ★★★    Not quite the InDesign killer many were 
hoping for, but the tweaks bode well for XPress 7.

SIZEFIXER PC Enlarge your digital images by a staggering 400
per cent with no loss in quality. 

FixerLabs £149 www.fi xerlabs.
com

104 ★★★★  Makes some bold claims, but delivers
– you can stretch images to breaking point .

ACDSEE PC This image-management solution supports the 
RAW image format and can convert to JPEG 2000.

ACD Systems £35 www.acdsystems.
com

104 ★★★★  A fast, easy-to-use and effi cient image-
management tool. Great interface, too.
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QUARK XPRESS 6.5
An upgrade from 
Quark 6.0 or 6.1 to 
6.5 is free.

PHOTOCLEAN Mac 
PC

A quickfi re photo clean-up application designed
with the absolute beginner in mind.

Shortcut 95 
Euros

www.trulyphoto
magic.com

101 ★★★★ Easy-to-use and intuitive photo-editing tools 
that should interest pros and enthusiasts.

NIK COLOR
EFEX PRO

PC Fantastic set of digital photographic fi lters for 
Photoshop and Paintshop Pro.

Nik Multimedia £280 www.nikmultimedia
.com

94 ★★★★  You could create the effects for
yourself in Photoshop, but they’d take longer.

SYMMETRY 
WORKS

Mac 
PC

Adobe Illustrator plug-in for creating eye-catching 
surface pattern designs in seconds.

Artlandia $241 www.artlandia.com N/A N/A Fast and effective way to create patterns. An 
effective time-saver when up against deadlines.

PRIMATTE 2.0 Mac 
PC

Photoshop plug-in dedicated to ultra-clean,
blue-screen compositing.

Digital Anarchy $299 www.digitalanarchy.
com

97 ★★★   More powerful than Cinematte and cheaper 
than Multimatte. Results are impressive.

SAPPHIRE Mac 
PC

Generate superb effects with this 175+-strong suite of 
movie-quality plug-ins.

GenArts $1,699 www.genarts.com 98 ★★★★  Without a doubt, the best plug-ins you can 
buy – but they come at a professional price.

PARTICULAR Mac  
PC

Neatly integrated After Effects plug-in suite, comprising 
natural and technical effects.

Trapcode £199 www.trapcode.com 99 ★★★★★  Stunning, beautifully put together and 
boasting endless creative possibilities.

FURNACE Mac 
PC

Two After Effects plug-ins for stabilising (Steadiness) 
and speeding up/slowing down (Kronos) footage.

The Foundry £350 www.thefoundry.
co.uk

101 ★★★★   Excellent, easy-to-use plug-ins – the 
high price shouldn’t dissuade professionals.

EYECANDY 5: 
TEXTURES

Mac 
PC

Ten Photoshop plug-ins, including Fur, Brick Wall, 
Diamond Plate, Marble, Reptile Skin and Swirl.

Alien Skin $99 www.alienskin.com 102 ★★★★  A fun, versatile and (mostly) useful set of 
fi lter effects that’ll suit pros and amateurs alike.

RECOMMENDED

RECOMMENDED

RECOMMENDED

RECOMMENDED

RECOMMENDED

LACIE BIG DISK
EXTREME 500

Mac 
PC

500GB FireWire hard drive. LaCie £420 www.lacie.com 97 ★★  A stylish, powerful and versatile hard drive
– let down by potentially disastrous reliability issues.

MOBILE HARD 
DRIVE

Mac 
PC

20GB, 40GB, 80GB hard drive. LaCie £85-
£200

www.lacie.com 97 ★★★★★  Swift auto-installation (without
drivers), top transfer rates, and a great low price!

IOMEGA
REV DRIVE

Mac 
PC

An innovative back-up/storage solution. Includes 
Norton Ghost (PC)/Dantz Restrospect Express 
(Mac).

Iomega £279 www.iomega-
europe.com

103 ★★★★  Fast and reliable, but not much cop if
you’re operating in a multi-platform environment.

RECOMMENDED

MOBILE HARD DRIVES

PLUG-INS

IMAGE EDITING SOFTWARE

INDESIGN CS
Adobe InDesign is 
fast becoming the 
industry-standard 
DTP package.

AFTER EFFECTS 6.5
Pick up this
superb set of digital 
photographic fi lters 
from Nik Color Efex 
Pro for only £280.

IOMEGA REV DRIVE
Iomega provides an 
innovative back-up 
solution for £279.

WHAT TO BUY?

TEAM LinG - Live, Informative, Non-cost and Genuine!

http://www.synthetik.com
http://www.adobe.co.uk
http://www.adobe.co.uk
http://www.macromedia.com
http://www.macromedia.com
http://euro.quark.com
http://euro.quark.com
http://www.adobe.co.uk/products/indesign
http://www.adobe.co.uk/products/indesign
http://www.alias.com
http://www.corel.co.uk
http://www.jawspdf.com
http://www.macromedia.com
http://www.macromedia.com
http://www.clicktoconvert.com
http://convert.com
http://www.scansoft.co.uk
http://euro.quark.com/en
http://euro.quark.com/en
http://www.acdsystems.com
http://www.acdsystems.com
http://www.trulyphotomagic.com
http://www.trulyphotomagic.com
http://www.nikmultimedia.com
http://www.nikmultimedia.com
http://www.artlandia.com
http://www.digitalanarchy.com
http://www.digitalanarchy.com
http://www.genarts.com
http://www.trapcode.com
http://www.thefoundry.co.uk
http://www.thefoundry.co.uk
http://www.alienskin.com
http://www.lacie.com
http://www.lacie.com
http://www.iomega-europe.com
http://www.iomega-europe.com
http://www.fineprint.com
http://www.fixerlabs.com
http://www.fixerlabs.com


January 2005   | 97

BUYER’S GUIDE

CANON I965 
BUBBLE JET

Mac 
PC

Fast (full A4 photo in under a minute) and economical 
printer with borderless photo printing facility.

Canon £255 www.canon.co.uk 96 ★★★★ Superfast photo printer that simply trounces 
the competition. Another winner from Canon.

CANOSCAN 
8000F

Mac 
PC

Entry-level scanner with FARE Level 1 auto-correction 
technology. Can scan up to the edge of the bed.

Canon £175 www.canon.co.uk 98 ★★★  Good capabilities at a very good price, but 
none of its features are market-leading. 

HP SCANJET 
8200

Mac 
PC

4800x4800dpi resolution A4 scanner with 48-bit colour 
sensitivity and good software package.

HP £449 www.hp.com/uk 98 ★★    Specs-wise, this sounds a dream; in practice, it's 
a nightmare... Poorly conceived drivers impair workflow.

CANOSCAN 
9900F

Mac 
PC

Professional scanner offering 2400x4800dpi resolution 
and FARE Level 2 technology.

Canon £299 www.canon.co.uk 98 ★★★★  A competent performer at a great price. It 
scans all sorts of media and is very easy to operate.

MICROTEK 
ARTIXSCAN 1100

Mac 
PC

Showing its age, but this faithful stalwart's colour 
fi delity is second to none.

Microtek £938 www.microtek.co.uk 98 ★★★  Valuable as part of a colour-critical environment, 
but slow and expensive, considering its age.

PERFECTION 
4870 PHOTO

Mac 
PC

Profi cient scanner with Digital ICE image-cleaning 
technology for the ultimate reproduction quality.

Epson £349 www.epson.co.uk 98 ★★★★   Wouldn’t look out of place in a pro 
environment or even a home studio.

BROTHER
HL-3450CN

Mac 
PC

A3/A4 colour laser printer (size: 615x420x540mm), 
offering maximum resolution of 2400dpi.

Brother £2,349 www.brother.co.uk 101 ★★★  Seems more at home with business graphics 
than digital artwork. Could do with more memory.

MAGICOLOR 
7300

Mac 
PC

A3/A4 colour laser printer (size: 628x594x564mm), 
offering maximum resolution of 600dpi.

Konica-Minolta £2,606 www.konicaminolta
printers.co.uk

101 ★★★★  High quality results. You can’t ignore the 
low price and running costs, or the 256MB RAM.

OKI C9500DN Mac 
PC

A3/A4 colour laser printer (size: 666x626x460mm), 
offering a maximum resolution of 1200dpi.

Oki £4,869 www.oki.co.uk 101 ★★★★ A fast and accurate printer for both high-
end graphics proofi ng and offi ce documents.

XANTÉ CL30 Mac 
PC

A3/A4 colour laser printer (size: 665x589x462mm), 
offering a maximum resolution of 1200dpi.

Xanté £4,463 www.info-tec.biz 101 ★★★★ Expect colour-accurate output every time and 
quickly delivered, reliable proofs.

XEROX PHASER 
7750DN

Mac 
PC

A3/A4 colour laser printer (size: 644x715x493mm), 
offering a maximum resolution of 1200dpi.

Xerox £5,779 www.xerox.com 101 ★★★★ Fast, high quality printer that’s perfect for 
both every day proofi ng and mission-critical design.

HP DESKJET 
6540

Mac 
PC

Can print up to 30ppm (black) and 20ppm 
(colour). 150-sheet input tray and ink status alert.

Hewlett Packard £118 www.hp.com/uk 103 ★★★★ Not  feature-packed, but delivers good 
results in both colour and black and white.

HP DESKJET 
130NR

Mac 
PC

Large-format (A1+) printer with 64MB RAM, 
automated 24-inch roll feed and automatic paper 
cutter.

Hewlett Packard £1,600 www.hp.co.uk 104 ★★★★  An affordable and robust proofi ng 
machine that delivers impressive results.

GRAPHICS CARDS
FIREGL X2 256T PC Top-end, pro-level graphics card tailored for

power-hungry users (engineers, architects, etc).
ATI $899 www.ati.com 98 ★★★   An amazing performer, but it comes at a 

price that may put off many prospective buyers.

 NAME MAC
PC?

DESCRIPTION MANUFACTURER PRICE WEBSITE ISSUE VERDICT

NIKON D70 Mac 
PC

An upgrade of Nikon’s D100, but at half the price
– and a capable answer to Canon’s 300D.

Nikon £800 www.nikon.co.uk 97 ★★★★   Superbly kitted out and built to tough and 
reliable specifi cations, the D70 betters the D100.

OLYMPUS 
CAMEDIA E-1

Mac 
PC

Smart design enables Olympus’ fi rst foray into the 
digital SLR world to accommodate smaller lenses.

Olympus £1,400 www.olympus.co.uk 97 ★★★★   A cracking build and a vast array of 
features make the E-1 a highly attractive proposition.

FUJIFILM 
FINEPIX S2 PRO

Mac 
PC

Competent digital shutterbug with Super CCD that
can capture 12MP images (with interpolation).

Fujifi lm £1,500 www.fuji.co.uk 97 ★★★★  A bulky, weighty SLR that delivers crisp, 
clear, colour-accurate images time after time.

CANON EOS 300D Mac 
PC

The fi rst genuinely budget SLR to hit the market –
with easy-to-use controls and limited functions.

Canon £900 www.canon.co.uk 97 ★★★  An average SLR that’s unfortunately showing its 
age – now superseded by Nikon's better-specced D70.

CANON EOS 10D Mac 
PC

Critically acclaimed digital SLR that’s 
exceptionally well put together.

Canon £1,400 www.canon.co.uk 97 ★★★★★  First class images, superb 
magnesium alloy body and great features.

PORTFOLIO 7 Mac 
PC

Leading asset-management software, now expanded to 
include direct-to-web publishing feature.

Extensis $200 www.extensis.co.uk 100 ★★★★  Nothing can touch the power of this long-
respected and valuable asset management solution.

ASSET MANAGEMENT

DIGITAL SLRS

RECOMMENDED

VIDEO
TOASTER 3

PC A complete post-production and video mixing suite.  
Supports live internet streaming.

Computers 
Unlimited

£2,500 www.newtek
-europe.com

95 ★★★★  Budget studios will fi nd VideoToaster 3 an 
ideal all-in-one solution for their production needs.

FINAL CUT PRO 4 Mac Emmy Award-winning tool for editing and fi nishing in 
SD and HD formats. Used to produce many TV shows.

Apple £699 www.apple.com/uk/
fi nalcutpro/

86 ★★★★★  Final Cut Pro 4 is nothing short of 
superb. Excellent bundled applications, too. 

AVID XPRESS 
PRO

Mac 
PC

Sophisticated video editing tool aimed at the higher
end of the mid-range market.

AVID £1,527 www.avid.com/
xpresspro

91 ★★★★  Twice as expensive as Premiere – but
not different enough to warrant the difference.

AUDITION 1.5 PC Pro audio editing/mixing environment that delivers 
advanced mastering and effects-processing features.

Adobe £246 www.adobe.co.uk/
products/audition

N/A N/A   An excellent tool for home users serious about 
audio. Superb features and easy to use, too.

FINAL CUT
EXPRESS 2.0

Mac Apple’s fl agship consumer video-editing app strikes a 
careful balance between features and affordability. 

Apple £199 www.apple.com/uk/
fi nalcut express

94 ★★★★  The best low-cost editing solution for DV, 
although effects may frustrate Pro users.

DIGITAL VIDEO

SCANNERS AND PRINTERS

HP DESKJET 130NR
The HP DeskJet prints 
20 colour pages per 
minute.

FINEPIX S2 PRO
Fujifi lm’s competent 
digital shutterbug will 
set you back £1,500.

EPSON 4870
Epson’s Perfection 
4870 offers superb 
reproduction quality 
for under £350.

FINAL CUT EXPRESS 2
Apple’s fl agship 
video-editing 
application (£199).

RECOMMENDED

WHAT TO BUY?

RECOMMENDED
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NAME MAC
PC?

DESCRIPTION MANUFACTURER PRICE WEBSITE ISSUE VERDICT

AFTER EFFECTS PC Adobe’s industry standard tool for adding visual effects 
and motion graphics to fi lm footage.

Adobe £664 www.adobe.co.uk/
products/aftereffects

95 ★★★★  Well-designed application with many 
features not available in rival software.

DVD WORKSHOP 2 PC Consumer-friendly DVD authoring software with many 
professional features, including real-time previews.

Ulead £259 www.ulead.co.uk 97 ★★★  Easy to use, but much of the (cheaper) 
competition has caught up since the release of v1.

VEGAS 5 PC Capable audio-visual editor with real-time effects 
rendering and 3D clip animation.

Sony $699 www.sony.com 98 ★★★    The most powerful audio editor on the 
market now sports compositing tools.

FINAL CUT PRO HD Mac The professional editing application with broadcast 
quality credentials is now HD compatible.

Apple £699 www.apple.com/uk 98 ★★★★★  Pro features and top interface
ensure this pro-level app always delivers.

AFTER EFFECTS 
6.5

Mac 
PC

Adobe’s industry standard app now includes better 
motion tracking and grain management tools.

Adobe £664 
(Standard)

www.adobe.co.uk 99 ★★★★   A number of new and improved features 
make this an indispensable tool for the video pro.

PREMIERE PRO 1.5 PC Video-editing app with improved project management 
and broader support for industry formats.

Adobe £616 www.adobe.co.uk 99 ★★★★   Premiere’s allegiance to Windows 
ensures superior integration with related titles.

PFTRACK 2 Mac 
PC

3D motion-tracking software that supports tracking, 
zooming, passing and tilting shots.

The Pixel Farm £3,000 www.thepixelfarm.
co.uk

100 ★★★★  Fast and effi cient, PFTrack 2 completes 
what can be a dreadful job simply and quickly. 

MOTION 1.0 Mac Apple’s entry-level motion graphics software comes 
with Behaviors and stacks of effects fi lters

Apple $299 www.apple.com 102 ★★★★  Simple and intuitive to use, with many 
advanced features, Motion 1.0 delights on all levels.

VIDEO STUDIO 8 PC This DV editor offers 128 transitions, DVD 
authoring functionality, and fi ve audio fi lters.

Ulead £50 www.ulead.co.uk 103 ★★★★ Offers a wealth of fl exible presets and 
effects fi lters, but unsophisticated editing tools.

POWER
DIRECTOR 3

PC DV editor with great titling functions, plus 122 
transitions and 24 video fi lters.

GoCyberlink £50 www.gocyberlink.
com

103 ★★★   Will certainly get the job done if you’re on a 
budget, but the DVD authoring is as basic as can be.

LET’S EDIT Mac
PC

DV editor offering 96 standard wipe transitions, 
a built-in wipe customiser and 26 video fi lters.

Canopus £99 www.canopus-
uk.com

103 ★★★   Every dialog/menu boasts a wide range of 
options and controls, but it’s not that intuitive to use.

STUDIO PLUS 9 PC Enjoy 126 transitions, 16 video fi lters and DVD 
authoring with this multi-purpose DV editor.

Pinnacle Systems £60 www.pinnaclesys.
com

103 ★★★★   Probably the fastest way to achieve a 
finished production from your raw footage.

PREMIERE
ELEMENTS

PC Benefi t from unlimited video and audio tracks 
with this feature-rich, entry-level version of 
Premiere Pro.

Adobe £69 www.adobe.co.uk 103 ★★★★   Your work may take longer, but 
the results speak for themselves.

DIGITAL VIDEO continued...
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RECOMMENDED

3D SOFTWARE
SHAKE 3.5 Mac 

PC
Small but effective update for Apple’s industry-standard 
compositing and visual effects application.

Apple £2,099 www.apple.com/uk/
shake

99 ★★★★★  Excellent colour correction tools 
from Apple’s pricey but powerful app.

3DS MAX 6 Mac 
PC

Acclaimed modelling, animation and rendering
solution used by 3D artists worldwide.

Discreet £2,814 www.discreet.com 92 ★★★★  Vertex Painting should keep 
3ds max popular in the games industry.

MAYA 6 Mac 
PC

Academy Award-winning 3D animation and effects 
software that’s become the fi lm industry’s favourite tool.

Alias £1,645 www.alias.com 97 ★★★★  Alias has made major improvements, 
although the app remains as tricky to master.

VUE 4 
PROFESSIONAL

Mac 
PC

Natural 3D scenery rendering package that enables you 
to generate lush landscapes at the click of a button.

e-o n Software £419 www.e-onsoftware.
com

91 ★★★★ A cut above other 3D packages – and
soon-to-be leader in its fi eld.

SILO PC Affordable polygon-modelling program that aims to be
a cheap yet powerful alternative to its pricier peers.

Nevercenter $109 www.nevercenter.
com

93 ★★★★   Professional-level modelling tools at 
your fi ngertips for a fraction of the cost. Great value.

CINEMA 4D 8.5 Mac 
PC

Powerful yet accessible 3D modelling and animation 
application, widely used in the fi lm industry. 

Maxon £499 www.maxon.net 97 ★★★★  Create realistic images with ease. New 
features include extra shaders and better Booleans.

MOJOPACK Mac 
PC

Compendium of planets, plug-ins, terrain maps and 
tutorials for planet/landscape-generator MojoWorld.

Pandromeda $99 www.pandromeda.
com

97 ★★★  An interesting collection, but hardly a 
substitute for a full-on MojoWorld update.

ZBRUSH 2 PC V2 of this innovative 2D painting/3D modelling hybrid is 
faster than ever and boasts hi-res mesh support.

Pixologic $489 www.pixologic.com 98 ★★★★★  A stunning 3D package that sets
a new standard for detailed polygon modelling.

LIGHTWAVE
3D 8

Mac  
PC

A long-awaited upgrade of this highly competitive 
industry standard 3D modelling and animation package.

NewTek £699 www.newtek.com 93 N/A  Brand new bones and dynamics systems 
make LightWave 8 a force to be reckoned with.

SOFTIMAGE XSI 4.0 PC This world-leading 3D modeller comes in three 
fl avours: Advanced, Essentials and Foundation.

Softimage $1,995 
-$8,995

www.softimage.com 100 ★★★★   Manipulating curves and NURBS is
a little inadequate, but the rest makes up for it.

AMAPI 7 PRO Mac 
PC

Latest iteration of Eovia’s classic app now comes with a 
new NURBS kernel and Dynamic Geometry.

Eovia $799 www.eovia.com 101 ★★★★  A powerful NURBS modeller for the 
professional designer, modeller or animator.

CINEMA 4D 9 Mac 
PC

Ninth iteration introduces 100 new features, including 
cloth simulator, the Point Slide tool and Ngons support.

Maxon £499 -  
£2,199

www.maxon.net 102 ★★★★   Not quite as feature-rich or complex as 
3ds max, but capable of some equally good results.

VUE 5 ESPRIT Mac 
PC

The famous 3D landscape generator now comes 
with Radiosity, Global Illumination and HDRI 
rendering.

e-on software £171 www.e-
onsoftware.com

103 ★★★★  Restricted plant generation and 
modelling tools, but a superb rendering engine.

CARRARA 4 Mac 
PC

The latest version of Eovia’s 3D modeller delivers 
an improved inverse kinematics and a redesigned 
timeline.

Eovia £199 www.eovia.com 103 ★★★★  Easy for students and amateur designers 
to learn, powerful enough to satisfy full-time pros.

PIRANESE 4 Mac 
PC

Distinctive 2D painting app, geared towards 
enhancing 3D design. Comes with natural media 
paintbox.

Informatix £450 www.informatix.
com

104 ★★★★  A true 2D/3D painting hybrid. The ability 
to import 3D objects is a real boon.

RECOMMENDED

RECOMMENDED

RECOMMENDED

RECOMMENDED

AFTER EFFECTS 6.5
Now includes better 
motion-tracking and 
grain management 
tools for only £664.

PREMIERE ELEMENTS
For £69, you can
have unlimited video 
and audio tracks with 
Premiere Elements.

CARRARA 4
A much-improved 
and redesigned 
version of Eovia’s 3D 
modeller for £199.

MAYA 6
Award-winning 3D 
software for £1,645 – 
one of the industry’s 
favourite tools.

WHAT TO BUY?
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SONIC DVDIT 5 PC DVD writing app that sits between Sonic’s entry-level 
MyDVD and the more advanced ReelDVD.

Sonic £171 www.sonic.com 100 ★★★  A useful introduction to the media for 
savvy creatives, but a little limited.

AHEAD NERO 6 
SUITE

PC A repackaged DVD version of the oft-bundled Nero 
burner, complete with NeroVision Express 2.

Nero 79 euros www.nero.com 100 ★★  An effective entry-level application aimed 
solely at consumers, not professionals.

ROXIO CREATOR 7 PC Complete with pro authoring component DVD 
Builder and a host of useful DVD-authoring features.

Roxio £70 www.roxio.com.uk 100 ★★   A comprehensive suite of tools that 
challenges the options of the Nero bundle.

APPLE DVD 
STUDIO PRO 3

Mac Features include render-free transition preview, 
alpha transitions and Photoshop integration.

Apple £349 www.apple.com 100 ★★★★   There’s no alternative for Mac users 
serious about creating DVD content. 

ADOBE ENCORE 
DVD 1.5

PC Features include DV menu previews, QuickTime fi le 
support and integrated/background transcoding.

Adobe £452 www.adobe.com 100 ★★★★   This  usable app provides a 
strong range of design and authoring options.

BUYER’S GUIDE

GRAPHICS TABLETS
NAME MAC

PC?
SHORT DESCRIPTION MANUFACTURER PRICE WEBSITE ISSUE VERDICT

NISIS EASYPEN G6 Mac 
PC

USB-friendly tablet: active area 304 x 228mm;
tablet dimensions: 385 x 347 x 12mm

Nisis  £90 www.nisis.com 99 ★★★  Nearly there in terms of features and 
usability, but there are irritating signal issues.

GRAPHIRE3 
CLASSIC XL

Mac 
PC

USB-friendly A5 tablet: active area 209 x 159mm;
tablet dimensions: 276 x 257 x 18mm

Wacom £200 www.wacom.com 99 ★★★★  Great all-round performer from 
Wacom, although not in the Intuos league.

INTUOS2 A5 
PLATINUM

Mac 
PC

USB-friendly A5 tablet: active area 203 x 162mm;
tablet dimensions: 334 x 258 x 14mm

Wacom £300 www.wacom.com 99 ★★★★   An incredible, feature-rich tablet 
that’s hard to fault. A5 tablets don’t get better.

INTUOS2 A4 
REGULAR PLAT

Mac 
PC

USB-friendly A4 tablet: active area 305 x 241mm;
tablet dimensi ons: 456 x 361 x 14mm

Wacom £400 www.wacom.com 99 ★★★★★  Customisable and easy to use,
this is everything you could want it to be.

WACOM INTUOS3 Mac 
PC

Redesigned A6, A5 and A4 tablets with scroll and 
Express Key functions, and new Pen Tablet System.

Wacom £130-£306 www.wacom-europe.
com

102 ★★★★  Wacom’s justly famous; these newly 
tablets are set to attract even more admirers.

 MONITORS
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BENQ FP23W Mac 
PC

23-inch widescreen LCD can display 1920x1200 
pixels and boasts a contrast ratio of 500:1. 

BenQ £1,275 www.benq.co.uk 102 ★★★★  An impressive monitor that delivers in 
terms of both resolution and picture quality.

MICROSCAN A904 Mac 
PC

19-inch LCD with a resolution of 1024x768 
and 500:1 contrast ratio.

ADi £395 www.adiuk.com 104 ★★★   A good budget entry monitor, with a 
punchy image that’s fi ne for low-level usage.

GALLERY 2010 
PLATINUM

Mac 
PC

20.1-inch LCD with a resolution of 1600x1200 
and 600:1 contrast ratio.

Formac £746 www.formac.com 104 ★★★  Gorgeous for day-to-day use, but lack 
of adjustability will dissuade graphics pros.

MULTISYNC 
LCD2180UX

Mac 
PC

21-inch LCD with a resolution of 1600x1200 
and a 400:1 contrast ratio.

NEC £1,291 www.nec.co.uk 104 ★★★★  A gorgeous display, compact yet 
easy to confi gure for precise image control.

SDM-P234 Mac 
PC

23-inch LCD with a resolution of 1920x1200 
and a 400:1 contrast ratio.

Sony £1,622 www.sonystyle.com 104 ★★★    Style-wise, it looks great, but design 
faults (that backlit logo on the bezel) irritate.

COLOREDGE CG21 Mac 
PC

21.3-inch LCD with a resolution of 1600x1200 
and a 400:1 contrast ratio.

Eizo £1,526 www.eizo.co.uk 104 ★★★★    A masterpiece – if colour 
accuracy is an issue, look no further.

 

DVD STUDIO PRO 3 Mac Create a complete DVD in under 15 minutes with the 
latest iteration of Apple’s pro DVD creation tool.

Apple £349 www.apple.com/uk 99 ★★★★  Stacks creative features make 
this perfect for the professional.

GO LIVE CS Mac 
PC

Adobe’s website design application is sometimes 
hailed as the Pepsi to Dreamweaver’s Coke.

Adobe £394 www.adobe.com 89 ★★★★  The refi ned look and the feel of the 
app make it better than ever.

DREAMWEAVER 
MX 2004

Mac 
PC

Build and maintain websites and applications with 
this powerful set of tools.

Macromedia £339 www.macromedia.co.uk 91 ★★★★  Good integration with Contribute; 
fully embraces Cascading Style Sheets.

STITCHER 4 Mac 
PC

Create high quality panoramas and 360-degree 
QuickTime VR animations in minutes.

RealViz 499
euros

www.realviz.com 95 ★★★★  Not the cheapest “sticking together” 
app around, but still one of the best.

TOON BOOM 
STUDIO 2.5

Mac 2D animation package that covers everything from 
scene-planning to preparing output for delivery.

Toon Boom $374 www.toonboom.com 98 ★★★★  A fantastic all-round package for 
anyone interested in 2D animation.

FRAME FORGE 3D 
STUDIO

Mac 
PC

Professional quality storyboarding 3D software – import 
scripts, pose fi gures, set up cameras, and more...

Innoventive 
Software

$349 www.frameforge3d.com 100 ★★★★   If you need to visualise your fi lm 
before shooting, this is an easy solution.

AUDITION 1.5 PC Syntrillium’s former sound editor Cool Edit Pro, 
supports VST, ReWire and enhanced video.

Adobe £246 www.adobe.co.uk 100 ★★★   This respected audio tool benefi ts from 
simplifi ed features and better integration.

SWIFT3D PC The latest version of the Flash 3D app has matured
– check out the enhanced modelling environment.

Electric Rain $189 www.eran.com 102 ★★★   Approachable and easy to master with 
a great modelling environment.

FLASH STUDIO 
PRO2

PC There’s more power and greater functionality 
in this latest iteration of the industry’s leading 
SWF2EXE app.

Multidmedia £130 www.multidmedia.com 103 ★★★★  An essential Flash utility for 
designers who know their limitations. 

CAPTIVATE PC Redeveloped version of RoboDemo, a screen capture 
program ideal for distance learning applications.

Macromedia $499 www.macromedia.co.uk 103 ★★★★  Provides streamlined and 
professional results via a simple interface.

WEB, ANIMATION, CD/DVD

RECOMMENDED

RECOMMENDED

DVD WRITERS

WACOM INTUOS 3
Revamped Wacom 
tablet prices
start from £130.

DVD STUDIO PRO 2
The only Mac option for 
DVD writing from Apple 
costs £349.

MICROSCAN A904
ADI’s new MicroScan 
A904 monitor has a 
price tag of £395.

RECOMMENDED

RECOMMENDED

RECOMMENDED

WHAT TO BUY?

DREAMWEAVER MX
Build and maintain 
websites and apps 
with Dreamweaver 
for only £339.
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SEE AN ISSUE YOU WANT? 
THEN CALL THE HOTLINE 
AS SOON AS YOU CAN, 
BECAUSE BACK ISSUES
ARE SELLING OUT FAST

HOW TO ORDER 
BACK ISSUES
CALL THE HOTLINE ON
0870 444 8455

OR EMAIL
ca.subs@futurenet.co.uk 
(Please quote the relevant code)

SUBSCRIBE TO COMPUTER ARTS 
IN PRINT
www.computerarts.co.uk/magazine
AS PDF
www.computerarts.co.uk/zinio

ADD THE COMPUTER ARTS WEBSITE 
TO YOUR BOOKMARKS OR FAVOURITES
www.computerarts.co.uk

IN EVERY ISSUE, COMPUTER 
ARTS PROJECTS FOCUSES 
ON A DIFFERENT AREA OF 
DIGITAL DESIGN – WITH
TIPS, TOP TRICKS AND 
EXPERT TECHNIQUES...

Did you know you can receive Computer 
Arts in electronic format? Turn to page 85.

Missed an issue of your favourite mag? Call now and order old issues

BACK ISSUESBACK ISSUES
ISSUE 99 Code COA99 ISSUE 100 Code COA100

ISSUE 102 Code COA102 ISSUE 103 Code COA103

ISSUE 101 Code COA101

INSIDE THIS ISSUE…

ISSUE 104 Code COA104

INTERACTIVE

CD66
PC & MAC CD-ROM

2633 
free fonts from top type 

foundries Union, URW, 

Font Garden and more... 

(PC & MAC)

EXPERT VIDEO TRAINING 

ON LIVETYPE AND FLASH

Create fantastic fi lm titles and cartoon type

FONTLAB 4.6
Try out the industry-standard font-creation software

A MASSIVE

WORTH

$20

(DUAL DEMO)

FREE FONT 
LIBRARY 
INSIDE

SOLD 
OUT

PDF VERSION AVAILABLE
PRINT VERSION SOLD OUT
Celebrate our 100th issue with: The 
Designer’s Handbook, Vue d’Esprit 
3.1 LE, Audition 1.5 demo, and more.

PDF VERSION AVAILABLE
PRINT VERSION SOLD OUT
Photoshop re-touching masterclass, 
Flash character animation and full 
copies of Stitcher 3.1 and Maya 5 PLE.

PDF VERSION AVAILABLE
PRINT VERSION AVAILABLE
Full version of Amapi 6, free 
EyeCandy textures, Swift 3D 4
trial, Freak bundle, and lots more!

PDF VERSION AVAILABLE
PRINT VERSION SOLD OUT
3D effects in Photoshop tutorial, plus 
free MAC Rhino fonts, full copy of 
Xara X1 and Flash StudioPro 2 trial.

PDF VERSION AVAILABLE
PRINT VERSION SOLD OUT
Create a Soviet-style poster with our 
Freak fi gure and accessories. Also 
includes eight AdvanceFlash clips.

TYPOGRAPHY Special – COSB0066
Design your own font and discover how 
typography can invigorate your work.

DESIGN BUSINESS Special – COSB0065
Top advice on how to set up your very 
own design company from scratch.

PDF VERSION AVAILABLE
PRINT VERSION AVAILABLE
Photoshop’s metallic effects exposed, 
full version of Bryce 4 on the CD, plus 
how to customise Illustrator brushes.

PHOTOSHOP Special – COSB0064
Improve your Photoshop work with 
these expert tips and techniques.
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ON THE CDOOOOOOOOOOOOON TH

WELCOME
This month, we lead with a
30-day trial version of 
Discreet’s 3ds max 7, the 
professional 3D app that’s 
perfect for fi lm-quality special 
effects, video-game design 
and architectural visualisation. 
If it all sounds a little daunting, 
then check out our tutorial 
starting on page 104, 
where you’ll fi nd out how to 
model your own home in 3D.

Also this month: a full 
version of Camtasia 3, the 
screen-recording app often 
used for creating video 
tutorials, PDF extracts from 
Peachpit Press’s Apple Pro 
Training Series: Motion – and 
a chance to enjoy more high-
quality motion graphics from 
Digital Anarchy’s acclaimed 
Chaos Stock collection.

Joe Russ
joseph.russ@futurenet.co.uk
NEW MEDIA CONTENT EDITOR

30-DAY TRIAL PC ONLY

3ds max 7

For those already familiar with 3ds max, version 
seven of Discreet’s heavyweight 3D app introduces
a range of notable improvements. The Mental Ray 
renderer and Character Studio now come as 
standard, for instance, and Discreet has tweaked a 
host of modelling, animation and rendering tools.

But even those new to the app are in for a treat. 
With this superb trial of 3ds max at your fi ngertips, 
you’ll be able to master the skills deployed every 
day by 3D professionals working on Hollywood 
blockbusters, top-selling videogames, product 
designs and in architectural visualisation. 
3ds max’s vast toolset encompasses almost every 
aspect of 3D design, be it character animation or 
special effects, and even takes in such seemingly 
obscure features as accurate physics modelling. 

For game designers who need to be economical 
with the complexity of their models, the new Normal 
Mapping feature will prove a real godsend. Normal 
Mapping enables you to take textures from high-res 
models and apply them to simple low-polygon objects, 
increasing the apparent detail in the model.

The Mental Ray renderer is an industry-standard 
module for creating high-quality image output – and 
capable of simulating a range of complex and subtle 
effects. These include global illumination (the way 
light refl ects and interacts with objects) and camera 
lens effects such as motion blur and depth of fi eld. 

Then there’s Character Studio, an impressive app in 
its own right, which offers, as the name suggests, a 
range of tools geared towards character animation. 
Now you can create realistic bones systems, which 
you can then “fl esh out” to create moving characters, 
complete with accurate, fl exing muscles and realistic 
skin textures. The ability to import motion capture 
data enables you to add another level of realism to 
your 3D characters. 

With such a broad set of features at your disposal, 
3ds max can seem a little daunting at fi rst, but don’t 
be put off. Turn to our tutorial, starting on page 104, 
and you’ll be shown all the basic techniques you need 
to build a 3D house using simple plans.

PAGE 104
BUILD YOUR

OWN HOUSE FROM ARCHITECTURAL 
PLANS WITH

3DS MAX

Get hands-on with the effects industry’s leading 3D modelling package
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TRIAL MAC AND PC

PrintDevizor Lite
Take the worry out of applying special fi nishes to your print work FULL LISTING

COMPLETE BOOK CHAPTER MAC & PC

40 PAGES FROM
APPLE PRO TRAINING 

SERIES: MOTION 

Ever discovered a neat trick in your favourite 
app, be it Photoshop or Flash, and wanted to 
tell your friends about it? You could write it 
down or a mail over some screenshots, of 
course, but wouldn’t it be easier if you could 
show them exactly how it’s done, in real time? 
Camtasia Studio is a complete solution for 

quickly creating professional-looking videos
of your PC desktop activity. Simply hit Record 
in Camtasia, demonstrate your prowess as 
normal, then, when you’re fi nished, hit Stop. 
You’ll now have a video of your on-screen 
activity in Flash, Windows Media, QuickTime 
or RealPlayer format.

FULL SOFTWARE PC ONLY

Camtasia 3 
Create your own presentations with this powerful screen-recording package 

3DS MAX 7 (PC) 
30-DAY TRIAL
Model a house – or just about anything you like
– with this heavyweight 3D application.

CAMTASIA 3 (PC) 
FULL SOFTWARE
Record on-screen activity to create demos and 
presentations of your work.

CAMTASIA STUDIO 2 (PC) 
TRIAL
The latest version of this screen-recording package.

APPLE PRO TRAINING
SERIES: MOTION (MAC+PC) 
BOOK EXTRACT
A complete chapter from the Peachpit Press guide 
– fi nd out why the graphic pros are getting excited.

PRINTDEVIZOR LITE (MAC+PC)
TRIAL
Visualise special print fi nishes in 3D.

FOLDUP! 3D (MAC+PC)
TRIAL
Design packaging with this Adobe Illustrator plug-in.

SWISHMAX (PC)
TRIAL
Create content with this alternative Flash app.

AVIDFREE DV (MAC+PC) 
TRIAL
Try out this feature-rich DV editing software.

CHAOS STOCK (MAC+PC)
STOCK MOTION GRAPHICS
Free animated backgrounds for DVD and video.

TUTORIAL FILES (MAC+PC)
To fi nd this month’s supporting fi les, navigate the 
interface to “In The Mag” and select Tutorials.

When you want to make your print work leap off the page, you’ll probably want to splash
out on a special fi nish. A good printer will always offer a range of additional coatings, 
varnishes and foils that give your work that extra oomph. Look closely and you’ll often see 
the cover illustration of Computer Arts varnished to give it a lustrous sheen. 
The problem is, these fi nishes are expensive and – because they’re 
created mechanically, apart from the print process – diffi cult to 
visualise. Special varnishes can therefore be an expensive gamble.

PrintDevizor helps minimise the risk by enabling you to visualise 
your special fi nishes on-screen before you go to press. To see how 
your fi nishes might look, PrintDevizor turns your document into a
3D model which you can 
then rotate through 360 
degrees, showing how
an array of varnishes, 
metallic fi nishes and 
special inks will appear 
under different lighting 
conditions. You can
even visualise different 
surface textures, such
as paper or board and 
matt or gloss fi nishes.

Another useful
feature is the ability to 
output the visualisations 
created in PrintDevizor 
as emailable images, 
animations and 
QuickTime VR movies.
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  SPECIAL OFFER FOR COMPUTER ARTS READERS

From now until 31 January 2005, Computer 
Arts readers with a copy of Camtasia 3 on 
our covermounted CD can buy Camtasia 
Studio 2 for only £128 (excluding VAT), a 
saving of more than £40 off the normal 
RRP. Visit www.qbssoftware.com/
CamtasiaCAOffer or Grey Matter www.
greymatter.com/camtasiaCAoffer and 
enter the password CSCOMPUTERARTS
to obtain your discount.

WINYOUR OWN COPYOF PRINTDEVIZOR WORTH £995!VISIT THECA WEBSITE*
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CD TUTORIAL

Ë
3ds max has managed to establish 
itself an ever more important role in 

the workfl ow of many an architect, from 
the small, single architectural practice to 
the multi-national studios. It has landed 
this role for two simple reasons. The 
program easily integrates with, adopts and 
develops many of the tools and interfaces 
found in sister packages such as Viz and
AutoCAD, and offers a number of 
differing project workfl ow techniques to 
achieve similar results. This enables 
anyone with knowledge of the basics of 
3D modelling, in any package, to use 3ds
max and produce quality results in hours 
using the same techniques they may well 
have mastered within other applications.

3ds max offers the architect an effective 
design development tool, giving real-time 
feedback on the important issues of 
building form, lighting and material 
solutions. All can be represented within 
3ds max and then progressively updated as 
the design specifi cations change. 3ds max 
should be embraced and utilised by the 
designer and not feared, much in the same 
way 2D drafting packages have been 
adopted into the workfl ow of every 
architect over the past decade.

The following tutorial will run through 
several of these most common modelling 
techniques. Some, the experienced user 
will take for granted, but others, such as 
the AutoGrid feature, have just been 
overlooked. The processes used here are 
the building blocks to any successful 3D 
visualization, and while you may not
use all of these techniques in future 
projects, many of them through time
and experience will become embedded 
within your production workfl ow.

BUILDING BLOCKS
3ds max is an exceptionally useful tool for architects working at all levels of design, says Anthony Lester. But what 
can it do for you? Give 3ds max a test-drive with this brilliant 3D visualisation tutorial and fi nd out for yourself

3DS MAX

ON THE CD

You’ll fi nd all the fi les 
you need to complete 
this tutorial in the 
folder marked Tutorial\
CD on the cover CD.

TIME LENGTH

1 hour

INFO

Anthony 
Lester is
the senior 
architectural 
visualisation 

specialist at Visual 
Eyes Media, a company 
he set up in 2004. For 
further information, 
visit www.visual-eyes-
media.co.uk.

FULL SOFTWARE

Check out the fully 
working 30-day trial
of 3ds max 7 on this 
month’s cover disc.
For more information, 
turn to page 102.

1First, open the model_dwg.max fi le, 
provided on the cover CD. This fi le 

contains the plans and elevations for the 
scheme that will form the basis of this 
particular project. Go to File>Open and 
navigate to the relevant folder.

2 You’ll now need to check that the 
system unit’s scale and display units are 

correct. Access this information by choosing 
Customize>UnitsSetup. Display units are 
purely for visual reference, but use metres 
for this exercise. For simplicity’s sake, set 
System units to 1 unit = 1 metre.

3   Select DWG_plan_ground and DWG_
plan_1st, isolate them and then, in top 

view, trace the extremities of the internal 
fl oors, keeping within the walls. You should 
use either 3D or 2.5D snap while tracing. 
Remember, if you use 2.5D you’ll then need 
to re-position the 1st fl oor plate.

4Rename the fl oor plates (Tools>Rename
Objects) and select (in this order) the 

ground fl oor line and then the 1st fl oor. Use 
the settings in the plate and then hit rename. 
Add an extrude modifi er to each line with an 
Amount value of -0.4m.

Illustration and tutorial by Anthony Lester
www.visual-eyes-media.co.uk

ON THE CD

You’ll fi nd all the fi les 
you need to complete 
this tutorial in the 
folder marked Tutorial\
CD on the cover CD.

TIME LENGTH

1 hour

INFO

Anthony 
Lester is
the senior 
architectural 
visualisation 

specialist at Visual 
Eyes Media, a company 
he set up in 2004. For 
further information, 
visit www.visual-eyes-
media.co.uk.
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It’s extremely 
important to ensure 
that the systems 
scale of a project fi le 
is correct right from 
the start, especially 
when dealing with 
imports from other 
applications. This 
scale can adversely 
affect modelling 
mapping, and 
photometric lighting. 
The display units can 
be set to anything 
that the user is 
comfortable with.
Use the Measure 
Distance tool on a 
known dimension to 
check that the system 
units are correct.

SYSTEM SCALE

5 Because the outer walls are 
geometrically simple, you can use an 

extrusion and Boolean technique easily 
enough. Select fl oorplate_00, then clone 
(Ctrl+V), tag the copy radial and rename it 
outer_wall. With the outer_wall selected, 
drop down to the editable spline level and 
select the spline sub-object.

8 You’ll now need to create openings in 
which to place the windows and doors. 

It’s best to create these holes using the 
Boolean technique. But this process can be a 
little temperamental, so we’ll only be making 
one Boolean operation. As a result, you’ll 
need to produce all the geometry being used 
as the second operand as one object. 

11    Convert Outer_wall back to an 
editable mesh, as you did in the 

previous step. Next, to remove unwanted 
diagonal face edges, select the Edges sub-
object and hit Ctrl+A to select all edges. Now, 
in the Surface Properties group, hit the Auto 
Edge button. An STL Check modifi er can also 
be used to check for errors in the Boolean.

9 Using the different views (left, right,
front and back), you can trace the outer 

perimeters of the windows and doors. You’ll 
need to extrude these lines, merge them into 
one editable mesh and then position the 
individual elements to intersect the outer_
wall object in preparation for the Boolean.

6 Select the only spline in the object, 
under the Geometry group of the spline 

modifi er, and enter -0.25m into the Offset 
box. Depending on the direction that the 
original fl oorplate_00 was traced, you may 
need to change this to +0.25m. Once it’s 
offset, go back up the stack and change the 
extrusion value to 5.2m.

7 Next, add the overhang above the front 
door. Simply use DWG_plan_1st to trace 

the outline of the wall in top view. Extrude by 
2.6m and attach this to the Outer walls using 
an Edit Poly modifi er. Select outer_wall, add 
Edit Poly to the modifi er stack and select 
Attach. Select the object you’ve just made.

10    Select Outer_wall. Right-click on the 
top of the modifi er stack and select 

Convert to Editable Mesh. Select the Create 
tab and in the drop-down menu select 
compound objects. Making sure Outer_wall 
is still selected, click on the Boolean tab. Hit 
the Pick Operand B tab and select the 
“windows mesh” you created earlier.

12 You can now use the outer_wall shell 
as a base for the windows and doors. 

On the Create tab, go to the drop-down 
menu, select Windows and then Awning. Set 
the parameters to those shown in the step 
14 image on the facing page. With 3D Snap 
selected, click, drag and release the four 
points 1) start 2) width 3) depth 4) height.

TEAM LinG - Live, Informative, Non-cost and Genuine!



TUTORIAL

January 2005   | 107

14 Create a cornice, by constructing a 
Loft, around the outer edge of the 

outer_wall. Draw a path around the top of
the outer_wall, closing the spline and then 
using the Loft_shape.max fi le, which can be 
merged in from the cover CD. When selecting 
the shape for the Loft, fl ip the orientation of 
the shape by using Ctrl+Select (LMB).

13Repeat this process for the rest of 
the windows in the scene. For the 

doors, the process is similar – just use the 
Doors drop-down menu in the Create tab 
and use the appropriate parameters (as 
shown above). Although tricky to get used 
to, the AEC are a useful way of sketching
up quick generic models.

15 Now make the pitch roofs simply by 
deforming three boxes. In top view, 

make a box convert to an editable mesh, 
non-uniform scale the top four vertex
points in the Y axis to create two, and weld 
together. Move each of these vertexes to 
align with the front elevation. Repeat the 
process for the secondary pitches.

16 To add some depth and detail to the 
model, you’ll need to add the balcony. 

Do this by creating a rectangle extruded by 
0.3m and then build a wall around the edge
– a spline extruded by 0.3m. You can then 
add a balustrade using renderable splines. 
Finally, add some cylindrical columns at
the corner of each overhang.

17You can now place a camera. Switch 
Snaps off (S) and go to Create>

Cameras>Target. Beyond the top-left of the 
building, click-drag towards the middle of the 
building. Select and move the camera and its 
target up by 1.6m. If the target has a different 
world Z value to that of the camera, use the 
camera-correction modifi er to compensate.

20 Load up the model from the CD (model_fi nal.max). It should appear the same as the 
one you’ve created, with the addition of some simple materials. With the exception of 

the base plane, all the geometry lighting and cameras have been kept the same. 

19Light Tracer is a quick lighting 
solution that’s easy to set up. Open 

the Render dialog box, ensuring that the 
default Scanline renderer is selected. On the 
Advanced Lighting tab, select Light Tracer 
and adjust the settings as shown here. Hit 
Render and you’ll have created a reasonable 
lighting setup for your quick model.

18Place a skylight anywhere in the
scene by choosing Create>Lights>

Standard>Skylight, with settings as shown 
above. The Direct light will be placed over the 
“right shoulder” of the camera view. Allow it 
to cast raytrace shadows, set its intensity to 
1 and the Ray bias (in the Ray Trace Shadow 
Params group) to 0.01.

CD TUTORIAL

The AutoGrid tool
is a quick way of 
modelling geometry
or a shape that has 
local co-ordinate 
systems aligned with 
the face that is selected. 
You can use it “on the 
fl y” as an effi cient
way of modelling
for extrusions and 
Booleans. The AutoGrid 
hasn’t been used in this 
instance because the 
viewport grids act in a 
similar way.

AUTOGRID
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CD DUPLICATION
DB Masters
• Short and long runs
• Competitive prices
• Fast turnaround
• A-Grade CDR 
• Thermal or screen print
Tel: 01795 597 755
Fax: 01795 597 766
Email: info@dbmasters.co.uk
Website: www.dbmasters.
co.uk

ILLUSTRATION,
3D ANIMATION & 
VISUALISATION
Arcana Digital
Animation, imaging and post 
production for broadcasting, 
interactive and print. Folio 
available online or call for a
CD sampler. Studio 15 minutes 
from Victoria. Clients include: 
Bray Leino, Citigate.A.F, DDB, 
Grey, JWT, Lowe, Masius, 
Ogilvy, OWN&P, Proximity, 
Publicis, RKCRY&R, Saatchi, 
TBWA, WTCS, WWAV.
Tel: 0208 466 0655
Email: john@arcanadigital.com
Website: www.arcanadigital.
com
Contact: John Fox

PRINTING 
SERVICES
Wellington Press 
The Wellington Press Group 
has been established for over 
70 years, offering a complete 
design, printing and fi nishing 
service encompassing all forms 
of printed and electronic 
communication. The Group has 
expanded and kept pace with 
the rapid developments in 
graphic communication and 

printing technology, and now 
leads the industry in many new 
techniques. From conventional 
to digital offset to large format 
printing and fi nishing, through 
pre-press, design and studio 
work, to electronic media and 
the internet, the Wellington 
Press Group are your complete 
solution providers. 
Tel: 0800 7833241
Fax: 0208 5583722
Website: www.wpdigital.co.uk

LARGE FORMAT 
PRINTING
Display Print
Services Ltd (dps)
It’s a big world out there and 
competition is fi erce, so how
do you create super-strong 
visual impact and really get 
noticed? By thinking big. Big 
graphics, big messages – and 
big pictures. As a specialist in 
large-format print and display, 
dps has all the know-how to 
transform your ideas into high 
quality reality. We can produce 
anything from point-of-sale 
items up to posters, banners, 
exhibition stands or even wrap 
up whole buildings.

Call us for more details of 
how we can help you to make
a big impression.
Tel: 01373 225555
Email: info@dps.eu.com
Web: www.dps.eu.com
Contact: David Wooster

RECRUITMENT
Corps Business
Corps Business is the most 
established and professional 
recruitment agency in the 
design, advertising and media 
industries. Since 1989, we

have been recruiting the top 
freelance and permanent 
creatives and developers. Our 
strict testing and screening 
procedure ensures that the 
people we supply can do what 
you want, when you want.
Tel: 020 7222 8484
Email: recruit@corps.co.uk
Website: www.corps.co.uk

TRAINING SERVICE
Corps Business
Corps Business is the leading 
UK authorised training centre 
for the top software houses, 
including Adobe, Macromedia, 
Apple, Maxon, Media 100, 
Extensis and Quark Systems. 
You can choose either a group 
or a tailored course, depending 
on your needs and abilities.
Our consultants are all very 
knowledgeable in the software 
and can advise you on which 
course would suit you best.
Tel: 020 7222 8484
Email: train@corps.co.uk
Website: www.corps.co.uk

Escape
Escape offers world-class 
training in 3D computer 
animation and 2D VFX for the 
creative industries and serves 
as a centre of creative 
excellence for both individuals 
and companies alike. The 
course programme has been 
designed in consultation with 
leading industry professionals.

Escape is the UK’s only 
authorised training centre for 
Alias’ Oscar®-winning 3D 
package, MayaR.
Website: www.escape
studios.co.uk 
Tel: 020 7524 7570.

Falmouth College of Arts
Are you passionate about the 
future of digital interactivity? 
The MA in Interactive Art & 
Design at Falmouth College of 
Arts, taught by renowned net 
artist Kate Southworth (www.
gloriousninth.com), offers 
radical new ways of working in 
Web design, digital sound art, 
net art and interactive 
installation art and design.
Tel: 01362 211077
Fax: 01362 213880
Email: admissions@falmouth.
ac.uk

Metro New Media
London’s leading training 
centre for Web design, 3D, 
animation, multimedia,
project management and 
programming
•  All trainers are professionals 

in their fi eld
• State-of-the-art studios
•  All levels from beginner

to advanced 
•  Specialists in customised 

training
• Discreet accredited
Tel: 0207 729 9992
Email: training@metronew
media.com
Website: www.
metronewmedia.com

Central UK training
•  3ds max and all that 

goes with it
• Discreet certifi ed
•  Low client – tutor ratios

(four normally)
• High impact, short courses
•  Introduction, Intermediate, 

Character Animation, etc
•  Videogames and Texture 

Making
•  We can help you select the 

right courses

• Dedicated forum
•  More on the website, 

including student work.
Come and see.

Tel: 01926 613002
Email: info@central-uk.com
Website: www.central-uk.com

WEB HOSTING
Dedicated Servers
The UK’s leading hosting 
company provides:
•  FREE and UNLIMITED phone 

& email support (24/7/365)
• Service level agreement
• State-of-the-art data centres
• Dedicated Control Panel
• Partner Programme
•  Windows, Linux, Sun, Cobalt 

and Co-location available
•  Host up to 200 Websites per 

server from £74.99 per month
Tel: 0870 3339738
Fax: 0115 9195514
Email: sales@dedicated-
servers.co.uk
Website: www.dedicated-
servers.co.uk

Netcetera
Formed in 1996, Netcetera is 
one of Europe’s leading Web 
hosting service providers. Our 
services are biased towards 
Microsoft-based Internet 
Technologies – Microsoft 
Certifi ed Partner since 1999. 
Netcetera provides complete 
solutions for Web hosting, 
Domain Name registration, 
ecommerce, e-mail, dedicated 
server hosting, server-based 
applications hosting (ASP) and 
.NETppliance.
Tel: 01624 612948
Fax: 01624 623385
Email: sales@inetc.net
Website: www.inetc.net

TO FEATURE IN THE CREATIVE DIRECTORY, EMAIL CA.ADVERTISING@FUTURENET.CO.UK

THE CREATIVE 
DIRECTORY
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CURRICULUM VITAE

RAOUL DELEO

CV

LOCATION: Rotterdam, Holland
JOB TITLE: Visual artist
DATE OF BIRTH: 21 December 1968

TRAINING: 1987-1990 – Graphic Design, 
Academy of Visual Arts, Tilburg
1990-1993 – Illustration, Willem de Kooning 
Academy, Rotterdam

SOFTWARE: All that is needed to get the job 
done. Most of the time, Adobe Illustrator and 
Photoshop are suffi cient.

HARDWARE: A very noisy Apple PowerMac G4 
“Quicksilver” dual 800 (I need to fi nd someone 
to replace the fan), an Epson 3200 Photo fl atbed 
scanner and an A5 Wacom tablet.

INFLUENCES: Japanese Manga and the work
of The Designers Republic used to inspire me. 
But now I just collect any image that I like.
This collection, which consists of samples of 
photography, graphic design, street art, fi ne 
arts, computer games and cartoons, often gives 
me an idea for a “new” style or technique.

STYLE: I’ve never had a specifi c “style” of my 
own; in order to keep things interesting, I try to 
create every illustration in a unique way. I also 
let my ideas and solutions for a certain brief 
determine which style or technique I use. But 
I always try to ensure a good concept and an 
overall feel of quality.

TELL US ABOUT YOURSELF: The internet is a 
wonderful thing. The length of my bookmark-
list with visually stunning websites has become 
so long it’s unscrollable. However, should my 
computer die on me, I’m happy to own the 
Pictoplasma books, number one and two. At the 
moment I’m busy creating an animated cartoon. 
I’d love to go back in time and work with Walt 
Disney between 1925 and 1935. I think his fi rst 
black and white cartoons were brilliant.

CONTACT: To see more of Raoul’s work, visit 
www.deleo.nl, or email raoul@deleo.nl.

WE WANT TO HEAR FROM YOU!
Send us your CV, in the format 
shown, to ca.mail@futurenet.
co.uk, with the subject line “CV”.

“This piece was created for a conference 
that covered innovation in the illustration 

industry and was built entirely in Illustrator.”

“I produced this New Year’s greeting for the
new Millennium. I claimed the card was “fortune 

energised” and protected the computer of the addressee.”

“For this illustration, I built a wooden statue, painted it, 
photographed it, then digitally decorated it afterwards.”

“The Last Taboo was created for an 
article that appeared in Playboy.

The piece was about a couple who wanted 
to reverse the roles in bed for once!” 

“The Fugitive Four was a four-page 
cartoon about disappearing 

dictators and terrorists. I wanted it to 
look like one long fi lmstrip of an old 
black and white animated cartoon.”
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